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1 О программе Tesseral Pro 

Программа Tesseral Pro предназначена для 2D, 2,5D моделирования (расчета 

синтетических сейсмограмм) конечно-разностным способом с аппроксимациями, такими как 

акустического, упругого, анизотропного, вязко-упругого случаев и 2D лучевого 

моделирования (аппроксимация уравнения эйконала). 

В Tesseral Pro встроены средства для создания глубинной скоростной модели геологического 

разреза вручную; по скважинным данным; картам геологических поверхностей; 2D, 3D 

решеткам. Tesseral Pro предлагает оригинальный подход к разработке тонкослоистых 

моделей, обеспечивающий высокую точность и обоснованность модели, с одновременно 

простым и быстрым ее построением. Для этого в Tesseral Pro кроме каротажа можно 

использовать дополнительные данные: координаты и инклинометрию скважин, 

стратиграфические разбивки, готовые карты горизонтов. 

Также Tesseral Pro позволяет создавать 3D-системы наблюдения и выполнять 3D лучевое 

моделирование. 
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1.1 Системные требования 

 

Минимальные Рекомендованные 

Windows /7/8/10/11 

1.5 GHz CPU 

 GPU обычный или интегрированный  

4 GB RAM 

2 GB свободного места на HDD 

Windows /10/11 

3.0 GHz CPU 

GPU повышенной производительности 

16 GB RAM 

10 GB свободного места на HDD 

Сетевая Карта (для доступа к 

корпоративной базе данных) 
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ЗАМЕЧАНИЕ: Если Вами закуплена версия Tesseral Pro с лицензированием 

USB- ключом, пожалуйста, не подключайте Ваш ключ до завершения установки 

программы. Драйвера USB ключей будут установлены во время установки 

программы. 

1.2 Загрузка и установка Tesseral Pro 

Последнюю версию программных продуктов Tesseral можно загрузить по следующим 

ссылкам: 

Страница загрузок Tesseral: http://www.tesseral-geo.com/download.en.php Архивный файл для 

установки Tesseral Pro: 

http://tesseral-geo.com/download/tesseral_pro_setup.zip 

Для начала установки, пожалуйста, разархивируйте «Tesseral_pro_zetup.zip» и запустите на 

выполнение исполняемый файл. 

 

При успешном запуске установки появится окно приветствия Welcome. 

 

В следующем окне User Information Вы можете ввести свое имя и указать, кто может 

использовать Tesseral Pro на Вашем компьютере (только текущий пользователь или все 

пользователи данного компьютера). 

 

После установки Tesseral Pro программа готова к запуску. Необходимо выбрать ярлык 

«Tesseral Pro» в Вашем меню запуска программ: 

http://www.tesseral-geo.com/download.en.php
http://tesseral-geo.com/download/tesseral_pro_setup.zip
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После того как Tesseral Pro запустится первый раз, Вам необходимо ввести регистрационную 

информацию или вставить Ваш USB ключ (смотрите Соглашение о лицензировании 

(Licensing Policy)). После этого программа готова к работе. 

 

Без лицензирования, в демонстрационном режиме, пользователю недоступно моделирование 

синтетических сейсмограмм и функции обработки сейсмограмм. 
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2 Первое знакомство 

При запуске модуля Tesseral Pro появится диалог Welcome с выбором возможных действий 

 

• Кнопка CREATE NEW MODEL вызывает мастер создания новой модели. 

• Кнопка LOAD MODEL предназначена для загрузки модели из TAM-формата 

программы Tesseral 2D, WGC-формата, GXII-формата или текстовых файлов 

разного вида. 

• Кнопка LOAD SEISMIC FILE позволяет отобразить в окне Tesseral Pro 

сейсмограммы в стандартном SEG-Y, а также внутренних TGR и SDS-PC 

форматах. 

• Кнопки OPEN PROJECT и OPEN LAST PROJECT для открытия файлов 

проектов Tesseral Pro. 

• Если нажать кнопку Done, появится стандартное пустое окно программы Tesseral 

Pro.
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М а с т е р м о д е л и р о в а н и я 

О к н о п р о е к т а и 

б а з ы д а н н ы х 

О к н о п о с т р о е н и я м о д е л и р а з р е з а ; о т о б р а ж е н и я с и н т е т и ч е с к и х 

с е й с м о г р а м м , к а т р , и д р . г р а ф и ч е с к и х д а н н ы х 

 

2.1 Структура окна программы Tesseral Pro 

 

В левое окне показывается дерево базы данных (описание в разделе Приложение Б.  

Геофизическая база данных) и дерево проекта (подробности в разделе Область дерева 

проекта и базы). Правое окно для построения и подготовки модели, вывода сейсмограмм, 

карт, 3D-изображений. Все объекты в правом окне выводятся в прямоугольных фреймах 

нескольких стандартных типов (подробно про фреймы, их размещение, параметры и 

операции в разделе Работа с фреймами). 

Внизу окна программы расположен Modelling Wizard – инструментальная линейка с 

кнопками вызова основных этапов моделирования (Последовательность шагов создания 

синтетических сейсмограмм). 
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2.2 Краткий обзор меню 

• Меню File – команды создания, сохранения, загрузки проекта (формат TPA), загрузки 

моделей, сейсмограмм, поверхностей, команды печати и экспорта документа в стандартные 

растровые, векторные форматы. 

• Меню Database – команды работы с базой данных в Tesseral Pro: выбор базы данных, 

создание, загрузка, редактирование скважинной информации (Приложение Б.  

Геофизическая база данных). 

• Меню Edit, View – общие команды работы с фреймами. 

• Меню Model – команды для создания и редактирования скоростной модели (Фрейм 

• Model. Скоростная глубинная модель). 

• Меню Map – команды и режимы работы с картами (Фрейм Map. Карты стратиграфических 

поверхностей). 

• Меню Seismic – команды и режимы работы с сейсмограммами в формате SEG-Y, SDS-PC, 

TGR (Фрейм Seismic. Отображение сейсмических файлов). 

• Меню 3D View – для отображения трехмерных изображений (Фрейм 3D View. 

• Визуализация 3-х мерных объектов). 

• Меню Run – запуск расчета синтетических сейсмограмм по модели, функции обработки 

сейсмограмм (Моделирование: расчет синтетических сейсмограмм). 
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2.3 Последовательность шагов создания синтетических 
сейсмограмм 

Внизу окна Tesseral Pro расположена инструментальная линейка Modelling Wizard – это 

подсказка последовательного вызова этапов построения синтетических сейсмограмм: 

Шаг 1. Построение 2D скоростной плотностной модели глубинного геологического разреза: 

вручную и/или автоматически; 

по скважинной информации и/или картам поверхностей горизонтов и/или 

2D или 3D пластовой скоростной модели в SEG-Y формате и/или LAS-файле, 

также поддерживается загрузка векторных 1D, 2D моделей из разных форматов. 

ШАГ 2. Создание схемы наблюдения (расстановка источников и приемников). 

ШАГ 3. Подготовка моделирования и расчет синтетических сейсмограмм по одному из 

следующих методов моделирования: 

1. 2D/3DVertical Incidence 

2. 2D Scalar 

3. 2D/3D Acoustic 

4. Acoustic without multiples 

5. 2D/3D Elastic 

6. 2D/3D Elastic Anisotropic 

7. 2D/3D Visco-Elastic 

8. 2D Eikonal Ray Tracing 

9. 2.5D Elastic 

10. 2.5D Elastic Anisotropic 

11. Haskell-Thomson 

Также в Tesseral Pro встроены средства обработки сейсмограмм (Обработка файлов 

сейсмограмм) и блок лучевого трассирования (Лучевое трассирование) 
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3 Построение глубинной модели разреза. 

Для создания глубинной скоростной плотностной модели геологического разреза в Tesseral 

Pro используется фрейм Model. 

Все объекты в Tesseral Pro выводятся во фреймах – подробно про типы и 

способы работы с фреймами в Работа с фреймами 

Во фрейме Model можно строить сколь угодно сложное распределение скоростей и 

плотностей по разрезу, отображающих практически любую геологическую структуру, 

задавать параметры анизотропии и трещиноватости, формировать расстановку источников и 

приемников. Геологическая модель формируется из набора перекрывающихся 

многоугольников-полигонов. В полигонах задается однородное или сложное, в том числе 

градиентное, распределение физических параметров. Также для формирования модели могут 

использоваться данные об отражающих горизонтах, скорости, плотности, анизотропии и др. 

параметров из акустического каротажа, решеток пластовых данных в seg-y формате, 

векторных 1Д и 2Д моделей, выгруженных из других пакетов. 
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3.1 Создание новой модели 

Первый этап формирования модели – выбор базовых параметров будущей модели: выбор 

размера модели (длина, интервал глубин), географическая привязка координат, выбор 

основного источника данных о разрезе (решетка в виде SEG-Y файла, решетки или изолинии 

отражающих поверхностей, скважинная информация, картинка-подложка и др.). Для этого 

используется команда Model/Create velocity Model (new frame). Далее 

появиться диалог с выбором Wizard-а для создания модели. 

 

В диалоге надо выбрать основной источник данных для построения глубинной модели. Далее 

рассмотрим все типы последовательно 
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ЗАМЕЧАНИЕ: Расстояния в модели можно задавать в метрах или в футах. 

Выбор единиц измерения проекта описан в разделе Приложение А. Единицы 

измерения. 

3.1.1 Создание простой 2D модели (SIMPLE model) 

Команда Model/Create velocity Model (new frame). Затем в открывшемся диалоге Create new 

Model нажмите кнопку SIMPLE model>. 

В диалоге Section установите длину модели, кровлю и подошву по глубине. 

 

 

Нажмите кнопку Далее >. 

В диалоге Base Polygon установите значение Compressional velocity для фонового 

(базового) полигона модели, либо введите параметры изменения скорости с глубиной. 
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Нажмите кнопку Готово. 

В результате будет создан фрейм Model и Вам будет предложено сразу задать схему 

наблюдения для модели:  

 

Это сообщение будет появляться всегда после создания новой модели. Подробно о 

расстановке источников/приемников рассказывается ниже в разделе Создание схемы 

наблюдения. 

После создания «пустого» фрейма Model, его надо заполнить многоугольниками- 

полигонами с данными о скорости, плотности и т.д. Подробно про ручное построение модели 

при помощи полигонов в разделе Построение и редактирование полигонов. 
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2D маодель 3D модель 

Примеры Seg-Y файлов глубинной скоросной модели 

ЗАМЕЧАНИЕ: В Tesseral Pro можно показывать Seg-Y файлы с помощью 

команды Seismic/Load Seismic File (New Frame) (подробности в 

разделе Фрейм Seismic. Отображение сейсмических файлов). Но для того, чтобы 

использовать решетку в формате Seg-Y для построения синтетических 

сейсмограмм, ее надо загрузить именно подложку во фрейм Model, именно как 

описано в этом разделе 

3.1.2 Создание модели по сейсмическому файлу (from SEISMIC file) 

Если у Вас есть 2D или 3D скоростная глубинная модель-решетка, записанная в формате 

SEG-Y, то ее можно использовать как подложку модели в Tesseral Pro. 

Например: 

 

Т.е. вместо рисования полигонов и подбора параметров можно прямо использовать Seg-Y. 

Достаточно только выбрать размер и положение модели. Если только Seg-Y файл с данными 

пластовой продольной скорости, то другие параметры (поперечная скорость, плотность) 

будут рассчитаны автоматически. Также поддерживается загрузка из Seg-Y файлов 

плотности, поперечной скорости, анизотропии. 

Временную модель в Seg-Y тоже можно использовать, только для этого ее надо 

предварительно преобразовать в глубинную модель. Для этого используется команда 

Run/Velocity model/Time to Depth transformation. Подробности в разделе 

Преобразование глубинного файла во временной и временного в глубинный. 

 

Построение модели: команда Model/Create velocity Model (new frame). 

В диалоге Create new frame Model нажмите кнопку From SEISMIC file >. 

ШАГ 1. Выбор SEG-Y файла скоростей. 

В диалоге File выберите сейсмический файл в формате SEG-Y или TGR. 
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Это могут быть файлы как 2D, так и 3D. 

Если кроме данных о продольной скорости (Compressional Velocity) у Вас есть сейсмические 

глубинные файлы с данными плотности (Density), поперечной скорости (Shear Velocity) или 

анизотропии (Anisotropy) то эти файлы тоже можно использовать как подложку 

соответствующих компонентов: нажмите кнопку Add other component files. В 

появившемся диалоге выберите файлы других компонентов.  

Когда сейсмический файл выбран, нажмите кнопку Далее>. 

ШАГ 2. Выбор координат и профиля модели. 

В следующем диалоге Profile, если Вы используете 3Д файл, необходимо ввести 

координаты профиля модели, либо нарисовать профиль вручную на плане мышкой: нажал- 

потянул-отпустил левую кнопку. 
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ШАГ 3. Размер модели 

В следующем диалоге Section установите кровлю и подошву модели: 

 

Модель по сейсмической подложке готова. Далее Вам будет предложено сразу задать схему 

наблюдения для модели (подробности в разделе Создание схемы наблюдения) 

Построенную модель можно «дорисовать» вручную, полигонами поверх подложки. Про 
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настройку параметров модели с Seg-Y подложкой в разделе Создание модели на основе 2D и 

3D сейсмограмм. 
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3.1.3 Создание модели по картам поверхностей (from Maps) 

Если у вас есть решетки или изолинии отражающих горизонтов – их можно использовать для 

автоматического создания полигонов модели. При этом модель формируется как разрез на 

3Д кубе поверхностей. В результате получается модель, в которой кровли и подошвы 

полигонов – повторяют форму поверхностей по выбранному сечению. 

 

Создание такой модели - команда Model/Create velocity Model (new frame. В диалоге Create 

new frame Model нажмите кнопку From Maps>. 

В открывшемся диалоге Maps нажмите кнопку Add File>, чтобы добавить поверхность из 

файла в проект Tesseral Pro. 

Поверхности 

Сечение 



© Tesseral Technologies -Документация Пользователя- 

24 

 

ЗАМЕЧАНИЕ: В Add File можно выбрать несколько поверхностей за один 

раз. 

 

После выбора файлов поверхности появится диалог Isoclines для настройки параметров 

изображения изолиний. Повторите добавление пластов кнопкой Add File>. Нажмите 

кнопку Далее>, когда все нужные поверхности будут добавлены в проект. 

 

В Tesseral Pro поверхности можно не только загрузить из файлов основных текстовых 

форматов, но и рассчитать по стратиграфическим данным скважин. Описание загрузки 

стратиграфии в базу данных смотрите в разделе Приложение 2. Геофизическая база данных. 

Описание функций расчета поверхностей по скважинам в разделе Расчет поверхностей по 

скважинным данным. 

В следующем диалоге Profile задайте координаты профиля или нарисуйте профиль 

вручную мышкой (нажал-потянул-отпустил). 
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Параметр Max number nodes on profile определяет, сколько вершин (узлов) будет в 

кровле и подошве каждого создаваемого из поверхностей полигона. 

Нажмите кнопку Далее> для перехода в диалог Section. 
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В диалоге Section установите интервал модели. В этом диалоге должны появиться линии 

полигонов, автоматически построенные вдоль выбранного профиля по загруженным в 

Tesseral Pro поверхностям. По умолчанию скоростные и др. параметры полигонов не 

установлены, поэтому полигоны отображаются серым цветом. Чтобы задать параметры 

полигона выберите его мышкой и вызовите команду Model/Edit Polygon. Подробности 

ниже в разделе Редактирование свойств полигона. 
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ЗАМЕЧАНИЕ: Для создания модели по скважинам необходимо предварительно 

загрузить в базу данных: 

1) координаты скважин; 

2) инклинометрию (если ее нет, для субвертикальных скважин достаточно 

альтитуды); 

3) глубины пластопересечений; 

4) акустический (плотностной) каротаж для построения тонкослоистой модели. 

Подробнее про заполнение базы данных смотрите в Загрузка данных 

Если Вы хотите создать простую горизонтально-слоистую модель по одному 

LAS- файлу, игнорируя данные инклинометрии, то это описано в следующем 

разделе Создание простой горизонтально-слоистой модели по LAS-файлу (From 

LAS-file). 

3.1.4 Создание модели по скважинным данным (from database WELLS) 

Скважинные данные используются чаще всего для создания тонкослоистых моделей по 

акустическому каротажу и/или плотномеру 

 

Создания модели по скважинам: команда Model/Create velocity Model (new frame). В диалоге 

Create new Model нажмите кнопку From database WELLS>. 

В диалоге Select Wells выберите скважины из списка Wells, которые хотите добавить в 

модель. Вы можете отметить одно или несколько месторождений, тогда в поле Wells будут 

только скважины из выбранных месторождений. 

 

После выбора скважин нажмите OK и перейдите в диалог Wells. 

В диалоге Wells показано географическое положение выбранных скважин и, если 

необходимо, Вы можете добавить или удалить скважины из профиля кнопками Add> и 

Delete>. 
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Когда все нужные скважины собраны в модель, нажмите кнопку Далее>. 

В следующем диалоге Profile установите координаты профиля модели, либо нарисуйте 

профиль мышкой (нажал-потянул-отпустил): 

 

В следующем диалоге Section установите кровлю, подошву модели: 
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В следующем диалоге Base Polygon введите скорость базового полигона: 

 

В следующем диалоге Well data Вы можете выбрать, показывать ли рядом со скважинами 

модели стратиграфическую разбивку и каротажные диаграммы: 
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ЗАМЕЧАНИЕ: Если Вы поставили галочку Log, то справа от скважин должны 

появиться кривые акустического каротажа, и параметры пересчета кривых 

должны установиться автоматически. Если каротажные диаграммы не 

появились, рекомендуется зайти в диалог Log (кнопка Properties группы 

Log). 

 

Отметьте Layers для автоматического создания полигонов по стратиграфическим 

разбивкам в скважинах (пластопересечения). Отметьте Log для автоматического заполнения 

полигонов параметрами по каротажу (формирование тонкослоистой модели). 

Подготовка создания тонкослоистой модели 

Подготовка заключается в выборе кривых для модели и настройки параметров пересчета, 

данных каротажа в характеристики полигонов (скорость, плотность, трещиноватость, 

анизотропию). 

 

В диалоге Log выберите кривые акустического каротажа (например, DT или AK) из списка 

всех кривых скважин модели. Для дальнейшего заполнения параметров полигонов по данным 

каротажа установите для выбранных кривых Specification – Compression  

Velocity or dT, а также Measure unit – mks/m для правильного пересчета значений 

кривых в параметры полигонов. 
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3. Установка шкалы и 
линии кривой 

2. Установка тип кривой и 
единиц измерения 

1. Добавление кривых в 
скважины 

 

Нажмите кнопку OK и выйдите из диалога Log выбора кривых. В результате в диалоге Well 

data рядом со скважинами на модели должны появиться каротажные кривые. Нажмите 

кнопку Далее> для перехода к следующему диалогу Add Polygons. 

  

В диалоге Add Polygons  из списка Create Polygons from Layers выберите условия создания 

полигонов: 

• No – не создавать полигоны автоматически 

• All layers – создать полигоны для всех пластов, существующих хотя бы в одной 

из выбранных скважинах. То есть, если пласт существует в любой из выбранных 

скважин, то он будет использоваться при создании полигонов. 

• For all wells – создать полигоны по пластам, существующим во всех 
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ЗАМЕЧАНИЕ: Этот файл не будет использоваться в расчете. С его помощью 

можно только оценить вид модели, по которой будет проводиться 

моделирование 

выбранных скважинах. То есть, если пласт не отбит хотя бы в одной из выбранных 

скважин, то не использовать его для создания полигонов. 

• Selected – выбрать пласты вручную из списка пластов базы. Отметьте Create 

polygons from Surfaces, чтобы создать полигоны, используя ранее 

загруженные поверхности. Загрузить поверхности можно прямо в этом диалоге по 

кнопке кнопка Load. 

В результате будет создана модель, в которой скорости (и/или другие параметры) 

полигонов будут заполняться автоматически по данным каротажа. Но, как говорилось ранее, 

для этого надо предварительно загрузить в базу данные по координатам скважин, координаты 

пластопересечений и кривые (подробности в разделе Загрузка данных). 

Интерполированные по каротажу параметры (тонкослоистость) не показываются в 

полигонах. Расчет интерполяции происходит автоматически перед запуском моделирования. 

Вы можете оценить качество готовой модели, выполнив команду Model/Export to 

Seismic Format (SEG-Y, TGR). В результате будет создан файл решетки. 

 

 

В Tesseral Pro реализованы специальные средства для создания и настройки полигонов, 

свойства которых определяются скважинными данными. Подробности в разделе Построение 

полигонов по пластопересечениям в скважинах. 

С помощью полигонов, связанных со скважинными данными, создаются тонкослоистые 

модели. Про принцип тонкослоистости в разделе Полигоны по каротажным кривым 

(тонкослоистость).  

Модел
ь 

Вид тонкослостой решотки, 
использующейса при моделировании 
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3.1.5 Создание простой горизонтально-слоистой модели по LAS- файлу 
(from LAS-file) 

В этом разделе описан простой способ построения модели по данным акустического 

каротажа и/или плотномера без предварительной загрузки данных в базу. 

 

 

Создания модели: команда Model/Create velocity Model (new frame). В диалоге Create new 

Model нажмите кнопку From LAS-file>. 

Далее в диалоге выберите LAS-файл с данными скорости и/или плотности. 

 

В диалоге LAS-file выберите кривую, соответствующую компоненту модели 

Compressional Velocity, Density, Share Velocity, и выберите единицы измерения данных в LAS- 

файле. 

Также рекомендуется правильно установить альтитуду скважины (Elevation). Хотя при 

Кривая АК (DT) 
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построении горизонтально-слоистой модели не используются данные инклинометрии 

скважины, но для условно вертикальной скважины альтитуды будет достаточно. 

В следующем диалоге Section установите длину и интервал глубин модели: 

 

Далее установите скорость в базовом полигоне. 
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В последнем диалоге Create polygons from LAS-file задайте параметры построения 

тонкослоистой модели. Эти параметры определяют количество и толщинуавтоматически 

создаваемых по LAS-файлу полигонов 

Clearance – максимальное допустимое изменение скорости внутри полигона. 

Min. Sampling rate by Depth – минимальная мощность, толщина полигона. 

 

В отличие от модели, построенной по скважинным данным из базы, где полигоны 

заполняются интерполированными параметрами из скважин, в случае использования одного 

LAS-файла модель формируется из множества тонких полигонов. Для проверки качества 

заданных параметров нажмите кнопку Create polygons. Измените параметры, если 

качество результата Вас не устраивает. 
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ЗАМЕЧАНИЕ: SPS-файлы можно использовать также только для задания 

системы наблюдения в уже готовой модели. Подробности в разделе Загрузка 

схемы наблюдения из SPS-файла. 

3.1.6 Создание модели по системе наблюдения (from SPS-file) 

Если Вы хотите в точности повторить полевую систему наблюдения для создания 

синтетических сейсмограмм, а также задать поверхность модели по высоте реальных 

источников и приемников, рекомендуется использовать SPS-файлы для создания новой 

модели. 

 

Создания модели: команда Model/Create velocity Model (new frame). В диалоге Create new 

Model нажмите кнопку From SPS-file>. 

Далее в диалоге Load SPS files выберите файлы источников, приемников и системы 

наблюдения. 

Кроме того, обратите внимание, что поддерживаются все типы SPS скриптов, а также SEG 

скрипты, KML (KMZ) и TXT файлы (со следующим простым форматом: SrcX, SrcY, SrcZ, 

RcvX, RcvY, RcvZ). 

 

После выбора и загрузки SPS файла, нажмите кнопку Далее и В следующем диалоге 

Profile задайте профиль модели 
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На рисунке красные прямоугольники – источники, а синие точки – приемники. 

Учтите, что в Tesseral Pro можно строить только 2D-модель и в модель «попадут» только 

источники и приемники вблизи выбранного профиля. 

Чтобы выбрать координаты профиля аккуратнее, воспользуйтесь кнопкой Zoom map 

В следующем диалоге Sources and receivers selection установите параметры 

отбора источников и приемников в модель. Этот диалог нужен, чтобы корректно извлечь 

только нужные источники и приемники из загружаемой 3D системы наблюдения. 
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В следующем диалоге Section установите интервал глубин модели и как использовать 

координаты высот источников и приемников, записанные в SPS-файлах (параметр Sources 

and receivers elevation) 

set SPS elevations – кровля базового полигона строиться по глубинам источников и 

приемников 

move under model top – источники и приемники опускаются (поднимаются) на кровлю 

модели 

ignore – базовый полигон модели и высота источников приемников устанавливаются 

независимо друг от друга. 
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Теперь, как и при других способах создания модели, необходимо заполнить полученную 

модель полигонами с параметрами (подробности в разделе Построение и редактирование 

полигонов). 
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3.1.7 Создание модели, используя подложку-картинку (from Picture) 

Используется для ручного рисования полигонов модели по подложке-картинке. 

Создания модели: команда Model/Create velocity Model (new frame). В диалоге Create new 

Model нажмите кнопку From Picture>. 

В следующем диалоге выберите картинку подложку формата BMP, JPEG, TIFF, а также GEO-

TIFF, GEO-JPEG с координатами в TFW, JGW файлах. Для этого нажмите кнопку 

Property. 

 

В диалоге Picture for Model файл картинки и область (часть) картинки, которая будет 

выводиться как подложка во фрейме Model 
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Выделите область 
модели мышкой 

 

В следующем диалоге Section установите интервал глубин модели и длину. 

 

В результате будет создан фрейм Model с подложкой-картинкой. 
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Эта подложка-картинка не может быть использована для моделирования, но полигоны можно 

нарисовать вручную по видимым границам, а потом заполнить созданные полигоны 

скоростями и др. параметрами. 
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Чтобы подложка всегда была видна, создаваемые вручную полигоны частично прозрачные.  
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3.1.8 Объединение нескольких способов создания модели 

Вы можете создать модель, используя одновременно SPS-файл и поверхности или 

сейсмограмму скоростной модели и скважинную информацию или все вместе. Для этого 

сначала надо создать модель любым способом, а потом опять вызвать команду создания 

модели Model/Create velocity Model (new frame). Вам будет предложено 

изменить существующую модель или создать новую 

 

Выберите ―Yes чтобы использовать другой метод создания модели для ее изменения. 
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3.1.9 Загрузка модели из файлов других форматов 

Команда Model> Create Velocity Model (New Frame), в появившемся диалоге 

Create new frame нажмите кнопку Load model from other format file… . 

Поддерживается загрузка из форматов TAM (формат модели Tesseral 2D), WGC, GXII и 

табличных текстовых файлов. Также можно загрузить модель из другого проекта (TPA). 
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3.1.10 Построение 3D модели из поверхностей (Surfaces) 

С помощью команды Map> Create Map (New Frame) > Load TXT or GRD- 

surface files загрузите поверхности и выберите среди них те, которые хотите 

использовать для построения модели в качестве горизонтов: 

 

 

 

Здесь представлена самая верхняя поверхность: 
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Просматривать и управлять каждой поверхностью по отдельности можно используя команду: 

Map> Manage/Delete surfaces. Далее, рекомендуется упорядочить горизонты 

используя Order Horizons by Depth. 

 

После того, как все поверхности были загружены, необходимо задать значения параметров 

для всех слоев, созданных этих поверхностей. Для того чтобы это сделать, сначала провести 

2D сечение (профиль) на карте. Это можно сделать с помощью команды Map> Section 

Mode. Проведите с помощью мышки профиль на поверхности (нажал- потянул-отпустил).  
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Чтобы отобразить двумерный профиль, нужно растянуть вниз поле заголовка, нажав и 

потянув правой кнопкой мыши: 

 

Это можно сделать, щелкнув левой кнопкой мыши по нижнему заголовку и перетащив его 

вниз левой кнопкой мыши. 

В растянутом поле появится двумерный разрез: 
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Чтобы задать значения параметров (например, скорость продольных или поперечных волн, 

плотность и т.д.) в определенном слое, используйте команду Map> Manage/ Delete 

Surfaces > Surface 3D-model Properties: 
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Если вы хотите закрасить вышележащий или подстилающий слои каким-нибудь цветом, 

выберите Surface type top или Surface type bottom соответственно. Этот шаг 

можно повторить для любой выбранной поверхности. Поскольку поверхности могут быть 

только одного типа (либо кровли Type: top, либо подошвы Type: bottom, но не 

одновременно того и другого), во фрейме карты могут быть «пустые» (без заливки) места. 

  

В заключение, чтобы создать файл 3D SEG-Y , используйте команду: Run > Map  Frame 
> Create 3D SEG-Y… 
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Задайте для вашей 3Dмодели размеры куба в направлениях X, Y, Z, шаг решетки, а также 

параметры и заливку Filling cells для тех слоев, которые остались «пустыми». Если вы 

хотите выполнить заливку «пустых» слоев из базовой сейсмограммы (т.е. из 3D Sgy куба), 

загрузите его с помощью команды Use base seismogram. 

Кроме того, можно выполнить заливку нескольких слоев из различных базовых 

сейсмограмм. В этом случае эти базовые сейсмограммы загружаются для каждой 

поверхности по отдельности в Map> Manage/ Delete Surfaces > 3D-model  Properties>Filling 

Empty cells(as default)>Use base seismogram. 
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Кроме того, можно выполнить заливку нескольких слоев из различных базовых 

сейсмограмм. В этом случае эти базовые сейсмограммы загружается для каждой 

поверхности с помощью команды Map> Manage/ Delete Surfaces > 3D-model  
Properties>Filling Empty cells(as default)>Use base seismogram. 

 

Важное примечание: Если были использованы одна или несколько базовых сейсмограмм 

для построения 3D куба, то пользователь заметит, что после нажатия OK в Run> Map 

Frame > Create 3D SEG-Y, сгенерированный 3D SGY куб НЕ содержат указанную база 
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сейсмограмма. Вместо этого, 3D сейсмограмма появится во фрейме карты для указанной 

поверхности. Ниже показан слой, полученный из 3D SGY куба: 

 

Если повторить команду Run> Map Frame > Create 3D SEG-Y еще раз, будет 

сгенерирован откорректированный куб. Таким образом, прежде чем генерировать куб, для 

проверки вы можете использовать фрейм с картой. 
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3.1.11 Задание вертикальных градиентов в 3D кубах 

 

Дополнительно, для любой поверхности можно задать вертикальный или горизонтальный 

градиенты. Чтобы задать вертикальный градиент присвойте вышележащую Map type: 

Top и подстилающую Map type: bottom поверхности соответственно, что обозначит 

слой, в котором будет задаваться градиент. Это делается в карте Map> Manage/ Delete 
Surfaces> Properties 

 

Когда тип карты Map type выбран, задайте значения градиентного изменения для кровли и 

подошвы: (т.е. в Map type: top и Map type: bottom), в Map> Manage/  Delete 

Surfaces> Properties, что и внесет вертикальный градиент. 
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3.1.12 Задание горизонтальных градиентов в 3D кубах 

Горизонтальный градиент может быть задан только из файла поверхности. Такие 

поверхности можно легко создать, вводя координаты X Y V в текстовом файле (с 

расширением *.xyz). Эти скоростные поверхности загружаются также, как и любые другие 

обычные поверхности File> Load Map file и должны быть с обозначенным 

параметром типа карты: Map type: Parameter в свойствах карты Map > Manage/ 
Delete Surfaces >  Properties. 

 

Затем, горизонтальный градиент (или скоростная поверхность) могут быть присвоен 

соответствующей поверхности в карте Map> Manage/ Delete Surfaces >  

Surface 3D-model Properties>Get value from map.  

Пожалуйста, обратите внимание, что значение VALUE должно быть задано в тех случаях, 

если имеются какие-либо «пробелы» в карте скоростей в местах разломов, выклиниваний или 

других сложных геологических построек. Если нет никаких пробелов в карте скоростей, то 

указанный параметр VALUE будет игнорироваться. 
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3.1.13 Задание цилиндрических тел и тетраэдров в 3D кубах 

Пользователь может задать цилиндры и тетраэдры в любом 3D Sgy кубе. 

Чтобы задать цилиндр, в первую очередь загрузить SGY куб во фрейм сейсмики File> 
Load Seismic file  

Куб в 3D виде (дополнительный вид): 

 

Затем кликните Run> Velocity Model Insert cylinder in Model Cube 

 

Укажите размеры цилиндра вдоль осей X, Y и Z, и его радиус Radius и значение скорости 

внутри Internal value. Вставьте цилиндр Insert cylinder после завершения. 
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Пожалуйста, имейте в виду, что на рисунке выше горизонтальная и вертикальная шкалы не 

совпадают. 

Чтобы задать тетраэдр, также загрузите SGY куб в сейсмический фрейм File> Load 

Seismic file, затем Run> Insert Tetrahedron in Model Cube. Затем нужно 

указать координаты для 4 вершин и значение скорости внутри Internal value для 

данного тетраэдра. 
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3.1.14 Построение 3D модели с использованием каротажных кривых 

Сначала необходимо выбрать месторождение со скважинами, с использованием которых вы 

хотите создать 3D модель. Чтобы сделать это, дважды щелкните по панели базы данных 

Database в дереве проекта (слева). Затем щелкните правой кнопкой на нужное 

месторождение и выберите Select a field for the project: 

 

Для того чтобы построить 3D модель из стратиграфических пластов в скважинах, 

необходимо выбрать сначала скважины: Map> Create Map (New Frame) > Show  database 

WELLS. 
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Полученная белая карта будет содержать все скважины выбранного нефтяного 

месторождения. 

Для того, чтобы указать, какие стратиграфические пласты в скважинах использовать, 

выберите команду Map> Calculation of Horizon from Well tops: 

 

Опция Automatic select layers предлагает различные критерии выбора слоев. 

Например: Only by all wells автоматически выбирает только те слои, которые 

являются общими для всех скважин в проекте. 

После того, как слои были выбраны, пользователь должен указать способ интерполяции в 

окне Choose mapping method (см. Построение карт поверхностей) 
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Затем сгенерированные стратиграфические поверхности можно рассмотреть, кликнув 

Map > Manage/Delete Surfaces. 

Для того чтобы задать значения для слоев, созданных из выбранных поверхностей, сначала 

нужно провести 2D сечение на карте. Это можно сделать командой Map> Section Mode. 

Начертите профиль на карте с помощью правой кнопки мышки (нажал- потянул-отпустил). 

 

Далее нужно задать величины скоростей для «пустых» слоев, построенных из поверхностей 

в Map> Manage/ Delete Surfaces> 3D-model Properties. 

 

С этого момента пользователь должен следовать инструкциям из раздела 3.1.10 (т. е. начать с 

рисования поперечного сечения по поверхностям) используя сначала Map> Section 

Mode.   
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3.1.15 Построение тонкослоистой 3D модели 

Для того, чтобы построить тонкослоистую 3D модель, используя скважинные данные, для 

начала нужно создать поверхности из стратиграфических данных в базе данных Database 

скважин. Эта процедура была описана выше. 

Как импортировать каротажные кривые и данные стратиграфии и инклинометрии, 

описано в разделе Загрузка данных. 

 

После того, как все поверхности будут сгенерированы, необходимо выбрать каротажные 

кривые для тонкослоистого моделирования в окне выбрав Map> Load Well Logs 

 

Если вы еще не начертили профиль во фрейме карты, выберите Map> Section Mode это 

используя левую кнопку мышки, проведите профиль. 

После выбора каротажных данных нужно выбрать те скважины, которые будут 

использоваться для построения тонкослоистой 3D модели. Для выбора скважины кликните 
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правой кнопкой мыши во фрейме с картой и командой Add well to profile отметьте 

скважину для вынесения ее на профиль. Повторите это для всех остальных скважин, которые 

хотите нанести на профиль. 

Теперь все ваши кривые должны отобразиться на профиле во фрейме карты: 

 

Чтобы включить тонкослоистость поверхностей, построенных из каротажных данных, нужно 

зайти в Map> Manage/ Delete Surfaces> Surface 3D-model  Properties и 

отметить птичкой бокс Use well log Values. 

 

 

Если вы хотите заполнить все поверхности данными из скважин, используйте команду Map  

> Manage/ Delete Surfaces > Surface 3D-model Properties> Filling 

Empty Cells (as default)>Use well log values (for all horizons). 
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После того, как все поверхности будут заполнены, выберите Run> Map Frame> Create 

3D SEG-Y. 
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Укажите желаемые размеры вашей 3D-модели вдоль осей X, Y, Z, шаг сетки, а также 

величину Filling cells, которая будет присвоена оставшемся пустым слою (слоям). 

Если вы хотите заполнить оставшийся пустой слой (слои) из базовой сейсмограммы (т.е. из 

3D SGY куба), загрузите его, используя базовую сейсмограмму Use base seismogram. 

Здесь же вы также можете ввести ограничения на мин. и макс. значения для тонкой 

слоистости в диапазоне значений Value Range. 

В заключение после нажатия ОК будет построен тонко-слоистый куб из скважинных данных. 
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© Tesseral Technologies -Документация Пользователя- 

69 

 

Текущее сечение OYZ 

Потяните одну из 

обозначенных пунктиром 

границ, чтобы выбрать 

сечение для 

редактирования 

Текущее сечение OXZ 

3.1.16 Создание 3D-модели со сложными разломами, используя фрейм 3D-
View 

Для создания новой или редактирования существующей 3D модели используйте команду 3D 

View> 3D Model Edit Mode. При создании новой модели отобразится диалог Create 3D 

Model. Задайте координаты границ куба модели и фоновую скорость продольной волны. 

Программа немедленно создаст два фрейма Model, непосредственно связанные с 3D 

моделью и между собой. (Фреймы Model используются для редактирования вертикальных 

сечений модели.) Модель по умолчанию состоит из восьми вершин, которые образуют по 

два вертикальных сечения вдоль осей Ox и Oy. Эти сечения соответствующих четырем 

вертикальным граням куба. Для того, чтобы выбрать одно из сечений для редактирования во 

фрейме Model, потяните мышью во фрейме 3D View обозначенную пунктиром границу 

сечения (пунктирную рамку) вдоль соответствующей оси. При отпускании левой кнопки 

мыши будет выбрано ближайшее к границе сечение. В качестве альтернативы можно 

использовать комбинацию клавиш CTRL+↑ или CTRL+↓ для выбора сечения XZ и CTRL+→ 

или CTRL+← для выбора сечения YZ. Для этого должен быть выбран один из фреймов 

Model или 3D View. Также сечение для редактирования может быть выбрано в Дереве 

Объектов: 3D View > Model > XZ (YZ) Section. 

 

Активные (выбранные) срезы куба модели, которые показаны во фреймах Model, можно 

редактировать как 2D модель. Основное отличие – это требование для любого созданного 

полигона иметь тип «top». (Другие типы не доступны). Программа поддерживает одинаковое 
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количество вершин поли-линии в каждой верхней границе полигона. Это достигается путем 

автоматической вставки недостающих вершин. Подобным образом каждый полигон, 

созданный в активном сечении, будет создан в других сечениях с интерполяцией между 

ближайшими верхним и нижним полигонами. 

Редактирование трехмерной модели рассмотрим на примере трапециевидной призмы. 

 

Перемещение вершины в одном из фреймов Model приводит к ее перемещению в связанном 

фрейме Model, если вершина принадлежит линии пересечения текущих разделов XZ и YZ. 

Вершина также перемещается во фрейме 3D View. Вершину также можно переместить по 

команде Edit node контекстного меню вершины во фрейме Model, установив точное 

Вершина (800, 400, -200) 

Линия пересечения 

текущих разделов 

XZ и YZ 
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значение в точке. Перемещение вершины в разделе XZ не затрагивает y-координату, также 

как перемещение в разделе YZ не изменяет x-координату вершины. Переместить также 

можно весь раздел целиком вдоль одной из осей координат OX или OY. Для этого нужно 

потянуть за рамку выбора (пунктирную рамку), зажав CTRL. Перетягивание первого и 

последнего разделов (в примере разделы номер 0 и номер 5) приводит к изменению границ 

модели! Раздел также можно переместить по команде Move контекстного меню рамки 

выбора, которое доступно по щелчку правой кнопки мыши. 

  

 

 

Вставка вершины во фрейме Model приводит к добавлению нового раздела: YZ, если 

вершина была вставлена в поли-линию раздела XZ и раздела XZ, если вершина была 

вставлена в раздел YZ. Раздел также можно добавить в точную позицию по x- или y- 

координате по команде Insert контекстного меню рамки выбора. 

Удаление одной вершины приводит к удалению целого раздела. Например, удаление 

вершины номер 3 в разделе XZ нашего примера (на предыдущем рисунке обведена 

кружочком) приведет к удалению активного раздела YZ. При этом активным станет раздел, 

ближайший к рамке выбора YZ. Аналогично, удаление вершины в разделе YZ приводит к 

удалению целого раздела XZ. Раздел также может быть удален при помощи команд 

контекстного меню Delete, Delete node и Delete Дерева Объектов, вершины фрейма 

Model и рамки выбора соответственно (рис. 3). Удаление целого полигона во фрейме Model 

(команда Model> Delete Polygon) приводит к удалению горизонта 3D модели. 

Горизонт может быть удален также по команде контекстного меню Дерева Объектов. 

Для лучшего понимания геометрии решетки модели используется штриховка. Кроме того, 

можно скрыть/показать ячейки сетки (галочка Show Mesh). Эти опции могут быть настроены 

по команде меню 3D View> 3D Model Properties либо по команде Properties 

контекстного меню Дерева Объектов: 

a) b) c) 



© Tesseral Technologies -Документация Пользователя- 

72 

 

 

Опция прозрачности полигонов устанавливаются по команде меню Model> Wells & 

Polygons> Polygon Fill Options: 

 

Снимите галочку с «Palette» для прозрачности полигонов. 

Горизонт модели состоит из ограниченных восьмиугольных ячеек решетки, созданных 

соответствующими (с одинаковым номером) полигонами различных сечений. Соответствие 

выражается через тот же идентификатор (ID) полигона. Свойства горизонта 3D модели 

можно задать во фрейме Model как свойства соответствующего полигона. Диалог свойств 

также доступен по команде Properties контекстного меню Дерева Объектов. 

Для того, чтобы вставить в 3D модель новый горизонт, создайте обычным образом новый 

полигон типа «top» в одном из связанных фреймов Model. Для того, чтобы удалить 

горизонт, выберите полигон, соответствующий его кровле в связанном фрейме Model, и 

удалите его. Либо воспользуйтесь командой Delete контекстного меню горизонта в Дереве 

Объектов. Команды меню и элементы управления панели инструментов фрейма Model 

используются так же, как и для 2D моделей. Команды редактирования 3D модели можно 

отменить/повторить при помощи стандартных команд Undo/Redo. 
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Для вставки нового вертикального сечения в модель используйте контекстное меню для 

пунктирной границы сечения, вызываемое щелчком правой кнопки мыши. Выберите 

команду контекстного меню Insert 3D Model Section (вставить сечение 3D-модели). 

Новое сечение вставляется только в положение границы сечения по оси Y: «регуляризация» 

набора сечений не производится. Поэтому будьте внимательны. Чтобы удалить вертикальное 

сечение, выберите его либо мышью, либо комбинациями клавиш клавиатуры CTRL+↑ или 

CTRL+↓ в фрейме 3D View. Выберите команду контекстного меню Delete 3D Model 

Section (удалить сечение 3D-модели). Чтобы сместить выбранное вертикальное сечение по 

оси X или Y, нажмите CTRL и перетащите пунктирную границу сечения. 

Для того, чтобы увидеть горизонты модели во фрейме 3D View, следует отключить режим 

Положение новой секции 3D модели 

  

Вершины, которые автоматически 

будут вставлены в новую 

полилинию 

Новые вершины, которые 

будут вставлены в каждую 

полилинию 3D модели 
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редактирования (команда меню 3D View> 3D Model Edit Mode) – перейти в режим 

просмотра. В режиме редактирования отображаются только активные (редактируемые) 

разделы, в то время как в режиме просмотра отображаются все вертикальные разделы и 

горизонты, отмеченные галочками в Дереве Объектов. Галочки у вершин Дерева Объектов 

Horizons, XZ Section и YZ Section позволяют скрыть/показать все горизонты, 

разделы XZ либо разделы YZ соответственно в обоих режимах. Используя галочку при 

вершине Model, можно также скрыть/показать всю модель. 

 

 

 

3D модель также можно инициализировать из карт горизонтов фрейма Map проекта. Для 

этого воспользуйтесь командой меню 3D View> Create 3D Model from Maps и 

настройте параметры в диалоге, который отобразится на экране. Список карт горизонтов 

можно редактировать: карты, удаленные из списка расположенной ниже кнопкой, 

исключаются из 3D Модели, но остаются нетронутыми во фрейме Map. Параметры Min и 

Max диалога задают границы модели. Для автоматического подбора значений по списку карт 

горизонтов предусмотрена кнопка. Дополнительные параметры Step и Size задают 

дискретизацию решетки модели. 
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Отредактированную модель можно сохранить как регулярная решетка в формате SEG-Y 

куба по команде меню 3D View> Export 3D Model to SEG-Y. Полученный 

сейсмический куб можно затем использовать при построении новой трехмерной модели. 

Таким образом можно вставлять объекты сложной формы в горизонтально-слоистую модель. 

Например, вставив в рассмотренную выше модель трапециевидной призмы горизонт сверху, 

мы можем установить его скорости по экспортированному ранее SEG-Y кубу, который 

содержит горизонтально-слоистую модель. Это делается в диалоге свойств горизонта (раздел 

3.2.5). 

Куб 3D модели 

Размер грида 

Карты горизонтов 

из фрейма Map 
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Еще одна команда 3D View > Export 3D Model to Text Files экспортирует отдельные 

горизонты модели в виде решетки в текстовом формате. 
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3.2 Построение и редактирование полигонов 

После создания пустой модели 2D (фрейм Model) ее надо «заполнить» геологическими 

объектами и выбрать их свойства. В Tesseral Pro для этого используются полигоны. Полигон 

– это ограниченный объект на модели, обладающий набором параметров (продольная и 

поперечная скорости, плотность, анизотропия, трещиноватость). Построенная модель, таким 

образом, полностью – от поверхности земли до подошвы и от левой до правой стороны 

должна быть заполнена полигонами с установленными свойствами. 

В процессе формирования задания на моделирование (построение синтетических 

сейсмограмм) по полигональной модели создается решетка с заданным шагом вдоль линии 

разреза и по глубине. Параметры каждого узла этой решетки устанавливаются из полигона, 

внутри которого оказался этот узел. Если узел «покрывается» несколькими полигонами, то 

параметры устанавливаются по «верхнему» полигону. 
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Способ построения 
полигона 

3.2.1 Создание полигона вручную 

Выберите мышкой фрейм Model. Команда Model/Create new polygon. 

 

В диалоге New Polygon выберите или введите имя полигона (Polygon name), 

установите способ построения полигона (Polygon type). Поддерживаются следующие 

типы полигонов 

 

• Polygon type: top&bottom – полигон составляется из 2-х границ кровли и 

подошвы. 

 

• Polygon type: top – пользователь рисует только кровлю полигона, подошва 

строится автоматически и совпадает с подошвой модели. 

Подошва полигона 

Кровля полигона 

Тип полигона – top&bottom 
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Подошва всегда 

совпадает с нижней 

границей модели 

Кровля полигона 

Polygon type - top 

 

• Polygon type: bottom – рисуется только нижняя граница полигона. Верхняя 

граница совпадает с верхней границей модели или располагается на уровне нулевой 

глубины, если кровля модели выше 0. 

 

• Polygon type: closed loop (object) – рисуется замкнутая линия границы. 

Подошва полигона 

Кровля полигона – глубина 

равна 0 

Polygon type –bottom 
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•  

• Polygon type: line – рисуется одна линия, толщина полигона задается 

параметром weight of line (m) в диалоге New polygon при выборе данного 

типа полигона. 

 

После выхода из диалога New Polygon щелкните мышкой, добавляя вершины нового 

полигона. При создании полигона можно выходить за границы Frame Model. Конец 

создания полигона – правая кнопка мышки или двойной щелчок левой кнопкой мышки 

(обязательно внутри Frame Model). Когда новый полигон создан, появится расширенный 

диалог редактирования свойств полигона. 

  

Полигон, толщиной 50 м. 

Polygon type – line 

Полигон 

Polygon type – closed loop (object) 
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3.2.2 Изменение формы полигона 

Выбрать полигон можно мышкой либо из списка всех полигонов в инструментальной 

линейке редактирования модели. У выбранного полигона зеленым цветом выделяются 

границы. Добавить вершину (узел) в границу полигона – нажатие левой кнопки мышки на 

линии кровли (подошвы). Удаление вершины – нажатие правой кнопки мышки на вершине. 

Смещение вершины – мышкой с нажатой левой кнопкой (нажал-потянул-отпустил). 
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3.2.3 Смещение и копирование полигона 

Выберите полигон мышкой или из списка в инструментальной линейке и вызовите команду 

Model/Drag polygon для перемещения или Model/Copy Polygon для копирования 

выбранного полигона. После этого щелкните левой кнопкой мышки на фрейме Model, чтобы 

завершить перетаскивание (копирование). 
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ЗАМЕЧАНИЕ: Пользуйтесь командами Undo/Redo для отмены неправильного 

действия. 

3.2.4 Удаление полигона 

Для удаления выделенного полигона выполните команду Model/Delete polygon. 
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3.2.5 Редактирование свойств полигона 

Выберите полигон мышкой либо из списка всех полигонов в инструментальной линейке. 

Граница выбранного полигона должна выделиться толстой зеленой линией. Редактирование 

свойств полигона выполняется командой Model/Edit polygon. 

 

Polygon Name – текущее имя полигона. Если полигон соответствует пласту в скважинах, 

рекомендуется, чтобы его имя совпадало с именем пласта. В выпадающем списке Polygon 

Name показывается весь набор имен пластов базы. 

Группа Component – скорость, плотность и другие параметры заполнения полигона. 

Если галочка перед названием параметра не стоит, значения этого параметра рассчитывается 

автоматически по другим параметрам. 

From Log – заполнять полигон, интерполируя данные по каротажным кривым из скважин. 

Кнопка Select Well-logs – выбор кривых в Frame Model, настройка их типа 

(скорость, плотность) и единиц измерения. 

From Seismogram – заполнять полигон по данным подложки-сейсмограммы. Кнопка 

Property seismogram – выбор подложек-сейсмограмм в Model Frame, 

настройка их типа (скорость, плотность) и единиц измерения. 

Кнопка By default – сохранение введенных значений компонентов для заполнения 

значений по умолчанию при повторном создании полигона с тем же именем. 

Режим Smoothing border позволяет автоматически сгладить границы полигона, причем, 

если Polygon Type выбран top&bottom, кровля и подошва сглаживаются независимо. 
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Кнопка Drawing Properties – параметры отображения заливки полигона и границ. На 

последующий расчет синтетических сейсмограмм не влияет 

  

Сглаженная граница Не сглаженная граница 
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3.2.6 Анизотропия и другие параметры 

Для ввода данных об анизотропии и трещиноватости нажмите кнопку Anisotropy and 

Other Properties в диалоге Polygon Properties. В появившемся диалоге 

установите значения параметров. 

По умолчанию полигон изотропен (Anisotropy не выбрано). 

 

Thompsen‘s Parameters (Коэффициенты Томсона): ε (Epsilon), δ (Delta) , γ (Gamma) и угол 

наклона ψ (Psi) оси симметрии по отношению к вертикали трансверсально-изотропной (ТИ) 

вмещающей среды в области полигона. 

Значения коэффициентов ε и δ определяют различие в скоростях qP и qSV - волн по 

различным направлениям по отношению к скоростям вдоль оси симметрии, вмещающей ТИ 

среды, и используются только в режиме Elastic Anisotropy. Параметр γ определяет скорости 

распространения qSH-волны по разным направлениям и не оказывает влияния на решение 

2D-задачи (введен в параметры для полноты и использования в перспективе). 

Fracture (Трещиноватость) задает интенсивности трещиноватости во вмещающей среде, 

определяется параметрами δn (Dn) , δt (Dt) и углом наклона трещиноватостей α (Alpha) по 

отношению к вертикали. 

Каждый слой может иметь от нуля до трех различных трещиноватостей. Параметры δn (Dn) , 

δt (Dt) принимают значения из интервала [0,…,1]. Угол наклона α (Alpha) задается в пределах 

[-90°,…,90°]. Значения параметров δn (Dn) , δt (Dt) зависят от плотности трещин, 

коэффициента Пуассона вмещающей среды и от того, чем заполнены трещины: твердой 

породой, флюидом или газом. Они оказывают влияние как на скорости распространения всех 

типов волн вдоль различных направлений, так и на их динамические свойства. 

Q-factor (Добротность) позволяет установить параметр поглощения сейсмической энергии в 

среде. 

Этот параметр измеряется в единицах добротности: величины обратной к декременту 

поглощения, т.е. ослабления волны при пробеге расстояния, равного длине волны. 

Добротность может быть назначена отдельно для продольных (Compressional) и 
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поперечных (Shear) волн. 

Группа Sources type: Reflector, параметр Muted – подавление генерации волнового 

фронта от всех границ полигона (для типа источников Reflector). Выбор типа источника 

описан в разделе Выбор метода моделирования и основных параметров (General). 
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3.2.7 Порядок перекрытия полигонов 

Все полигоны в модели выводятся по порядку в списке полигонов (список на 

инструментальной линейке редактирования модели). Поднять (поместить наверх), опустить 

(поместить вниз) полигон можно командами Model/Bring Polygon Forward, 

Model/Bring Polygon Backward. Эти команды опускают/поднимают полигон на один 

уровень, т.е. меняют в списке выбранный полигон с предыдущим/последующим. Для того 

чтобы «выставить» полигон правильно (т.е. установить правильную последовательность 

перекрытия полигонов) повторите команду несколько раз. 
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3.2.8 Базовые точки 

Базовые точки позволяют задавать градиент изменения значений компонентов в полигоне. 

Выберите полигон, в который хотите добавить базовые точки. 

Добавление базовой точки в активный (выбранный) полигон – команда Add Base Point в 

контекстном меню по правой кнопке мышки или команда меню Model/Base Point/Add 

Base Point. 

 

 

В диалоге Base Point введите координаты базовой точки и значения компонентов. 

Градиент будет рассчитываться автоматически между каждыми двумя последовательно 

введенными базовыми 

точками:
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Редактирование параметров базовой точки производится с помощью контекстного меню по 

правой кнопке на базовой точке, команда Edit Base Point или команда меню 

Model/Base Point/Edit Base Point для активной (выделенной красным цветом) 

базовой точки. 

Базовые точки можно перемещать мышкой (нажал-потянул-отпустил) и удалять по команде 

контекстного меню Delete Base Point, или Model/Base Point/Delete Base 

Point. 

Также есть возможность провести интерполяцию между базовыми точками с учетом 

геометрии полигона (аналогично, как и для каротажных кривых). Для этого правой кнопкой 

мыши нужно кликнуть на полигон и выбрать команду Polygon Properties > 

Interpolate like well-logs. 

Базовые точки 
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Верхняя базовая точка задает скорость вдоль кровли полигона, а нижняя базовая точка – 

вдоль его подошвы, а сгенерированный градиент является однородным по отношению к 

геометрии полигона (как показано на рисунке выше). В правой панели показан пример с 

более грубой иллюстрацией градиента (сгенерированным по двум базовым точкам, которые 

отображается как белые квадраты), а левая панель представляет собой соответствующий 

файл SGY с иллюстрацией градиента, сгенерированного с учетом геометрии границ. 
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3.2.9 Построение полигонов по пластопересечениям в скважинах 

Поддерживается только в моделях, построенных по скважинам с пластами. Про построение 

таких моделей в разделе Создание модели по скважинным данным (from database 

WELLS). 

Выберите мышкой фрейм Model. Команда Model/Create polygon. В диалоге New 

Polygon установите Polygon Name из списка кодов пластов базы. Эти полигоны должны 

были быть созданы заранее, используя тип Top и Bottom (Кровля и Подошва), и сохранены 

в базе данных. 

 

Если имя полигона совпадает с именем пласта хотя бы одной из загруженных в модель 

скважин, то Вам будет предложено построить полигон автоматически по данным 

пластопересечения: 

 

Результат: 
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Поддерживается автоматическое построение группы полигонов по нескольким выбранным 

пластам. Команда Model> Wells & Polygons > Create Polygons  from Well 
Strata Marks 

 

Выберите из списка пласты, которые хотите использовать для заполнения модели 

полигонами. Результат – автоматически построенная глубинная модель: 

Автоматически 

созданный полигон 
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ЗАМЕЧАНИЕ: Для построения тонкослоистой модели по каротажным кривым 

рекомендуется сначала подготовить ее с помощью Wizard-а создания модели 

From  Database WELLS. Подробности в разделе Создание модели по 

скважинным данным (From database WELLS). 

3.2.10 Полигоны по каротажным кривым (тонкослоистость) 

Tesseral Pro позволяет создавать тонкослоистую скоростную модель, используя скважинные 

данные (в частности, акустический каротаж). 

 

ШАГ 1. Выбор кривых акустического каротажа. В диалоге Model Properties 

Модели, построенной по скважинам, выберите кривые акустики (DT или AK). Для этого в 

группе Well data установите галочку при кнопке Log с левой или с правой стороны 

скважины. Далее нажмите кнопку Log и в появившемся диалоге выберите акустические 

кривые из списка всех кривых скважин модели. Для дальнейшего заполнения параметров 

полигонов по данным каротажа установите для выбранных кривых тип Compressional 

Velocity or dT и в окошке Measurement unit установите единицы измерения кривой 

mks/m для правильного пересчета в параметры полигонов. 

 

В результате рядом со скважинами на модели должны появиться каротажные кривые. 

ШАГ 2. Построение полигонов. Для тонкослоистой модели используются обычные 

«толстые» полигоны, построенные как вручную (раздел «Cоздание полигона вручную»), так 

и любым автоматическим способом (раздел «Построение полигонов по пластопересечениям 

в скважинах» или раздел «Создание модели по картам поверхностей (From SURFACES)»). 

ШАГ 3. Установка компонентов полигона «из кривых» (From Log). 

Выберите полигон и выполните команду Model/Edit polygon. Если в модели правильно 

выбраны акустические кривые (шаг 1), то выбор From Curve должен быть доступен для 

3. Установка шкалы и линии 
кривой 

2. Установка тип кривой и 
единиц измерения 

1. Добавление кривых в 

скважины 
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ЗАМЕЧАНИЕ: Если выбор From Log не доступен (серый) нажмите кнопку 

From  Log для правильного выбора кривых акустического каротажа в модель 

ЗАМЕЧАНИЕ: После выбора From Log и нажатия ОК расчет интерполяции 

для компонентов не начнется немедленно. И значения компонент From Log 

заменят значения, установленные по умолчанию при запуске расчета. 

компонента Compressional velocity. Выберите From Log 

 

Если приведенные выше шаги выполнены правильно, вы увидите результат, похожий на 

рисунках ниже. Для получения второго изображения, необходимо удалить верхний полигон, 

используя кнопку " Delete Polygon (Удалить Полигон)". 

 

Заполнение 
компонентов из 
каротажа 
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Режимы интерполяции данных 

каротажа в полигонах 

 

Специфика полигонов по кривым 

Полигон по кривым заполняется интерполяцией скважинных данных вдоль пласта. 

Существует три режима интерполяции. 

 

• Stratification: Равномерное сжатие, растяжение пропорционально мощности пласта: 
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Скважина 

Кровля 

пласта 

Интерполяция 

только по 

кровле 

Интерполяция 

данных 

Подошва пласта 

(полигона) 
Кривая 

 

 

• Interpolation parallel to the Top (Down lap): Интерполяция данных будет 

«параллельна» кровле полигона. 

 

• Interpolation parallel to the Bottom (Top lap): Интерполяция данных 

будет «параллельна» подошве полигона. 

 

Скважина 

Кровля 

пласта 

Интерполяция 

по кровле и 

подошве 

Интерполяция 

данных 

Подошва пласта 

(полигона) 
Кривая 
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Параметры отображения заливки полигонов, построенных по каротажным кривым задаются 

командой Model> Wells & Polygons > Well-Log Based Polygon  

 

Опции заполнения (Fill Options) 

 

  

Top Lap Down Lap 

Stratification Model 
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ЗАМЕЧАНИЕ: Для построения модели по сейсмограмме рекомендуется 

сначала подготовить ее с помощью Wizard-а создания модели From SEISMIC 

file. Подробности в разделе Создание модели по сейсмическому файлу (From 

SEISMIC file) 

3.3 Создание модели на основе 2D и 3D сейсмограмм 

В Tesseral Pro реализована возможность построения модели путем импортирования 

скоростных моделей в формате SEG-Y, SDS-PC, TGR. Сейсмическая модель может быть 

использована как подложка при построении полигонов и как источник заполнения 

созданных полигонов скоростями. 

 

При построении п о л и г о н о в , и с п о л ь з у я  сейсмическую подложку к а к  фоновую 

«картинку», рекомендуется настроить прозрачность модели с помощью команды Edit> 

Palette. 

 

  

Прозрачность палитры 
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Диалог настройки 

подложки-сейсмограммы 

Значение компонента по 

сейсмограмме 

3.3.1 Значения компонентов в полигонах по решетке сейсмограммы-
подложки 

В диалоге параметры полигона (команда Model> Edit Polygon) установите From 

Seismogram для любого компонента. Кнопка From Seismogram серая, если не 

установлена подложка сейсмограмма или для сейсмограммы не выбран компонент 

(подробности в разделе Создание модели по сейсмическому файлу (From SEISMIC file)). 
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3.3.2 Параметры анизотропии Томсона-Цванкина 

Теперь можно запускать 2.5D Elastic моделирование для сред с орторомбической 

анизотропией. Орторомбической среда может быть описана с помощью 7 безразмерных 

параметров Томсона-Цванкина, которые доступны в свойствах полигона Polygon 

Properties> Anisotropy & Other Properties >Thomson’s Tsvankin  

parameters 

 

 

В окне параметров анизотропии Advanced Polygon Anisotropy Parameters 

пользователь может указать либо параметры анизотропии Томсона-Цванкина и рассчитать 

коэффициенты упругой жесткости, или непосредственно указать жесткости тензора для 

выбранного полигона. 
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3.3.3 Параметры пористости среды 

Теперь пользователь может указать параметры пористости среды для любого полигона в 

модели. Чтобы задать эти параметры щелкните правой кнопкой мыши на нужном полигоне и 

выберите Edit Polygon> Porous 

 

 

После того, как пористость была задана, а также значения скоростей упругих волн и 

плотности для минералов, сухих пород и жидкостей Mineral, Dry Rock и Fluid, 

величины скоростей насыщенных пород и объемной плотности в окне свойств полигона 

Polygon properties соответственно изменятся (на основе уравнения Гассмана). 
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© Tesseral Technologies -Документация Пользователя- 105 

 

Приемники. Черным цветом 
выделяются приемники текущего 
(серого) источника 

Источники 

ЗАМЕЧАНИЕ: Предложение запустить Acquisition geometry WIZARD 

появляется каждый раз при создании новой модели. 

4 Создание схемы наблюдения 2D 

 

Для выбора текущего источника во фрейме Model щелкните левой кнопкой мышки на этом 

источнике (треугольник). Текущий источник выделяется серым цветом. Приемники 

текущего источника показываются в виде черных квадратиков. Остальные приемники имеют 

вид серых квадратиков. Для перемещения источников и приемников вручную используйте 

мышку в режиме нажал-потянул-отпустил. 

Начальная расстановка источников (пункты взрыва) и приемников (пункты приема) – 

команда Model/Acquisition geometry. В этом диалоге задается количество, шаг, 

расположение и схема наблюдения, определяющая связь между каждым источником и 

группой его приемников. 

Вам будет сразу предложено задать расстановку источников и приемников с помощью 

последовательных шагов. 

 

Поскольку ручная настройка схемы наблюдения дело сложное, рекомендуется согласиться на 

WIZARD. 

 

В Tesseral Pro реализовано несколько схем наблюдения, определяющие порядок и 

расположение приемников для каждого источника (пункта взрыва). В зависимости от 

выбранной схемы, в WIZARD-е может быть от одного до 4 диалогов. 
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Выберите схему 
наблюдения 

4.1 Перемещение приемников с источником 

Размещение приемников задается относительно одного источника и повторяется аналогично 

(дублируется) для остальных источников модели 

ШАГ 1. Схема наблюдения. 

 

В диалоге Observation scheme выберите Move receivers with source. Если 

выбран этот режим, то дальше Вы задаете размещение источников, а потом задайте 

размещение приемников относительно одного источника. В результате группа приемников 

каждого источника будет иметь именно такое же размещение относительно «своего» 

источника. 

ШАГ 2. Источники. В диалоге Source выберите из списка изменяемые параметры и 

введите значения в открытые ячейки параметров. Источники будут автоматически 

размещены равномерно вдоль поверхности наблюдений (по верхним границам полигонов 

модели). 

 

From – начало линии источников вдоль профиля модели. 

To – конец линии источников вдоль профиля модели. 

Step – шаг между источниками. 

Number – количество источников. 

Выберите изменяемые 

параметры 

Расстановка источников 
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ЗАМЕЧАНИЕ: Параметры связаны между собою простым соотношением 

Number=(To-From)/Step+1. Поэтому изменение одного из параметров приводит к 

перерасчету другого (других). 

 

ШАГ 3. Приемники (для схемы «Move receivers with source»). 

 

В диалоге Receivers (geophones) задаете линию приемников аналогично линии 

источников. Параметры From и To – это не абсолютное смещение относительно начала 

профиля, а смещение группы приемников относительно «своего» источника (удаление со 

знаком). 
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4.2 Фиксированная позиция приемников 

Приемники и источники размещаются независимо друг от друга. А потом для каждого 

источника выбирается его группа приемников. 

ШАГ 1. Схема наблюдения. 

В диалоге Observation scheme выберите Fixed receivers position. В 

следующих диалогах Вы задаете линию источников, и независимо от источников задаете 

линию приемников, а потом для каждого источника выделяете его группу приемников. 

ШАГ 2. Источники (для схемы «Fixed receivers position»). Диалог Source одинаковый 

для всех схем наблюдения. Подробное описание см. выше. 

ШАГ 3. Приемники (для схемы «Fixed receivers position»). 

 

Диалог Receivers (geophones) для схемы наблюдения «Fixed receivers position» 

аналогичный диалогу Source. Параметры From и To задаются как смещение вдоль линии 

профиля модели. Подробное описание (для диалога Source) см. выше. 

Задайте количество используемых приемников (из всей линии приемников) слева и справа от 

любого источника. 
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4.3 Нулевое смещение 

В этой схеме у каждого источника только один совпадающий по координатам приемник. 

Используется, например, для лучевого трассирования. 

ШАГ 1. Схема наблюдения. 

В диалоге Observation scheme выберите Zero-offset shooting. В следующем 

диалоге Вы задаете линию источников. Приемники располагаются автоматически так, что 
каждому источнику соответствует только один приемник, совпадающий по координатам с 

источником. 

ШАГ 2. Источники (для схемы «Zero-offset shooting»).  

Диалог Source одинаковый для всех схем наблюдения. Подробное описание см. выше в 

разделе Перемещение приемников с источником. 
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4.4 ВСП, ВСП с подъемом приемников 

Используется для задания системы наблюдения ВСП, когда источники расположены на 

поверхности. Можно построить схему наблюдения для неподвижной линии приемников или 

для приемников «поднимающихся» по скважине. 

 

ШАГ 1. Схема наблюдения. 

В диалоге Observation scheme выберите VSP(moving source). 

 

Приемники 

выбранного источника 

Приемники 

выбранного источника 
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ШАГ 2. Источники. Диалог Source такой же, как для других схем наблюдения. 

Подробное описание см. выше в разделе Перемещение приемников с источником. 

ШАГ 3. Приемники. 

 

В диалоге Receivers (geophones), как и для схемы наблюдения Перемещение 

приемников с источником надо задать расстановку приемников для первого источника. 

ШАГ 4. Приемники. Дополнительные параметры 

 

Укажите, как расположены приемники: вдоль вертикальной линии или вдоль скважины. 

Скважину можно выбрать из списка скважин, использующихся в модели (как добавить 

скважину в модель, описано в разделе Диалог свойств фрейма Model). 

Пример размещения приемников вдоль скважины: 
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Параметр Move receivers for every source on используется в схеме наблюдения, 

когда приемники поднимаются в скважине в процессе сейсмических наблюдений. 

  

Приемники по скважине 
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4.5 ВСП диполь 

Источники, как и приемники, расположены в скважине. 

 

ШАГ 1. Схема наблюдения. 

В диалоге Observation scheme выберите Dipole VSP. 

ШАГ 2. Источники. Диалог Source такой же, как для других схем наблюдения. 

Только источники располагаются вдоль вертикальной линии или скважины. 

ШАГ 3. Приемники. 

В диалоге Receivers (geophones), как и для схемы наблюдения Перемещение 

приемников с источником надо задать расстановку приемников для первого источника. 

ШАГ 4. Приемники. Дополнительные параметры 

Укажите, как расположены приемники: вдоль вертикальной линии или вдоль скважины. 

Параметр Move receivers for every source by используется в схеме наблюдения, 

когда приемники поднимаются в скважине в процессе сейсмических наблюдений. 
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4.6 Загрузка схемы наблюдения из сейсмограммы 

Если у Вас есть сейсмограммы полевых исследований, то данные о координатах источников 

и приемников, а заголовках трасс можно использовать для задания схемы наблюдения 

модели. 

ШАГ 1. Схема наблюдения. 

В диалоге Observation scheme выберите Load from seismogram. В следующем 

стандартном диалоге Open File (Открыть файл) выбираете сейсмический файл. Все 

источники, приемники будет загружена из заголовков трасс выбранной сейсмограммы. 
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4.7 Загрузка схемы наблюдения из SPS-файла 

ШАГ 1. Схема наблюдения. 

В диалоге Observation scheme выберите Load from SPS-file. 

В следующем диалоге SPS-file load выберите SPS файлы. Также, если Вы используете 

SPS-файлы 3D расстановки, то настройте условия отбора источников и приемников в модель 

(группа Sources and receivers selection), чтобы не засорять 2D модель лишними 

данными. 

 

В следующем диалоге Map выберите сечение модели вдоль линии приемников. 

 

Если длина модели меньше, чем выбранная длина профиля в диалоге Map, Вам будет 

предложено исправить (расширить) модель. 

Модель можно полностью построить, используя данные SPS-файлов, как описано в разделе 
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Создание модели по системе наблюдения (From SPS-file). 
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Задайте линию размещения источников и приемников 

Можно вызвать Wizard прямо из диалога 

Приемники по скважине 

4.8 Стандартный диалог расстановки источников и приемников 

Кроме Wizard-а для расстановки источников и приемников по команде Model> 

Acquisition Geometry можно загрузить общий диалог. На вопрос, запустить ли Wizard, 

выберите No. 

 

Группа Sources (shot points) задает размещение источников, Receivers 

(geophones) – приемников. Группы Allocation для источников и приемников 

определяют линию, вдоль которой будут располагаться источники (приемники). Если Вы 

выберете пункт Well и скважину из списка, то источники (приемники) разместятся вдоль 

выбранной скважины. 
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Если Вы выберите Free в группе Sources Allocation или Receivers  

Allocation, то каждый источник (приемник) можно будет размещать прямо на модели 

независимо от остальных. Иначе все источники/ приемники можно будет двигать только 

группой вдоль линии, определяемой в группах Allocation. 
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5 Моделирование: расчет синтетических сейсмограмм 

Для выполнения расчета синтетических сейсмограмм необходимо иметь модель 

(раздел 3) и систему наблюдения (раздел 4 ). 

Перед выполнением расчет необходимо сохранить проект (команда File/Save Project). 

Выполните команду Run> Run Modeling для задания параметров моделирования. 

  



© Tesseral Technologies -Документация Пользователя- 121 

 

5.1 Выбор метода моделирования и основных параметров (General) 
 

Главный параметр – использующийся метод решения волнового уравнения Modeling 

Procedure. Доступные следующие процедуры моделирования: 

 

• 2D Vertical Incidence – для вертикального распространения волн и горизонтальных границ. 

Позволяет быстро оценивать время прихода и амплитуды отраженных волн на временном разрезе при 

условии строго вертикального 1-D распространения сейсмической энергии. 

• 2D Scalar – для скалярной модели среды (жидкостное приближение без учета вариации плотности 

породы). Учитывает только распределение продольных скоростей и является наиболее быстрым 

способом моделирования 2-D распространения волн. 

• 2D Acoustic – для акустической модели среды – использует только распределение продольных 

скоростей и плотностей (жидкостное приближение) и дает возможность оперативно оценить волновые 

2-D эффекты распространения сейсмической энергии в реальной геологической ситуации. 

• Acoustic without multiples – для быстрого получения временного разреза в акустической 

модели среды. В целом соответствует режиму взрывающихся горизонтов других методов, но не 

учитывает кратные волны, благодаря чему изображение меньше зашумлено. Позволяет изучать 

влияние кратных волн (путем сравнения с обычным акустическим методом). 

• 2D Elastic – для изотропной упругой модели среды. Основной метод расчета. Позволяет 

моделировать в 2-D распространение сейсмической энергии в твердых средах с учетом эффектов 

обмена и поперечных волн. Может учитывать эффекты квазианизотропии, связанной с переслаиванием 

тонких пластов. 

• 2D Elastic Anisotropic – для анизотропной в 2-D упругой модели с учетом разницы в 

физических свойствах вдоль и поперек напластования, с тремя системами ориентированной в 2-D 

трещиноватости. Позволяет оценивать эффекты искажения распределения сейсмической энергии в 

связи с анизотропией среды. Параметры анизотропии и/или трещиноватости должны быть специально 

заданы пользователем. Там, где они не заданы, алгоритм эквивалентен изотропному эластическому 

методу. 

• 2D Visco-Elastic – для изотропной упругой модели с учетом добротности. Позволяет точнее 

оценивать эффекты искажения распределения сейсмической энергии в связи с поглощением. 
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Учитывает дисперсию скоростей. Параметры поглощения (добротность среды) должны быть 

специально заданы пользователем. Там, где они не заданы, алгоритм эквивалентен Elastic Modeling. 

Позволяет изучать влияние типа флюида. 

• 2D Eikonal Ray Tracing – метод лучевого трассирования для изотропной или анизотропной 

среды, предполагает высокочастотное (оптическое) приближение волновых процессов. Не формирует 

кратных волн, но может учитывать эффекты обмена при отражении. Метод не вполне корректен в 

тонкослоистой среде. Позволяет оценивать освещенность горизонтов с учетом отражения. (Остальные 

методы отображают вместо освещенности только энергию падающей волны.) 

• 2.5D Elastic/Elastic Anisotropic + Visco-Elastic* – для анизотропной в 3-D или 

изотропной упругой модели с произвольным образом ориентированными в 3-D системами 

трещиноватости. Предполагает, что профиль модели направлен вкрест неоднородностей породы, т.е. 

изменения свойств среды поперек плоскости модели (вдоль оси Y) пренебрежимо мало. Позволяет 

формировать не только 2-D/3-C, но и 3-D/3-C сейсмограммы, а с помощью направленного источника – 

даже 3-D/9-C (за три шага). Параметры анизотропии и трещиноватости должны быть заданы 

специально, причем азимуты отсчитываются от линии профиля модели. Кроме того есть 

дополнительная опция моделирования частотно зависимого поглощения. 

• 3D Vertical Incidence позволяет имитировать вертикальное падение волн на горизонтальные 

границы. Это позволяет быстро оценить время пробега и амплитуды отраженных волн на временном 

разрезе для случая распространения сейсмической энергии строго в одном измерении. Чтобы 

запустить этот способ моделирования, сначала создайте систему 3D наблюдения (см. 3D система 

наблюдений ), затем выполните запуск моделирования Run> Run 3D modeling 
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ЗАМЕЧАНИЕ: 2.5-3D-3C полноволновое (конечно-разностное) 

моделирование из-за его ресурсоемкости использует распараллеливание 

вычислений, включая . многоядерность, распараллеливание на узлах, 

графических картах, позволяя проводить расчеты за разумное время. 

 

o 3D-3C Acoustic, Elastic* позволяет моделировать распространение волн в условиях 

реалистично гетерогенной (во всех 3-х направлениях X, Y и Z) среде. Это моделирование 

можно применять к таким объектам, как рифы, соляные купола, интрузивные тела или круто 

падающие разломы и т.д. в местах, где требуется точное 3D распределение коллекторских 

свойств. 

 

Чтобы запустить этот способ моделирования, сначала создайте систему 3D наблюдения (см. 

3D система наблюдений ), затем выполните запуск моделирования Run> Run 3D 

modeling 

o 3D-3C elastic method for VTI/HTI mediums. Для этого способа должны быть 

указаны анизотропные параметры среды 
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Epsilon, Delta и Gamma. Либо должны быть загружены постоянные значения или 

сейсмические кубы для анизотропных параметров в окне 3D анизотропного моделирования 

3D Anisotropic Modeling. 

Также нужно указать угол Phi (то есть угол от вертикали) и азимут оси TTI. 

 

Для случая ромбической Orthorhombic (VTI/HTI),  как написано, оба угла Phi и Azimuth 

могут быть или 0 или 90 градусов. 
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Чтобы запустить этот способ моделирования, сначала создайте систему 3D наблюдения (см. 

3D система наблюдений), затем выполните запуск моделирования Run> Run 3D 

modeling 

• Haskel-Tomson - этот метод 2D/3D моделирования, поддерживающий произвольно 

ориентированную 3D TTI анизотропию. Это метод, в сущности, 3D- метод для 

горизонтально-слоистых сред, хотя и используется для 2D-моделей; Если этот метод (не 

вполне корректно) применяют к среде с искривленными границами, он неявно строит 

горизонтально-слоистую среду, исходя из скоростей строго под источником. Важнейшее 

достоинство этого метода – с его помощью возможно отдельно рассчитать поля разных 

типов волн (P, SV, SH); Этот метод не очень приспособлен к тонкослоистым моделям, 

т.к. время счета пропорционально числу границ. С помощью этого метода можно 

моделировать лишь точечные источники, при этом и источники, и приемники 

предполагаются расположенными на общей горизонтальной поверхности. Метод 

реализует спектральное разложение вдоль осей X, Y, а также время, в результате в 1D 

волновое поле распространяется вдоль оси Z. Метод, по существу, позволяет 

пользователю создавать частичные волновые поля, позволяя выбрать тип 

распространения (т.е. Down Wave) и прихода волн (т.е. Generate wave type), в то 

же время 
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позволяя преобразовывать полноволновой режим в напластованных слоях. 

 

Опции Slowness Coefficient by x и Slowness Coefficient by y (1200 в 

данном примере) - подразумевается, что диапазон медленности ограничена 1200/Vs, где Vs 

минимальная поперечная скорость волны в модели. Number – параметр, определяющий 

количество используемых гармоник (т. е. медленности). С этими двумя переменными можно 

смоделировать все возможные отражения и поверхностные волны при условии, что 

используется большая величина Number медлительности (т.е. 601). Меньшее значение 

медлительности приведет моделированию только отраженных волн и в то время к 

подавлению поверхностных волн (например, волн Рэлея). 

• 3D-3C visco elastic method используется для оценки влияния поглощения 

сейсмической энергии в 3D-среде с или без каких-либо вертикальной/горизонтальной 

трансверсальной анизотропии. Для этого метода файл Quality Cube file (т.е. куб 

добротности Q) должен быть загружен на вкладке 3D Modeling General 

Properties для процедуры моделирования 3D Elastic или 3D Elastic 

Anisotropic 
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Чтобы запустить этот способ моделирования, сначала создайте систему 3D наблюдения (см. 

3D система наблюдений ), затем выполните запуск моделирования Run> Run 3D modeling 

Кроме того, для учета дисперсии скорости (то есть частотной зависимости), должно быть 

указано количество механизмов релаксации Number of relaxation mechanisms в 

диалоге 3D Modeling Calculation Properties. Use Apparent Velocities 

связывает заданную скорость среды с заданной частотой. Следовательно, по мере 

уменьшения ширины полосы сигнала (из-за Qs и Qp), скорость также уменьшается. Это 

вполне согласуется с прикладной геофизикой. В то же время, опция Use Intrinsic  

Velocities связывают заданную скорость с нулевой частотой, и в результате скорость 

распространяющихся волн больше заданной скорости в модели. Этот метод 3D вязкоупругого 

моделирования в большинстве случаев используется для изучения влияния жидкости на 

полное трехмерное распространение волн. Подробнее см.: 

http://petrowiki.org/Acoustic_velocity_dispersion_and_attenuation 

http://petrowiki.org/Acoustic_velocity_dispersion_and_attenuation
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Следующее относится только к 2D-моделированию. 

 

Если тип источника (Source type) выбран как Shot points, синтетические 

сейсмограммы генерируются последовательно от каждого источника для группы связанных с 

ним приемников (как установлено в выбранной системе наблюдения). В результате 

моделирования получится объединенная синтетическая сейсмограмма, собранная из 

сейсмограмм от каждого пункта взрыва. Можно считать сейсмограммы не от всех источников 

модели, а от выбранной группы (параметры From # и To #) 

При выборе Source type: Reflector (Взрывающиеся рефлекторы) принимается, что 

видимая часть границы каждого полигона может быть источником волны, направленной 

вверх к поверхности модели. Необходимо установить максимальный угол границы (Max 

angle), больше которого эта граница не генерирует сигнал. 
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ЗАМЧАНИЕ: Можно отключить генерацию волны от всех границ любого 

полигона. Для этого в диалоге параметры полигона Polygon Properties, 

открывающимся из меню Model > Edit Polygon , нажмите кнопку 

Anisotropy & Other  Properties, выберите  Muted в группе 

Sources type: Reflector. 

В з р ы в а ю щ а я с я п о в е р х н о с т ь 

п о к а з ы ы а е т с я к а к м а л е н ь к и е 

и с т о ч н и к и в д о л ь в с е й п о в е р х н о с т и 

Р е ж и м в зр ы в а ю щ и х с я п о в е р х н о с т и 

 

При выборе Reflector меняется способ отображения системы наблюдения на фрейме 

Model. Источники не показываются, а части границ, генерирующие волну, показываются 

толстыми пунктирными линиями. 

 

При выборе Source type: Surface (Взрывающаяся поверхность) также не 

используются точечные источники, а взрывается вся поверхность земли одновременно. Это 

позволяет моделировать распространение плоской волны. В этом режиме также меняется 

способ отображения системы наблюдения на фрейме Model. 

 

У ч а с т к и г р а н и ц ы н е 

в ы з р ы в а ю т с я . У г о л > 30 
0
 

Р е ж и м в зр ы в а ю щ и х с я р е ф л е к т о р о в 
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В группе Shotgather Record устанавливаются продолжительность приема и шаг 

квантования трассы в ms (Start, Stop, Step) в выходных расчетных сейсмограммах. 

  

ЗАМЧАНИЕ: После расчета сейсмограммы в режиме взрывающейся 

поверхности или рефлекторов, если Вы хотите вернуть систему наблюдения с 

точечными источниками, выполните команду Model> Acquisition 

Geometry и выберите в диалоге Тип источников Shot Points. 
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5.2 Параметры сигнала (Wavelet) 

 

Выберите частоту сигнала источника (параметр Frequency). Этот параметр значительно 

влияет на качество и время расчета синтетических сейсмограмм. Грубо: чем выше частота, 

тем лучше качество и больше время расчета 

• Wavelet (тип сигнала) используется для выбора формы сигнала. Кроме нескольких 

стандартных типов Вы можете загрузить сигнал любого вида из текстовой таблицы. Для 

этого нажмите кнопку Load From File. 

• Source Mode (тип источника) используется для выбора направленности сигнала. 

• Surface Mode (тип поверхности) – при выборе Invisible (невидимая) свободная 

поверхность в сейсмическом волновом поле не проявляется. При выборе Free 

(свободный), свободная поверхность проявляется естественными волновыми 

эффектами. 

• Опция Use minimal-phase signal (использовать минимально-фазовый сигнал) – 

если отметить этот пункт, амплитудный спектр сигнала сохраниться, но его фазовый 

спектр будет изменен, чтобы получить минимально-фазовый сигнал. 

• Опция Suppress Source SV - подавление поперечных волн, возникающих при 

начале работы источника. Когда источник расположен вблизи «свободной» поверхности 

это позволяет избежать появления сильных поверхностных волн (для моделирования 

Elastic Anisotropic Modeling). 
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5.3 Дополнительные параметры (Additional) 

На этом этапе выбираются специальные параметры, связанные выбранным на первом этапе 

методом моделирования (параметр Modeling Procedure). Поэтому этот диалог имеет 

разный вид для разных методов. 

Для конечно-разносных методов решения волнового уравнения Vertical Incidence Modeling, 

Scalar Modeling, Acoustic Modeling, Elastic Modeling и Elastic Anisotropic Modeling диалог 

Additional имеет такие параметры: 

 

• Computation grid properties – параметры решетки конечно-разностного 

моделирования. Рекомендуется использовать параметры, выбранные по умолчанию 

(при нажатых кнопках auto) 

• Generate snapshot (снимки) – в процессе моделирования создается специальный 

файл …Snap.tgr, содержащий снимки волнового поля модели. Параметр Start – 

время начала генерации снимков. Step (шаг дискретности) – временной интервал 

между снимками (последовательность мгновенных изображений распространения 

волны по разрезу). 

• Generate by every … source – позволяет генерировать снимки не для всех 

источников подряд, а через один, два или реже. 
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ЗАМЕЧАНИЕ: Файл снимков волнового поля (Snapshots…Snap.tgr) для каждого 

источника занимает значительный объем в памяти компьютера. Кроме того, 

объединение снимков от каждого источника в один файл (последний этап расчета 

синтетических сейсмограмм) требует много времени: время объединения файлов 

снимков сравнимо со временем моделирования простых моделей. Поэтому 

рекомендуется отменять создание Snapshot-ов, если они Вам не нужны или хотя бы 

шаг генерации снимков (параметр Step) и «пропускать» часть источников (параметр 

Generate by every … source) 

 устанавливать большой  

• Опция Use Attenuation – учитывать ли при вычислениях параметр Quality, 

там, где он выбран для полигона (подробнее в разделе Анизотропия и другие 

параметры). 

• Margin (Граница) – расширение пространства сетки вычислений за пределы 

апертуры наблюдений (источник – линия приемников). 

• Threads per process – сколько ядер используется при моделировании, Max – 

использовать все ядра процессора. 

• Produce Time Field - при вычислениях волнового поля также создается файл с 

префиксом Time с полем времен падающей волны: First Arrivals (Первые 

вступления) – по первым вступления падающей волны, Maximum Energy 

(Максимум энергии) – по наиболее интенсивной падающей волне 

• Log interpolation properties – при построении модели по скважинным 

данным базы (подробности в разделе Полигоны по каротажным кривым 

(тонкослоистость)) параметры ограничивающие значения скоростей и плотности в 

полигонах, заполняющихся по данным каротажа. 
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5.3.1 Метод лучевого моделирования (Eikonal Ray Tracing) 

Добавляется параметр Max. Dip of reflector, ограничивающий угол наклона 

отражающих поверхностей. Snapshot (снимки) при моделировании методом Eikonal Ray 

Tracing не генерируются. 
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5.3.2 Метод 2.5D Elastic Anisotropic Modeling 

В первом General диалоге добавляется группа Receiver Lines for  Shotgathers 

для задания ширины и плотности полосы приемников относительно линии источников. 

 

Если система наблюдений 2D ВСП уже была построена, то пользователь может повторить ее 

для круговой системы ВСП путем выбора VSP radial allocation  scheme of 

sources. 
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На диалоге Additional добавляется группа Y Fourier Transform Spatial 

Frequency Range (K2). Она связана со спецификой реализации 2.5D моделирования, 

использующего спектральный метод разложения в направлении Y, где изменение параметров 

пород предполагается инвариантным. 
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Вариант А зашумлен из-за недостаточного диапазона частот (From, To). 

Вариант B содержит сигнал от фиктивные источников из-за недостаточного числа 

рассчитанных пространственных частот (Number of K2 values per shot). 

Вариант C – правильно. 

 

Параметры спектрального разложения рекомендуется подбирать автоматически нажатием 

кнопки Calculate (Вычислить) в нижней части той же группы. 

В любом случае метод 2.5D требует очень большого объема вычислений, как и 

A B C 

x x x 

y 

 = 0.2,  = −0.1, 

 = 0.03,  = 45 , 

 = 30 , VP = 2500 

y 

y 

y 

y 

y 

t t t 

Vp=4000 
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полный 3D. Он отличается возможностью более эффективного распараллеливания, особенно 

на графических сопроцессорах (NVIDIA CUDA). Для сокращения объема вычислений 

целесообразно использовать как можно меньшее время Stop в диалоге General. 
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Н а ж м и т е , ч т о б ы п р е р в а т ь р а с ч е т 

Л и с т и н г р а с ч т а 

С н и м о к в о л н о в о г о п о л я т е к у щ е г о в р е м е н и м о д е л и р о в а н и я С е й с м о г р а м м а 

П р о ц е н т р а с ч е т а в с е го з а д а н и я П р о ц е н т р а с ч е т а т е к у щ е й с е й с м о г р а м м ы 

5.4 Процесс расчета сейсмограмм 

После выбора метода моделирования и параметров расчета нажмите кнопку Готово. 

Должен появиться диалог моделирования Modeling in Progress, в котором 

пользователь может следить за процессом работы. 

 

Сверху окна моделирования выводится процент расчета по текущему источнику и общий 

процент расчета. Слева выводиться часть построенной сейсмограммы, а справа волновое 

поле текущего времени расчета. Внизу общий листинг расчета. 

Ели Вы хотите прервать расчет синтетических сейсмограмм, нажмите кнопку 

Terminate. 

Если при расчете произошла ошибка, сообщение будет выведено в листинг в нижнее окно 

диалога Modeling in Progress. Для того чтобы посмотреть листинг закончившихся 

расчетов вызовите команду Run/Show Progress Dialog. 

После успешного окончания моделирования диалог Modeling in Progress 

автоматически закроется и в окне Tesseral Pro появятся рассчитанные сейсмограммы. 
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Выходные файлы моделирования будут созданы в каталоге проекта. Например, для проекта 

ModelOne.tpa при выборе эластического изотропного моделирования (Elastic Modeling) 

выходные файлы: 

ModelOne+GathEP.sgy сейсмограмма 

ModelOne+GathEP.tgr трехкомпонентная сейсмограмма TGR: Vertical Particle Velocity, 
Horizontal Particle Velocity, Normal Stress 

ModelOne+SnapEP.tgr мгновенные снимки волнового поля 

ModelOne+TimeEP.tgr время распространения волны по модели от источника 

ModelOne+WaveEP-1.tgr форма сигнала 

Подробнее про отображение сейсмограмм в Tesseral Pro в разделе Фрейм Seismic. 

Отображение сейсмических файлов. 

  

С и н т е т и ч е с к а я 

с е й с м о г р а м м а 

М о д е ль  

М г н о в е н н ы е с н и м к и 

С о з д а н н ы е ф а й л ы . 

Щ е л к н и т е н а ф а й л , ч т о б ы 

п о к а з а т ь е г о в п р а в о м о к н е 
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5.5 Подготовка задания для кластера и моделирование в сети 

Для расчета синтетических сейсмограмм конечно-разносными методами, реализованными в 

Tesseral Pro, достаточно мощности современного персонального компьютера. Исключение 

2.5D Elastic Anisotropic Modeling. В зависимости от размера модели и выбранных параметров 

расчета моделирование может занять от нескольких часов до нескольких дней. Поэтому 

рекомендуется запускать расчет сейсмограмм методом 2.5D Elastic Anisotropic Modeling на 

кластере или в сети персональных компьютеров. 
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5.5.1 Моделирование на кластере 

В Tesseral Pro можно подготовить модель и задание для расчета синтетических сейсмограмм 

на кластере. Кластер может работать под управлением Windows или Linux (UNIX). 

Программа Tesseral Pro непосредственно не работает с кластером. Предполагается, что 

пользователь самостоятельно копирует задание и модель на кластер, самостоятельно 

запускает там задание, самостоятельно копирует результаты расчетов назад и загружает их в 

Tesseral Pro для визуализации. 

Для подготовки задания для кластера вызовите команду Run/CLUSTER: Create  task. 

Диалог подготовки задания полностью аналогичен диалогу запуска расчета в Tesseral Pro 

(Моделирование: расчет синтетических сейсмограмм). Например, для проекта ModelOne.tpa 

с тремя источниками должны появиться файлы: 

runtask.ini 

ModelOne1.tam 

ModelOne2.tam 

ModelOne3.tam 

Здесь ModelOne1.tam, ModelOne2.tam, … - специальные модели для каждого источника 

(этих файлов должно быть столько, сколько источников участвует в расчете), 

runtask.ini – главный файл с описанием задания на моделирование. 

Желательно перед выполнением этой команды создать пустую папку, куда и сохранить 

задание. В этом случае не придется разбираться, какие файлы к нему относятся, а какие – 

нет. Вычислительные программы для кластера можно скачать с сайта www.tesseral-geo.com, 

страница «Download» или «Скачать». Документация – в архиве каждой программы. 

  

http://www.tesseral-geo.com/
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Р а с п е д е л е н и е и т о ч н и к о в п о 

к о м п ь ю т е р а м в с е т и 

Д о с т у п н ы е 

к о м п ь ю т е р ы в с е т и 

П р о ц е н т в ы п о л е н и я н а к а ж д о м к о м п ь ю т е р е 

5.5.2 Моделирование в сети Windows 

Для расчета больших задач Tesseral Pro использует специальную утилиту TesseralFarm.exe. 

TesseralFarm является утилитой, дополняющей Tesseral Pro, и предназначенной для 

реализации кластеров в сетях Windows. По сравнению с аналогами, основанными на 

архитектуре Unix, кластеры, организованные с помощью TesseralFarm, требуют значительно 

меньше подготовительных усилий, имеют гибкую топологию и значительный потенциал к 

расширению. После соединения компьютеров в локальную сеть и настройки программы, 

можно разбивать вычислительные задачи на части, чтобы каждый компьютер моделировал 

сейсмограммы от своего набора источников. TesseralFarm позволяет управлять вычислениями 

на отдельных узлах и получать (собирать) общий результат. 

Подробности про инсталляцию и настройку TesseralFarm в отдельном документе. Запуск и 

распределение задания в сети Windows из Tesseral Pro, команда Run> NET: Run 

modeling. 

Получить все доступные компьютеры в сети Actions> Add All Available Servers. 

 

Распределение задания по узлам (компьютерам) сети показано в колонке Queue. При 

моделировании показаны диапазоны источников для каждого узла. Вы можете менять 

количество источников для узла, дважды щелкнув, мыши на компьютере в списке. 

Когда узлы выбраны, нажмите START. Программа начинает копировать файлы задания на 

узлы (это происходит либо практически мгновенно, либо занимает определенное время, 

зависящее от размеров файлов и скорости сети), затем на узлах запускаются вычисления. Вы 

можете наблюдать за ходом вычислений на отдельных узлах в колонке %  done. 

 

Если Вы хотите прервать вычисления на отдельном узле, щелкните правой кнопкой мыши 

этот узел и выберите Break calculation. 

Если Вы хотите прервать вычисления на всех узлах, нажмите STOP. 

После того, как вычисления на всех узлах завершатся, файлы результата вычислений будут 

помещены в папку, из которой Вы запускали вычисления. 
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М о д е л и р о в а н и е 

з а в е р ш е н о . Р е з у л ь т а т ы 

о б ъ е д е н ы 
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6 Лучевое трассирование 

ШАГ 1. Создаете новую или выбираете готовую модель (команда Model > Create 

Velocity Model (New Frame) или Edit > New Frame > Model).В модели 

обязательно должны быть источники и (Model > Acquisition Geometry). 

ШАГ 2. Выбираете полигон, для которого будете трассировать лучи. 

ШАГ 3. Выполняете команду Run > 2D Model: Ray Tracing 

 

Подробнее параметры лучевого трассирования рассмотрены в разделе «Параметры лучевого 

трассирования». 

Результат: 

Т и п о т р а ж е н и я в о л н ы 

В ы б р а н н ы й п о л и г о н 

У с т а н а в л и в а е т о с н о в н ы м п а р а м е т р а м 

з н а ч е н и я П о - у м о л ч а н и ю 

В ы б о р и с т о ч н и к о в 

д л я т р а с с и р о в а н и я 

Ш а г р е ш е т к и 

р а с ч е т а 

В ы б о р г р а н и ц ы о т р а ж е н и я 
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В Tesseral Pro можно накапливать расчеты лучей, повторяя вызов команды Run> 2D 

Model: Ray Tracing. Если расчет повторно вызывается с теми же параметрами и для той 
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ЗАМЕЧАНИЕ: Все расчеты лучей хранятся в документе (“―.tpa”-файл). 

Следите, чтобы расчеты лучей не слишком накапливались, засоряя документ. 

Удаляйте в диалоге Model> Raypath Visualization 

Properties.лишние расчеты. 

Удалить все лучи Удалить выбранные лучи 

Показывать трассировку луча 
(если отменен, то источники и 
приемник с точкой отражения 
прямой линией) 

Параметры 
текущего 
расчета 

Показывать лучи на 
модели 

Выбор расчета для 
отображения во фрейме Model 

же границы, то он автоматически заменяет существующий расчет. Во фрейме Model по 

умолчанию выводятся лучи последнего расчета. Лучи, отображаемые во фрейме Model 

(текущий расчет), можно поменять, выбрав из списка всех проведенных расчетов с помощью 

команды Model > Raypath Visualization Properties. Там же в диалоге можно 

посмотреть параметры текущего расчета, изменить настройки отображения лучей и удалить 

расчеты. 
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6.1 Режимы отображения лучей на фрейме Model 

• Show all rays – показываются все лучи текущего расчета. 

• Show Raypath for active source only – показываются все лучи от активного 

источника. Серым цветом показываются лучи от неактивных источников. 

 

• Show rays of region – показывает лучи текущего расчета, у которых пункт взрыва, 

пункт наблюдения или тучка отражения попали в выбранный регион. Для установки региона в 

диалоге Model > Raypath Visualization Properties выберите Show rays of 

region и отметьте Select region by mouse. Теперь мышкой в режиме нажал-потянул-

отпустил выберите на модели регион для отображения лучей. Режим выбора региона 

отменяется автоматически при отпускании левой кнопки мышки 
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6.2 Отображение лучевого трассирования на сейсмограмме 

Загрузите полевую, рассчитанную лучевым или конечно-разностным методом сейсмограмму 

во фрейме Seismic. Предполагается, что это сейсмограмма, соответствующая модели, по 

которой проводилось лучевое трассирование. Показать лучевое трассирование на 

сейсмограмме – команда Seismic> Highlight Traced Ray  Reflections 

 

Команда Seismic > Connect Ray Reflection Points меняет режим показа времен 

отражений на сейсмограмме (линии с подписями или точки). 

  



© Tesseral Technologies -Документация Пользователя- 151 

 

6.3 Параметры лучевого трассирования 

Задаются командой Run> 2D Model: Ray Tracing диалоге Ray Tracing: 

 

Основные параметры 

• Reflecting boundary (polygon) – выберите полигон и границу (top или bottom) 

отражения. 

• Grid Cell size – шаг решетки. Чем больше шаг, тем быстрее расчет и ниже точность луча. 

• Margin – максимальный угол отклонения луча. 

• Hade err, angle of допустимое отклонение угла отражения от угла падения 

(т.е. допустимое отклонение закона отражения). 
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Б е з T ra c e R e a l R a y p a th s T ra c e R e a l R a y p a th s 

 

 

• Trace real raypaths – расчет реального прохождения луча от источника к отражающей 

границе и назад к приемнику. 

 

• Separator (accounts the boundary overlapping) – если граница 

разделяется на участки накрывающими полигонами, то для каждого участка 

границы расчет проводится отдельно по всем приемникам и источникам, и пути 

лучей для каждого участка границы будут показаны разными цветами. 

Margin Margin 
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Две точки отражения для пары источник-приемник 

ЗАМЕЧАНИЕ: Параметры анизотропии устанавливаются в диалоге настройки 

параметров пластов модели, команда Model > Edit Polygon. В диалоге 

Polygon properties кнопка Anisotropy & Other Properties. 

 

• Loop – считается до трех отраженных лучей для каждой пары источник- приемник.  

 

• Группа Sources - Выберите источники, для которых будут трассироваться лучи. 

Параметр Every (receiver) определяет шаг по приемникам для каждого источника. 

• Группа Time: P-time file, S-time file – для трассирования лучей можно 

использовать уже готовые файлы насчитанных времен распространения волны. Это могут 

быть времена, рассчитанные любым методом конечно- разностного моделирования 

(команда Run > Run modeling) 

• Use Anisotropy – отметьте, если хотите трассировать лучи с учетом анизотропии. 

 

• Группа Model По умолчанию пункт Generate before ray tracing. этот пункт 

отменен, поскольку расчет модели может быть длительной операцией (если скорости 

полигонов модели рассчитываются по каротажным кривым). Если модель не менялась с 

предыдущего лучевого трассирования или моделирования, то в повторном расчете 

модели нет необходимости, и Вы можете не выбирать пункт Generate before ray 

tracing. 

• Кнопка Default. Нажмите для автоматической установки принятых параметров 

трассирования и имен файлов. 
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7 Система наблюдений 3D 

Для проведения трехмерного моделирования в Tesseral Pro вам необходимо создать 3D 

модель, состоящую из скоростной 3D модели в формате Seg-Y (см. Просмотр 3D  

сейсмических моделей или результатов миграции), отражающую поверхность в одном из 

стандартных форматов решеток (см. Загрузка поверхности из текстового файла), и 3D 

систему наблюдений (см. 3D система наблюдений). 
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7.1 Создание 3D системы наблюдений 

Трехмерная система наблюдения в Tesseral Pro может быть задана вручную, или ее можно 

загрузить из стандартного SPS-файла. Прежде всего, вам нужно создать фрейм Map (Карта) с 

топографическим фоном из картинки (см. Загрузка карты с использованием фонового 

рисунка). Если вы создаете 3D систему наблюдений вручную, вы должны использовать 

команду Map > Acquisition geometry, чтобы выбрать рисунок и основные параметры 

3D съемки (см. Выбор 3D системы наблюдений). Для коррекции своих параметров системы 

наблюдения и оформления ее в соответствии с реальной топографической картой, 

используйте команду Map/3D survey modes (см. Перемещение и вращение 3D системы 

наблюдений). 
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7.1.1 Загрузка карты с использованием фонового рисунка 

Команда: Map/Create Map (new frame)(Карта/Создать карту). 

 

В диалоге Create new Map нажмите Select background PICTURE или Load TXT 

or GRD-surface files (см. раздел Фрейм Карта). Выберите предпочитаемый файл с 

топографической картой. Tesseral Pro поддерживает следующие форматы изображений: 

BMP, JPEG, TIFF, GEO-TIFF, GEO-JPEG с координатами в TFW, JGW файлах. 
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Вам необходимо задать координаты для двух базовых точек в диалоге Background 

Picture (Фоновый рисунок), чтобы согласовать эту картинку с реальной топографической 

картой. Положение этих точек можно изменять с помощью мышки в нижней части диалога. 

Например, когда вы щелкаете мышкой и выбираете Point “2”, включаются для 

редактирования ячейки Horizontal и Vertical, и можно вводить координаты в поля 

ввода. То же самое справедливо и для первой точки Point “1”. 

Если система координат картинки отличается от системы координат проекта, ее можно 

указать с помощью диалога, который вызывается при нажатии на кнопку Convert COORD. 

 

Результат: 

Точка ―1‖ 

Точка ―2‖ 
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В Tesseral Pro фоновый рисунок для карты нельзя повернуть на 90°, однако его 

можно сделать зеркальным (перевернуть) по вертикальной/горизонтальной оси. 

Поэтому координаты базовых точек в диалоге Background Picture задаются не как 

значения X и Y, а как расстояния вдоль вертикальной и горизонтальной оси. 

ЗАМЕЧАНИЕ: Пожалуйста, помните, что направленность осей на карте может 

быть задана в диалоге со свойствами проекта File/Project Properties: 
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Чтобы задать добавить другие картинки и/или задать виртуальные координаты в 

«фоновом рисунке», в фрейме Map выберите команду Map/Edit Frame Properties. В 

диалоге Map Properties нажмите на кнопку Background Picture в группе 

Background: 

 

Появится диалог, в котором можно выбрать и настроить одну или несколько картинок: 
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Несколько картинок (обычно две или четыре) нужны на стыке карт или фотографий. 

 

Если вы хотите спрятать фоновые рисунки и не отображать их в поле карты Map, 

используйте Frame Map Properties и отмените Show Picture (показать рисунок). 

Для удаления фонового изображения нажмите Background Picture и Remove, или 

Remove All (удалить рисунок, или удалить все рисунки). 

 

Теперь вы можете использовать фрейм Map для задания системы наблюдений 3D. 
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7.1.2 Выбор 3D системы наблюдений 

Выберите в меню команду Map/Acquisition Geometry. 

 

 

Tesseral Pro поддерживает следующие варанты 3D системы налюдений. 

1) Ортогональная 

 

2) Взрывы, расположенные по типу коленчатого вала 

 

3) Диагональная 

 

4) Загруженная система из SPS-файла (см. Загрузка системы наблюдений из SPS- файла) 

5) Загруженная система из Seg-Y-файла (см. Загрузка системы наблюдений из SPS- файла). 
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6) VSP азимутальная 

 

7) VSP радиальная 

 

8) VSP ортогональная 

9) Морская 

 

в т.ч. «флип-флоп»: 



© Tesseral Technologies -Документация Пользователя- 163 

 

  

…и др. 

 

В закладке 3D Survey Layout можно указать величину приращения между линиями 

источников/приемников и станциями. 

 

 

 

В закладке Recording Patch можно указать количество приемников, связанных с каждым 

взрывом. В полях Inline receivers group и Crossline receivers group можно 

указать количество ближайших к источнику приемников, попадающих в эту группу. 

 

ЗАМЕЧАНИЕ: дополнительные параметры справа от первой колонки 

(инкрементов) зависят от расстановки. 
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В закладке Survey bearings вы можете указать размеры и направление 3D системы 

наблюдений. 

 

ЗАМЕЧАНИЕ: Вы можете создавать фрагменты записи любой формы с 

помощью параметров Remove Receivers from Shot и Add Receivers 

to Shot. С помощью этих параметров можно назначить приемники к 

фрагменту записи. В этом случае в диалоге Recording Patch в 

Acquisition Geometry, вы можете выбрать использование маски Use 

mask, и группы продольных и поперечных линий приемников Inline 

receivers group и Crossline receivers group будут 

игнорироваться, а недавно созданный фрагмент записи будет использоваться для 

всей системы. 
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ЗАМЕЧАНИЕ: Координаты начальных точек 3D системы наблюдений (X beg., 

Y beg.), длину продольных/поперечных линий INLINE/CROSSLINE Length 

и Azimuth (азимут) можно задавать «визуально» во фрейме Map, используя 

команду Map/Section Mode. Проведите линию профиля мышкой (нажал-

провел-отпустил) и откройте диалог настройки геометрии системы наблюдений 

Map/Acquisition  Geometry. Если вы создаете 3D систему наблюдений 

впервые, направление этой системы будет совпадать с той линией профиля, 

которую вы только что прочертили. Если вы хотите изменить размеры или 

направление уже созданной системы наблюдений, используя мышку, выберите 

команду Map/3D survey Modes/Moving with rotation. (См. ниже). 

Результат: 
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7.1.3 Морские исследования 

Для морских наблюдений конфигурация источников и приемников может быть задана с 

помощью команды Seismic system deployed from the vessel. 

 

 

Параметр Distance between shots позволяет задать расстояние между источниками 

(водяными пушками) для наблюдений типа «флип-флоп». Если используется она водяная 

пушка, введите в этот параметр 0. 

Опция Free Cable позволяет пользователю задать параметры записывающей установки 

для всех источников, расположенных вдоль продольной линии. Параметр Frequency of 

Moving (Частота перемещения) задает частоту смещения вдоль поперечной линии. 

Например, частота 2 означает, что записывающая установка будет смещена для каждого 

второго источника вдоль поперечной линии. Шаг перемещения Moving Step - это шаг 

смещения записывающей установки вдоль поперечной линии для каждого 
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последовательного источника в том же направлении. Таким образом, шаг перемещения 200 

означает, что записывающая установка будет смещена на 200 м для каждого источника (если 

частота перемещения Frequency of Moving =1) вдоль поперечной линии. Позиция 

начала Start Position указывает начальную точку записывающей установки (то есть 

положение его нижнего левого угла для нулевого азимута). Так, например, начальная 

позиция для Inline = 0 и Crossline = 0 означает, что начальная позиция записывающей 

установки будет находиться в самом нижнем левом углу 3D-съемки, как показано ниже. 
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Потянуть для изменения 

длины продольных линий 

If you click inside 3D survey area, 

you can move the whole survey 

layout up-down and left-right 

inside the Map frame. 

Используйте эту точку 

для вращения 

системы наблюдений 

(изменения азимута) 

Потянуть для изменения 

длины поперечных линий 

7.1.4 Перемещение и вращение 3D системы наблюдений 

Команда Map/3D survey Modes/Moving with rotation используется для коррекции 

положения 3D системы наблюдений на карте. Для этого используется левая кнопка мыши 

(нажал-потянул-отпустил). 

 

 

Другой режим перемещения системы наблюдений заключается в ее вертикальном 

перемещении с проектированием на дневную поверхность, указанный горизонт, или 

плоскость заданной глубины. Команда Map> Set Shot/Receiver Depths 

(Установить глубины источников/приемников) используется для реализации такой операции: 

 

Поддерживаются два метода вертикального перемещения: station projection 

(проекция) сохраняет горизонтальные координаты станций, а station chaining 

(укладывание цепочек) ограничивает кабельное расстояние между соседними станциями 

одной линии, и таким образом может сдвигать станции вдоль линий. 
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7.1.5 Редактирование станций источников и приемников 

Опция Map/3D survey Modes/Hide используется, чтобы скрыть ненужные источники 

и/или приемники в 3D системе наблюдений. 

Есть возможность выбирать источники и приемники для отключения с помощью режима 

Eraser (где сам eraser-резинка имеет форму круга заданного радиуса Radius). Нажмите 

левую кнопку мыши и, удерживая ее, перемещайте ее вокруг области, которую хотите 

скрыть. Скрытые источники/приемники не будут задействованы в следующей 3D системе 

наблюдений. Скрытые источники не будут показываться в поле Map (Карта) в большинстве 

режимов. Но в некоторых режимах они изображаются по умолчанию серыми и 

перечеркнутыми. Внешний вид пиктограмм станций настраивается в диалоге параметров 

поля. 

В режиме Select Group by Polygon полигон рисуется путем отщелкивания левой 

кнопкой мыши вокруг группы нужных источников и приемников. После завершения 

рисования полигона двойной щелчок левой клавиши мыши скрывает все источники и 

приемники внутри полигона. 

Аналогичные команды Select outside of… (выберите снаружи…) и Select inside 

of… (выберите внутри…) используют полигоны, образованные одним из имеющихся 

статических слоев. 
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Также можно выбирать источники и приемники, подлежащие скрытию, с помощью 

ограничений на значения X и/или Y: 
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Используйте Select All, чтобы скрыть все источники и/или приемники. 

 

Если вы хотите вернуть скрытые источники и/или приемники в систему наблюдений, 

используйте опцию Map/3D survey Modes/Show. Эта опция работает по тому же 

принципу: нажал-потянул-отпустил. 

Результат: 
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ЗАМЕЧАНИЕ: Если вы хотите использовать опцию Hide/Show 

(Скрыть/Показать) отдельно для источников, и отдельно для приемников 

(например, чтобы скрыть группу источников, но приемники оставить на месте), 

вам нужно отметить Map/Show  Shots (Карта/Показать источники) или 

Map/Show Receivers (Карта/Показать приемники) соответственно. В 

результате источники (или приемники) не будут показаны во фрейме Map 

(Карта), а редактирование будет возможным только для отображаемых 

элементов (источников или приемников). 

 

 

Для удобства редактирования можно использовать масштабирование изображения 

(команда View/Zoom). 

Скрытая часть системы 

наблюдений (не используется 

при моделировании) 
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По умолчанию пиктограммы источников и приемников (совместно именуемых 

«станции») масштабируются при увеличении (зуме) точно, как другие графические элементы. 

Однако иногда для лучшего разрешения рекомендуется полностью отменить 

масштабирование пиктограмм станций, или сделать скорость его масштабирования 

значительно меньше. Это делается в диалоге параметров поля Карта: 
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Здесь же можно настроить сами пиктограммы станций с помощью диалога, который 

вызывается по кнопкам Source и Receiver: 
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Кнопка Save as default запоминает настройки скважин для следующих проектов. 

 

Ниже приведен пример альтернативного оформления станций после настройки в указанных 

диалогах. 
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7.1.6 Изменение направления линий источников и приемников 

Используя команду Map/3D survey Modes/Moving Shot и Receiver lines, вы 

можете изменять форму линии источников и приемников, для приведения их в соответствие 

с реальной топографией. Чтобы это делать реализовано 4 типа режимов перемещения 

Selection Type. Сдвиг по кабелю Cable используется, если Вы хотите перемещать 

источники, или приемники, сохраняя расстояния между ними (например, изменить азимут 

одной линии возбуждения, или приема). Сдвиг точки Point предназначен для перемещения 

отдельных станций (по одной). Линия Line позволяет передвинуть всю линию в другое 

место, сохраняя взаимное расположение составляющих ее станций. И, наконец, полигон 

Polygon позволяет ограничить группу станций многоугольным контуром и передвинуть 

всю эту группу в другое место, сохраняя взаимное расположение станций внутри группы. 

 

Следующий пример иллюстрирует перемещение источников в режиме Cable, затем идет 

пример применения режимов Point и Line. 

В этих примерах для наглядности фоновый рисунок скрыт (в диалоге Frame Map 

Properties отключена опция отображения рисунка Show Picture), приемники также 

скрыты (выключена опция Map/Show Receivers). 
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После первого создания 3D системы наблюдений, каждая линия источников/приемников 

имеет две «якорные точки», которые связывают линию с ее положением на плане. Таким 

образом, вы можете: 

1) Изменять положение «якорной точки», используя левую кнопку мышки (нажал-потянул-

отпустил); 

2) Удалять «якорную точку» двойным щелчком левой кнопки мышки; 

3) Добавлять новую «якорную точку – нажать левую кнопку мышки на любом источнике. 

Те же операции применимы и для линии приемников: 
 

Линии источников и приемников можно перемещать вместе или независимо друг от друга: 

  

Перемещение линии 

источников 
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В режиме Polygon используйте щелчок левой клавиши мыши, чтобы отбивать вершины 

многоугольной области вокруг группы источников, или приемников, которые нужно 

переместить. Щелчок правой кнопки мыши прерывает процесс рисования многоугольной 

границы, а двойной щелчок мыши завершает и сохраняет нарисованную границу. После 

двойного щелчка нажмите правую клавишу мыши и, не отпуская двигайте мышь. Программа 

отобразит перемещаемую группу в виде описанного прямоугольника. Передвиньте ее куда 

нужно и отпустите клавишу мыши. Группа переместится в это место. 

 

Координаты и номера станций 

 

Используйте команду контекстного меню Shot/Receiver Coordinates в режиме 

Survey Line, чтобы показать и изменить координаты источника, или приемника, 

выбранного щелчком левой клавиши мыши: 
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Этот диалог не пропадает, если Вы переходите в другой режим редактирования карты, 

например, в режим увеличения Zoom mode, чтобы показать расстановку крупнее 

(приблизить). Однако, он перестает при этом реагировать на щелчки мышью, пока Вы 

не вернетесь в режим правки линий расстановки Survey Line mode с помощью меню 

Map> 3D Survey Edit Modes> Moving Shot and Receiver Lines, или 

соответствующей кнопки в панели инструментов. 

 

Этот диалог – не модальный, и Вам не нужно его закрывать, чтобы увидеть координаты 

другой станции. Просто щелкните левой клавишей мыши на ней. Координаты станции 

можно изменить в цифрах и запомнить с помощью кнопки Set. Такое изменение приведет к 

тому, что выбранный источник, или приемник переместится в указанную точку. 

Position и Line (позиция и линия) – это формальные последовательные номера, не 

зависящие от расположения станции и номеров инлайн/кросслайн в SPS. Номер позиции – 

это последовательный номер при сквозной нумерации источников, или приемников (т.е. без 

учета линии). На него не влияет не только перемещение, но и удаление (точнее – 

отключение) части станций. Все то же самое верно и для номеров линий: они 

последовательные и не меняются, если отключить какие-то линии. Ну а идентификацию 

станции (номера инлайн/кросслайн) в SPS отображают параметры Inline ID и XLine ID. 

Значения -1 этих параметров, которые Вы видите на предыдущем рисунке, означают просто 

«не определено». Они определены с самого начала только для расстановок, загруженных из 

файлов SPS, или SEGY. Иначе они задаются только в момент экспорта расстановки в SPS. 
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7.1.7 Создание 3D группировки записи 

Прежде всего, вам нужно указать параметры группировки записи для каждого источника в 

диалоге Map/Acquisition Geometry в закладке Recording Patch. В группах 

Inline receivers group и Crossline receivers group задаются параметры, 

указывающие количество ближайших приемников, которые будут задействованы с текущим 

источником. 

Вы можете изменить форму фрагмента записи, используя маску, и применить его для всей 

системы наблюдений. Во-первых, нужно выбрать источник в середине системы наблюдений. 

В меню Map/3D survey Modes/View Relation щелкните мышкой по выбранному 

источнику. Выбранный источник будет выделен красной точкой, остальные источники будут 

показаны в виде серых точек. Приемники, задействованные с выбранным источником, будут 

показаны синими, а остальные приемники будут серыми: 

 

Добавлять и удалять приемники вокруг источника можно, используя команды Map/3D 

survey Modes/Remove Receivers from Shot и Map/3D survey Modes/Add  

Receivers to Shot. Эти две команды выполняются подобно (нажал-потянул-отпустил) 

команде Hide/Show (Скрыть/показать). 

Пример: 
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Теперь вы можете выбрать любой источник в Map/3D survey Modes/View Relation и 

группа приемников, связанная с этим источником, будет иметь одинаковую форму. В то же 

время в диалоге Acquisition Geometry в закладке Recording Patch опция ― ”Use 

mask” (Использование маски) будет автоматически включена: 

 

Иными словами, группа приемников задается маской, созданной вручную, а не параметрами 

группы Inline (Crossline) receivers group.  
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7.1.8 Загрузка системы наблюдений из SPS-файла 

Вот еще один полезный способ для создания 3D-системы наблюдений, используя 

стандартный SPS-формат. В том же самом диалоге Map/Acquisition Geometry. 

 

Выберите From SPS-file (загрузку наблюдений из SPS-файла) и нажмите кнопку 

Select SPS-files (выбрать файлы). 

 

В следующем диалоге загрузите SPS-файлы для источников, приемников и их взаимосвязи.  



© Tesseral Technologies -Документация Пользователя- 184 

 

 

 

Отметьте Sea observations, если этот SPS описывает схему морских наблюдений. 

Нажмите Next>, и появится следующий диалог, с изображением на карте схемы 3D- 

наблюдений, загруженной из выбранных SPS-файлов. 
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В данном диалоге вам необходимо задать координаты Начальной (Origin) точки, а также 

Продольную длину (INLINE) и Азимут в этом диалоге. С помощью этой линии легко 

перемещать и вращать систему 3D наблюдений, загруженную из SPS файлов. Рекомендуется 

использовать мышь, чтобы нарисовать линию на карте (нажал-потянул-отпустил). Вам не 

нужно быть точным с отрисовкой линии. 

Вы можете увеличить эту картинку, нажав кнопку Zoom map (Увеличить карту), чтобы 

работать в большем масштабе 

Тут же можно преобразовать координаты, если в загруженном SPS система координат 

отличается от системы координат проекта. Для этого нажмите кнопку COORD Convert 

(Преобразовать координаты): 

Конец линии 

профиля 
Начало линии 

профиля 
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Появится диалог аналогичный тому, который используется в File / Project 

Properties (Файл/Параметры проекта) для задания системы координат всего проекта. 

Как только вы закончите загружать SPS-файлы, появится диалог Acquisition Geometry. 

Закладки 3D survey Layout и Recording Patch не будут использоваться, если вы 

переходите к варианту загрузки SPS-файлов Load survey from SPS-files. В закладке 

Survey bearings параметры размеров будут проигнорированы, но географические 

параметры системы 3D наблюдений необходимы:  

 

Результат: 
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Вы можете редактировать системы наблюдений, загруженные из SPS-файлов, с помощью 

команд Moving with rotation, Hide, Show: 

 

  

Пример скрытых источников, 

загруженных из SPS-файлов 
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7.1.9 Загрузка системы наблюдений из SGY-файла 

Также есть способ загрузки 3D-системы наблюдений из синтетических сейсмограмм SGY-

формат. В том же самом диалоге Map/Acquisition Geometry. 

 

нужно выбрать Load survey from SGY-files         и нажать кнопку Select SGY- 

files>. 
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7.1.10 Экспортирование 3D системы наблюдений в SPS-файл 

3D систему наблюдений, созданную во фрейме Map, можно экспортировать в стандартный 

SPS формат. Для этого используется команда меню Map/Export to SPS. Задайте имя 

файла, после чего файлы источников и соответствующие им данные будут созданы 

автоматически. В результате получится три SPS файла: 

• S01 – источник; R01 – приемники; 

• X01 – файл их взаимосвязи. 

 

Кроме того, тут можно назначить нумерацию линий и станций (если она отличается от 

автоматической n=1, 2, 3, 4, 5…), чтобы эти значения записывались в SPS-файл при 

экспорте. Чтобы сделать это, выберите Apply next numbering для источников и/или 

приемников. Затем задайте нумерацию линий Line Numbers и нумерацию станций 

Station Numbers отдельно для источников и приемников. Задайте значения, 

соответствующие друг-другу, так что если источник и приемник попадают в одну точку, то 

номер линии этого источника совпадает с номером этого приемника в линии и наоборот, 

номер этого источника в линии соответствует номеру линии этого приемника. 
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7.1.11 Экспортирование 3D системы наблюдений в KML-файл 

3D систему наблюдений, созданную во фрейме Map, можно экспортировать в формат KML, 

используемый для отображения объектов на картах Google Maps. Для этого, используйте 

команду меню Map/Export 3D Survey to KML. 

 

Задайте имя экспортируемого KML-файла, выберите координатную систему GPS в 

Ellipsoid, а также номер зоны. В результате будут сгенерированы 2 KML-файла: 

Sources.kmz и Receivers.kmz; 
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7.1.12 Управление статическими слоями 

В поле карты также можно грузить статические слои, например, границы участков 

(исключительно для изображения). Их можно импортировать из текстовых файлов очень 

простого формата: координаты X и Y, затем – номер полигона (как на следующей картинке). 

Также поддерживается загрузка из шейпфайлов и файлов DXF (формат Autocad). 

 

Чтобы загрузить статический слой используйте меню Map> Manage Static  Layers и 

в диалоге – кнопку From File. Программа покажет следующий диалог, позволяющий 

указать систему координат загружаемых данных, если она отличается от системы координат 

проекта. (Для этого отметьте Coordinate conversion To system и введите 

параметры системы координат загружаемого файла): 

 

После загрузки статического слоя используйте кнопку View, чтобы настроить стиль его 

линий. 
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Вы можете также переименовать статический слой в проекте (используя Name), добавить 

другой статический слой (From File...) или удалить любой из них (выделить в списке и 

нажать Delete). 

Кнопка Info позволяет посмотреть, какую область покрывает статический слой: 



© Tesseral Technologies -Документация Пользователя- 193 

 

 

Если перед тем, как нажать OK, отметить Set to Work Area, после выхода из диалога 

настройки статических слоев, область карты будет изменена на указанный в этом диалоге 

прямоугольник. 

 

Когда закончили, нажмите Close и щелкните мышью в это поле. Изменения в статических 

слоях отобразятся на карте. 

  



© Tesseral Technologies -Документация Пользователя- 194 

 

7.2 Параметры систем координат 

Пожалуйста, обратите внимание, что во фрейме Map есть возможность выбора из нескольких 

систем координат, базирующихся на следующих эллипсоидах: WGS-84 (GPS), NAD-83 (GRS), 

NAD-27 (Clarke 1866), ETRS-89, SK-42 (Krasovsky), PZ-90 (GLONASS), GSK- 2011. 

Для того, чтобы выбрать систему координат, в который будет отображаться карта, 

необходимо в Map> Map Frame Properties> Project properties… установить 

ненулевые координаты в графах Easting и Northing of Point для выбранного 

эллипсоида. А также установить значение проекции центрального меридиана эллипсоида (в 

градусах) Central Meridian of the Projection (degrees), который обычно 

устанавливается равным нулю. 
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7.3 Планирование наблюдений 
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7.3.1 Меню планирования 

Меню планирования имеет две локации: 

1) Вкладка меню Map => Fold Map 

 

 

2) В панели быстрого доступа 

 

 

Функционал планирования состоит из следующих пунктов: 

 

– Расчет, вызывает диалог Fold Calculation Properties 
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– Отображение сетки бинов Show Bins Grid 

 
– Отображение карты перекрытия Show Fold Map 

 

 

 

– Отображение гистограмм распределение расстояний 

источник/приемник Show Offset Distribution Map 

– Отображение розы азимутального распределения источник/приемник 
Show Azimuth Distribution Map 

– Установить режим отображении карты Fold Display Options 

– Показать сведенную статистику по карте перекрытия и бинам Show  
Bins Grid Statistics 

– Показать сведенную статистику по выбранному бину Show Selected 
Bin Information 

– Показать графическую статистику по карте перекрытия Show Plot  

Statistics 
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7.3.2 Диалог Расчета Перекрытий (Fold Calculation Properties) 

 

Диалог разбит на 4 части: 

Первая – Bin Size, здесь можно настроить размер сетки для расчета. Есть три 

способа: первый – установить высоту (Crossline Bin Size) и ширину (Inline Bin 

Size) бина, второй – установить количество бинов по Х (Inline Bin Count) и Y 

(Crossline Bin Count), в зоне планирования, третий – кнопка автоматического расчета 

(Auto Fit). При этом, высота равна половине расстояния между приемниками, а ширина 

половине расстояния между источниками, расстояние равно моде выборки из всех 

расстояний между источниками и приемниками. 

Вторая – Extent, здесь можно установить область проведения расчета, то есть определить 

какие средние точки между источником и приемникам не будут входить в расчет. Данную 

настройку можно выполнить тремя способами: заполнить соответствующие поля, нажать 

кнопку (All) – выбрать все поле, нажать кнопку (Mouse Selection) – выбрать область 

вручную, при этом диалог временно закрывается и можно и мышью определить границы. 

На изображение ниже, показано выделение границ расчета с помощью мыши Mouse 

Selection: 
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В соответствующих полях отображаются координаты выделенного квадрата 
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Ниже показана карта перекрытий Fold Map, рассчитанная в границах области выделения. 

  

Третья часть диалога Recording Patch. Содержит пункты выбора типа группировки 

приемников при записи одного источника (template). Реализовано три способа. Первый 

(Relations from SPS-File)– группа формируется из схемы, будь то SPS файл или 

схема, установленная при настройке расстановки источников/приемников. 

 

Второй способ (By Group) - установить количество приемников в линии (Stations 

Count) и количество линий (Line Count). Результат схемы 30/10 на изображении ниже 
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Третий способ (By Distance) – устанавливается радиус (Circle Radius) поиска 

приемников вокруг действующего источника. 

Результат такой схемы записи показан на изображении ниже: 
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Четвертая часть диалога Limits – фильтры длины (Offset) и азимута (Azimuth) линии 

между источником и приемником. Если флажок (Make Offset/Azimuth Limits 

Exclusive) не активен тогда в расчете принимают участие те пары источник/приемник, для 

которых выполняется неравенство: From <= Offset/Azimuth <= To 

Если активен тогда: From > Offset/Azimuth > To будет  включен. 
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7.3.3 Отображение карты перекрытий (Fold Display Options) 

 

Fold Display Options – диалог для установки режима отображение 

статистических параметров расчета (Fold, Offset и Azimuth). 

Для Fold Map (Перекрытие) есть такие типы отображения: Color and Value – Заливка 

бинов цветом, соответствующего шкале перекрытия, а также отображение их значения. 
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Only Color – Только заливка бинов цветом 

 

Only Value – Отображение только значений перекрытий. 
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Для Offset Map (Удаление) следующие варианты отображения: 

No Color – Черно-белая шкала. Высота линий пропорциональна офсету (самый большой 

офсет занимает всю высоту квадратика, а для ближнего приемника высота близка к нулю). 

Расположение линий по горизонтали вычисляется по максимальному офсету 

(пропорционально ширине квадрата), а все меньшие офсеты располагаются по 

вычисленному градиенту. 

 

Color – Отображение шкала ”Redundancy”- избыточность, т.е. количество одинаковых 

выносов, попадающих в один и тот же бин. Однократный офсет имеет цвет, 

соответствующий 0 по шкале избыточности. Если несколько офсетов совпадают, то им 

приписывается цвет по оси избыточности. 
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Min Offset – Заливка бинов цветом, соответствующего шкале меньшего удаления в 

бине. Max Offset – Заливка бинов цветом, соответствующего шкале большего удаления 

в бине. Mean Offset – Заливка бинов цветом, соответствующего шкале среднего 

значения удаления в бине. 

 

Median Offset – Заливка бинов цветом, соответствующего шкале медианы удалений в 

бине. 

Offset Range – Заливка бинов цветом, соответствующего шкале разницы большего с 

меньшим удалений в бине. 

Largest Gap – Заливка бинов цветом, соответствующего шкале наибольшей разницы 

между последовательными удалениями, в бине, (удаления сортированы от меньшего к 

большему). 

Offset Variability – Заливка бинов цветом, соответствующего шкале распределения 

удалений в бине (Коэффициент изменчивости), определяющейся по формуле: 

Offset Variability = (S / Средняя величина X (в бине))*100 

 

где: 

S = Стандартное отклонение промежутков между удалениями средних точек в бине, n = 

Количество промежутков (при кратности 15 количество промежутков равно 14), Xi = 

Промежуток между удалениями (Разность между последовательными удалениями в одном 

бине)
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Для Azimuth Map (Направление) следующие варианты отображения: 

 

No Color – Черно-белая шкала. Показаны «паучки», т.е. распределение азимутов 

направлений источник-приемник, который попадают в данный бин. Длина лучей паучка 

зависит от удаления (Offset). 

 

 

Color – Отображает «Избыточность», т. е. количество раз, когда каждый азимут попадает в 

один и тот же бин. Один азимут имеет цвет, соответствующий избыточности, равной нулю. 

Для более чем 1 азимута цвет назначается «конечности паука» в соответствии с цветовой 

шкалой избыточности. 
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Circle Plot – Концентрические окружности соответствуют диапазонам удалений, и с 

увеличением радиуса увеличивается расстояние источник-приемник (удаление). Изменить 

шаг отображения окружностей можно в раздели - Line Increment в поле - Offset. 

 

 

 

Offset to Azimuth – Средние точки в каждом бине изображаются в координатах 

удаление-азимут. Удаления откладываются по оси X (увеличение X соответствует 

продольному направлению сетки бинов), а азимуты откладываются по оси Y, от 0 до 360 

(увеличение Y соответствует поперечному направлению сетки бинов). Чтобы изменить 

интервалы по удалениям и азимутам используются опции Azimuth и Offset в разделе - 

Line Increments. Каждая средняя точка обозначается звездочкой на соответствующем 
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удалении и азимуте. 

 

Trace Azimuth – Заливка бинов цветом, соответствующего шкале отображается азимут 

первой трассы, удовлетворяющей критериям ограничения в раздели - Line Increment в 

поле - Offset. 
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7.3.4 Статистическая информация по площади и бинам (Bins Grid Statistics) 

Bins Grid Statistics – содержит статистическую информацию по 

источника/приемникам, площади и бинам. Есть возможность подсчитать полезную площадь: 

1) Указать значения предела полезного перекрытия (Min Fold и Max Fold), в поле (Min-Max 

Areal) отображается суммарная площадь всех бинов, значение перекрытия в которых попадают в 

промежуток min-max. Кнопка Reset забрасывает значения Min Fold и Max Fold до 

рассчитанных. 

 

2) Отбить контуры полигона мышью, нажав на кнопку Mouse Selection, диалог статистики 

сворачивается, левой кнопкой мыши отбиваем полигон, при нажатии на правую кнопку полигон 

замыкается, диалог статистики раскрывается, в поле Area раздела Mouse Selection 

Polygon отображается площадь выделенного полигона. 
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Результат: 
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7.3.5 Статистическая информация по выбранному бину (Selected Bin 
Information) 

После того как активировав опцию Selected Bin Information, нажатие на любой 

бин приводит к появлению диалога со статистической информацией данного бина. Сам бин 

подсвечивается в инверсионном цвете. Находясь в данном режиме, можно переключатся 

между бинами тем же путем – результатом будет отображения в диалоге информации вновь 

выбранного бина. 

 

 

Диалог состоит из трех частей: первой (Bin) – порядковый номер бина относительно начала 

координат и его координаты; вторая (Attributes) – статистические данные бина; и третья 

часть – графическая статистика по удалению и направлению, соответствующая отображению 

No Color для Offset и Azimuth. 

Также в диалоге находится кнопка Show Spider - чтобы отобразить все пары источник-

приемник, формирующие средние точки в данном бине (большой паук). Для отключения 

отображения большого паука необходимо нажать на ту же кнопку, которая теперь называется 

Hide Spider. 



© Tesseral Technologies -Документация Пользователя- 
213 

 

 

Для выхода из данного режима нужно деактивировав опцию Selected Bin 

Information. 
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7.3.6 Статистика рассчитанной карты Plot Statistics 

Plot Statistics – диалог, в котором отображается статистика рассчитанной карты (Fold 

Map) в виде следующих графиков зависимости и диаграммы: 

 

  - График распределение бинов (Number of Bins) в зависимости от кратности 

(Fold) 

 

  - График распределение сейсмотрасс (Number of Traces) в зависимости от удаления 

(Offset ) 

 

  - График распределение сейсмотрасс (Number of Traces) в зависимости от азимута 

(Azimuth) 

 

 

По оси Х отложено в зависимости от типа графика перекрытие (Fold), удаление 

(Offset), азимут (Azimuth), а по оси У – количество бинов (Number of Bins) или количество 

сейсмотрасс (Number of Traces). 

 

- Радиальная диаграмма распределение сейсмотрасс в зависимости от азимута 

(Azimuth) и удаления (Offset). 
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В данной радиальной диаграмме - каждая окружность соответствует определенному 

удалению в зависимости от шага. Шкала удалений отмечена на осях X и Y. Радиальные 

линии показывают шаг по азимуту, каждая ячейка в круговой диаграмме окрашена в 

соответствии с количеством сейсмотрасс, имеющих данное удаление и азимут. 

 

- Диаграмма распределение сейсмотрасс в (Number of Bins) в зависимости 
от азимута (Azimuth) и удаления (Offset). 

 

 

В данной диаграмме по оси X отложено удаление (Offset) а по оси Y – избыточность 

(Redundancy) каждая ячейка окрашена в соответствии количеству бинов имеющие n 

количество одинаковых по удалению средних точек. 
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- Display Options - - опции отображения графиков и диаграмм 

 

Данная кнопка вызывает диалог опциональных настрое отображения, где можно установить 

шаг (Increments) для перекрытия (Fold), удаления (Offset), азимута (Azimuth), а 

также изменить отображения линейных графиков (As Line Graph) на гистограммы (As 

Bar Graph). 
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7.4 Манипуляции со схемой наблюдений 
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7.4.1 Изменение направления осей системы наблюдений (Inline/Crossline) 

В том случаи, если при загрузке схемы наблюдений из SPS-file, по каким-либо причинам 

программа неправильно определила систему координат Inline/Crossline, к примеру, как на 

рисунке ниже, есть возможность изменить расположение осей, для этого необходимо 

активировать режим  - (Shots/ Receivers: Moving with rotation) зажать 

кнопку ctrl и провести манипуляцию (переместить, повернуть, изменить длину одной из 

осей). 

Before After 

 

Данная функция работает только в случае, когда схемы наблюдений загружена из SPS- file, 

для схем, построенных другим способом, функция отключена. 
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7.4.2 Изменение расположения точек возбуждения и приема 

Для того, чтобы переместить линию возбуждения, или приема (Shot/Receiver) на точные 

координаты необходимо активировать режим  - (Moving Shot and Receiver 

Lines), после чего навести на Shot/Receiver, нажать левую кнопку мыши. 

 

После чего появится контекстное меню, где нужно выбрать пункт Shot/Receiver 

Coordinates. Появится диалог с текущими координатами Shot/Receiver Map – 

координаты карты, а SPS – расположение в схеме наблюдений Inline/Crossline, Z – текущая 

глубина Shot/Receiver. 

 

Если необходимо получить координаты другого Shot/Receiver можно повторить процедуру 

не закрывая диалог. Изменив одну из координат необходимо нажать Set после чего 

Shot/Receiver поменяет свое расположение или глубину. После получения 

необходимого результата необходимо закрыть диалог. 
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7.4.3 Изменение глубины точек возбуждения и приема 

Нажатие кнопки  - (Set Shots/Receivers Depth) откроет диалог с помощью 

которого можно установить глубину для всех источников, или приемников. 

Предусмотрено два способа получение значение глубины: первый – установить глубину 

вручную, второй – относительно поверхности, выбранной из списка загруженных в проект. 

 

После выбора способа получение глубины необходимо установить, чему будет присвоена 

глубина Shots или Receivers или обоим, для этого активировать соответствующие флаги. 

После выбора настроек жмем ОК. 
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7.4.4 Размещение точек возбуждения, или приема в скважине 

 

Для изменения исходного размещения точек приема в скважине, или для того, чтобы 

поместить в скважине точки возбуждения, нужно перейти в режим Map/3D Survey Edit 

Modes/Moving Shot and Receiver Lines, затем в появившемся диалоге выбрать 

скважину (из числа скважин активных месторождений базы данных с загруженной 

инклинометрией): 

 

Для выполнения действия необходимо в списке Point выбрать один тип точек: Receiver 

для приемников, или Source для источников. Затем в поле Action нужно выбрать 

действие Add – добавить, или Remove – убрать. 
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Далее в поле тип Type укажите, как именно добавлять. 

 

 

Типы добавления (Add): 

1) Interval (в интервале) – требуется заполнить поля From – начальная глубина вдоль ствола 

скважины, To – последняя глубина, и Step – шаг размещения приемников, или источников: 
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Результат: 

2) Above (выше указанной глубины и вплоть до устья скважины) – требуется заполнить поля To – 

последняя глубина вдоль ствола скважины, и Step – шаг размещения приемников, или 

источников: 

 

Результат: 

 

3) Below (ниже указанной глубины и вплоть до забоя скважины) – требуется заполнить поля From – 

начальная глубина вдоль ствола скважины и Step – шаг размещения приемников, или источников: 
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Результат: 

4) Depth (на указанной глубине вдоль ствола) – требуется заполнить поле Z: 

 

Результат: 

 

Типы удаления: 

1) Interval (удалить в интервале) – требуется заполнить поля From – начальная глубина вдоль 

ствола скважны и To – последняя глубина: 

 

Результат: 

 

2) Above (удалить выше указанной глубины вплоть до устья скважины) – требуется заполнить 

поле To – последняя глубина вдоль ствола скважны: 
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Результат: 

3) Below (удалить ниже указанной глубины вплоть до забоя скважины) – требуется заполнить 

поле From: 

 

Результат: 

 

4) All (удалить все точки источников или приемников в расстановке) . 

Используя перечисленные операции, можно формировать составные расстановки, не 

входящие в основной набор такие, как ВСП с неравномерным шагом приемников, 

межскважинное зондирование, «инверсное» ВСП с источником в скважине, комбинация 

поверхностных наблюдений с ВСП и др. 
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8 Лучевое моделирование 3D 

В этом разделе вы можете найти, как создать задание и запустить 3D трассирование лучей. 

Для выполнения 3D лучевого трассирования в Tesseral Pro необходимо иметь скоростную 

3D-модель в формате SEG-Y (см. Просмотр 3D сейсмических моделей или результатов 

миграции), отражающую поверхность в одном из стандартных форматов (см. Загрузка 

поверхности из текстового файла) и 3D система наблюдений (см. 3D система наблюдений) 

Некоторые особенности просмотра результатов моделирования представлены в главе Фрейм 

3D View. 
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8.1 3D Лучевое Моделирование (3D Ray Tracing Modeling) 

Для моделирования 3D-трассировки лучей в Tesseral Pro необходимо создать 3D модель, 

состоящую из 3D скоростной модели в формате Seg-Y (см. 13.4), отражающей поверхности в 

одном из стандартных форматов сетки (см. 14.1) и создать 3D-макет съемки (см. 7). 
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8.1.1 Просмотр 3D скоростной модели 

Для просмотра 3D скоростной модели в виде SEG-Y файла, пользователь может загрузить ее 

во фрейм Seismic и затем отобразить ее во фрейме 3D View. 

Для загрузки 3D SEG-Y файла, воспользуйтесь командой меню File> Load  Seismic 

File, или Seismic > Load Seismic File (New Frame). В стандартном диалоге 

File Open (Открыть файл) выберите файл, а в диалоге 

 

Выберите ‗Model or Migrated gather‘ (Модель или Мигрированный разрез). Ваш выбор будет 

запомнен, и в следующий раз при загрузке этого же файла, этот запрос выполняться не будет. 

Файл откроется в новом фрейме Seismic. 

 

Более детально о работе с файлами 3D моделей и их отображении можно найти в разделе 

«Просмотр 3D сейсмических моделей и результатов 3D миграции». 

Вы также можете отобразить файл 3D модели в трехмерном виде. Для этого создайте новый 

фрейм 3D View с помощью команды меню 3D View > View Data Cube (New  

Frame). В окошке диалога Add Items (Добавить элементы), выберите файл, который хотите 

просмотреть: 
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ЗАМЕЧАНИЕ: Для процедуры трехмерного моделирования не обязательно иметь 

файл скоростной 3D модели, загруженный в интерфейс. Однако, это полезно как для 

просмотра файла, так и для уверенности, что был выбран правильный файл для 

моделирования. 

 

Затем скоростная 3D модель будет показана в трехмерном виде:  

 

Для более детальной информации о просмотре трехмерных изображений смотрите главу 

«Фрейм 3D View. Визуализация 3-х мерных объектов». 
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8.1.2 Загрузка отражающей поверхности 

Отражающая поверхность может быть представлена в любом стандартном формате решеток. 

(см. Загрузка поверхности из текстового файла). Для того, чтобы ее загрузить, выберите 

команду меню File > Load Surface File. Если фрейма с картой Map Frame не было, 

он будет создан, а файл загрузится. Кроме того, вы можете использовать меню Map > 

Create Map (New Frame) (Создать карту в новом фрейме) и в диалоге выбрать ―Load 

TXT or GRD-surface files (Загрузить файл поверхности в ТХТ или GRD формате). 

При загрузке поверхности вам будут заданы вопросы о построении изолиний. Это касается 

только их отображения и не является обязательным. После этого вам будет представлен 

диалог свойств поверхности Surface properties: 

 

Более подробную информацию о параметрах в этом диалоге и по работе с фреймом карты 

Map можно найти в разделе «Фрейм Surface. Карты стратиграфических поверхностей». После 

нажатия кнопки ОК, поверхность загружается в фрейм Map (Карта). 
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8.1.3 Запуск 3D лучевого моделирования 

Перед тем, как начать расчет модели, необходимо создать 3D систему наблюдений. 

Ниже представлен пример отражающей поверхности и 3D системы наблюдений: 

 

Для запуска трехмерного лучевого моделирования выберите команду меню Run> 3D Ray 

Tracing Modeling…. Если вы не сохраняли проект, вам будет предложено это сделать. 

После этого открывается диалог 3D Ray Tracing (Трехмерное лучевое моделирование): 
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Вы можете изменить следующие параметры :: 

• Output Folder. Определяет папку, в которой хранятся исходные файлы и результаты 

вычислений. 

• Velocity Cubes (Файл куба скоростей). Определяет файл, в котором заданы 3D скорости в 

формате SEG-Y, используемый в трехмерной модели (см. Просмотр 3D скоростной модели). 

Куб скорости поперечных волн задается в случае PS лучевого моделирования, в противном 

случае значение Vs генерируется автоматически в соответствии с уравнением Кастанья 

(Castagna’s equation) . 

• Horizon File (Файл поверхности). Определяет файл отражающей поверхности (см. Загрузка 

отражающей поверхности) 

• Horizon File Type (Формат файла поверхности). Указывает тип файла, применяемого для 

отражающей поверхности. (Подробно см. Загрузка поверхности из текстового файла). 

• Sources to compute (Группа источников для расчета). Укажите диапазон источников для 

вычислений. Задайте диапазон в редактируемых окошках или нажмите кнопку All (Все), 
чтобы провести вычисления для всех источников, или Active (Активные), чтобы провести 
вычисления только для выбранных источников в 3D системе наблюдений (см. 3D система 

наблюдений) 
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ЗАМЕЧАНИЕ: Не устанавливайте слишком малые значения для шагов 

вычислений. Это приведет к значительному увеличению времени вычислений. 

• Region Cube (Размеры куба). Укажите размеры 3D модели для расчетов или используйте 

кнопки From Velocity File (Из файла скорости) или From Surface (Из поверхности) для 

задания размера куба из диапазонов в соответствующих файлах. 

Также в этой группе задаются шаги вычислений. X step и Y step (Шаг по X и шаг по Y) 

определяют пространственную плотность лучей в процессе вычислений, в то время как Z 

step (шаг по Z) определяет используемый программой шаг по времени и влияет на 

количество звеньев, из которых состоит каждый луч. 

 

• Illumination File Name (Имя файла освещенности) указывает имя файла поверхности, в 

котором будет сохранена карта освещенности после вычислений. 

• Rays File Name (Имя файла лучей) указывает имя файла (или группы файлов), в котором 

лучи от источников, достигшие приемники, будут сохранены после вычисления. В имени 

файла будет автоматически снабжен индексом источника, и для каждого источника в 3D 

системе наблюдений будет создан один файл. 

• Пользователь может также учесть затухание сигнала при пробеге лучей, отметив опцию the 

Attenuation due to Ray divergence и выбрав один из двух режимов вычисления 

точного Precise или быстрого Fast. Для Precise (Точного) режима будет учитываться 

закон отражения и рефракции Снелла (Snell’s Law), и лучи будут изгибаться в соответствии 

с упругими свойствами куба скоростей Velocity Cube File. В Быстром режиме Fast 

Mode падающая и отраженная волны останутся совершенно прямыми. 

Нажмите RUN (Запуск), и моделирование начнется. Появится обычное диалоговое окно 

процесса расчета: 
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8.1.4 Просмотр карты освещенности 

После того, как закончится расчет, результативный файл освещенности загружается во 

фрейм Map. (Вам будет предложено провести изолинии, это не обязательно). 

  

 

Вы также можете загрузить карту освещенности позднее, используя команду меню File> 

Load Surface file. Этот файл находится в папке, указанной в диалоговом окне 3D Ray 

Tracing (см. Расчет 3D трассирования лучей). 

Теперь Вы можете отобразить отражающую поверхность вместе с картой освещенности в 

фрейме 3D View. Для этого выберите команду меню 3D View> View Data Cube (New 

Frame) (3D Просмотр> Просмотр данных куба (Новый фрейм)). 

Появится диалог Add items (Добавить элементы): 
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Для выхода из диалога нажмите Cancel (Отмена), (не нажимать ОК) 

Создан пустой фрейм 3D View. Теперь выберите 3D View> Add Surface> From 

Project. Появится диалог Add Surface From Project (Добавить поверхность из 

проекта): 

 

В левом списке All Layers (Все слои) выберите поверхность отражения и нажмите 

'>'. Название поверхности переместится в следующий список Layers to be added (Слои, 

которые будут добавлены). 

2 

1 



© Tesseral Technologies -Документация Пользователя- 237 

 

 

 

Нажмите OK. В диалоге свойств поверхности Surface Properties 

 

отметьте опцию ―Filling by another surface (Заливка другой поверхностью), и затем нажмите 

― ”…”. В диалоговом окне Filling by Surface (Заливка поверхностью) выберите переключатель 

― “From project”, и затем выберите из списка карту освещенности. Нажмите ОК в обеих 

диалогах, и поверхность загрузится во фрейм 3D View. 

2 
1 

4 

3 
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Для получения инструкций о том, как настроить параметры отображения 3D- просмотра 

(вращение, масштабирование и т.д.), пожалуйста, обратитесь к разделу «Фрейм 3D View. 

Визуализация 3-х мерных объектов». 
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8.1.5 Просмотр лучей 

Выберите команду меню 3D View > Add/Remove Rays…. В диалоге Open File выберите 

файл с расширением ‗.bin‘, имая которого указывается в диалоге Ray Tracing (см. Расчет 3D 

трассирования лучей). По умолчанию это файл имеет название “OutputRays.bin”. Этот файл 

содержит каталог всех вычисленных лучей во время моделирования. 

Открывается диалог Add Rays (Добавить лучи): 

 

Слева, вы можете указать, какие лучи вы хотите добавить: от источников, приемников, или 

точек отражения. 
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Затем выберите лучи, которые нужно отобразить в поле 3D View. В зависимости от вашего 

выбора в левой части диалогового окна, будут показаны лучи из источников, приемников 

или точек отражения. Удерживая нажатой левую кнопку мышки, нарисуйте прямоугольник, 

чтобы выбрать источники, приемники или точки отражения. Чтобы отменить выбор 

определенных источников, приемников, или точек отражения, снимите выделение 

аналогичным способом, но с помощью правой кнопки мыши.  

После нажатия кнопки ОК, будут показаны лучи от выбранных источников, к выбранным 

приемникам, или в выбранных точках отражения.  

Нарисуйте прямоугольник с помощью 

мыши, чтобы выбрать точки 
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Лучи в поле 3D View можно временно скрыть, щелкнув на галочке Rays дерева 3D View.  

 

 

Если вы хотите изменить цветовую палитру, выберите команду меню 3D View → 3D View 

Frame Properties… (Свойства фрейма трехмерного просмотра). На экране 

отобразится диалог General (Общие настройки). 
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Комбо-бокс set by группы Rays Palette позволяет выбрать параметр, по которому 

раскрашиваются лучи. При выборе параметров «luminance», «offset», «angle of 

incidence» минимум и максимум палитры будет установлен по значениям яркости, 

расстояния между источником и приемником и угла между лучом и нормалью к поверхности 

в точке отражения соответственно. Минимум и максимум будет установлен только по тем 

лучам, которые загружены в поле 3D View. Каждый луч будет раскрашен целиком одним 

цветом из палитры в соответствии со значением параметра. Если же в комбо-боксе выбрать 

параметр «reflection point», то каждый луч будет раскрашен двумя цветами: одним 

цветом от источника до точки отражения и другим цветом от точки отражения до 

приемника. При этом все лучи будут раскрашены одной парой цветов. 

В диалоговом окне Palette (отображается по кнопке ...) вы можете изменять цветовую 

палитру и/или установить вручную минимальное и максимальное значения палитры. 
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8.2 Группирование источников в 3D моделировании 

Пользователь также может задать группирование источников (т.е. одновременные взрывы из 

нескольких источников) для любого метода 3D моделирования. Для того, чтобы это сделать, 

сначала нужно загрузить поверхность (см. раздел Фрейм Карта) и задать систему 

наблюдений в 3D (см. раздел 3D система наблюдений). Затем вызовите диалог Run>Run 3D 

Modelling и следуйте инструкциям раздела Моделирование: расчет синтетических 

сейсмограмм. После задания всех параметров моделирования нажмите Finish и Run  

modelling. 
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Нажмите Terminate как только по крайней мере 1% от работы был выполнен. 

После того, как работа была остановлена, найдите файл survey3d.txt в недавно созданной 

рабочей папке и откройте его в Microsoft Excel. Survey3d.txt содержит XYZ координаты 

каждой пары источник-приемник создаваемой 3D системы наблюдений (т.е. координаты 

каждой трассы), и заполните столбцы Inline и Crossline нулями. Затем, для 

источников, которые должны быть сгруппированы, должен быть назначен один и тот же 

номер. Например, если из 100 источников в 3D системе наблюдений пользователь хочет 

сгруппировать только 5, то Source Number 1 (в действительности это может быть любое 

число) должен быть назначен для всех трасс, относящихся к этим 5 источникам. Другими 
словами, каждая строка, которая содержит координаты SrcX; SrcY; SrcZ 

соответствующих 5 источников, должна быть заполнено с тем же номером. Остальные 95 

источников (которые не представляют интереса для нас), должны быть обозначены другим 

номером (например, 2), так, что вся колонка SrcNum заполнена. Для случаев группирования 

3-х или более наборов источников применяется такая же методика. 
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После того, как колонна SrcNum будет вся заполнена, сохраните и замените существующий 

файл survey3d.txt на обновленный (не забудьте также сохранить его в формате TXT). После 

чего вернитесь во фрейм с картой, который содержит ранее созданную 3D систему 

наблюдений, и нажмите Run> Run 3D Modelling>Yes. 
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После того, как расчет будет закончен, общее число полученных сейсмограмм будет 

равняться общему количеству групп источников. Для приведенного выше примера, вы в 

итоге получите 2 сейсмограммы, (одна для 5 сгруппированных источников, и другая для 

остальных 95 сгруппированных источников). 
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8.3 Двойные пары источников в 3D моделировании 

Теперь можно моделировать произвольно ориентированные двойные пары источников, 

выраженные матрицей стресса (или тензором момента) в survey3d.txt. 

Это можно сделать для любого метода 3D моделирования (кроме 3D акустического). 

Сначала загрузите поверхность (см. раздел Фрейм Карта) и задайте 3D систему наблюдения 

(см. раздел 3D система наблюдений). Затем вызовите диалог Run> Run 3D  Modelling 

и следуйте инструкциям раздела Моделирование: расчет синтетических сейсмограмм. После 

задания всех параметров моделирования нажмите Finish и Run  modelling. 
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Нажмите Terminate, как только по крайней мере 1% от работы был выполнен. 

После того, как работа была остановлена, найдите файл survey3d.txt в недавно созданной 

рабочей папке и откройте его в Microsoft Excel. Survey3d.txt содержит XYZ координаты 

каждой пары источник-приемник создаваемой 3D системы наблюдений (т.е. координаты 

каждой трассы), и заполните все колонки Inline и Crossline нулями, а колонку 

заполните -1, что отключит ее во время вычислений. 
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Введите тензор момента в колонки KTau11, KTau22, KTau33, KTau12, KTau13, KTau23 

для всех соответствующих источников. 

Убедитесь в том, что присвоили одинаковые значения тензора момента для всех трасс, 

относящихся к определенному источнику. Другими словами, тензор момента должен 

оставаться одинаковым для каждой пары источник-приемник в таблице. 

После того, как колонки KTau были заполнены, сохраните и замените существующий файл 

survey3d.txt на обновленный (не забудьте также сохранить его в формате TXT). 

Теперь откройте файл runtask.ini, находящийся в той же рабочей папке 

моделирования, где survey3d.txt и измените 

 

[Source] 

Type=0; Omnidirectional 

на 

[Source] 

Type=10; Double Couple 

 

После чего сохраните файл runtask.ini (File> Save)в той же папке. 

Затем вернитесь во фрейм с картой, в котором находится ранее заданная 3D система 

наблюдений, и нажмите Run> Run 3D Modelling> Yes. 
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© Tesseral Technologies -Документация Пользователя- 252 

 

8.3.1 Использование одного и того же тензора момента для всех источников 

Если вы хотите использовать тот же тензор момента для всех источников в 3D системе 

наблюдений, то достаточно изменить только runtask.ini файл следующим образом (оставив 

нетронутым survey3d.txt): 

Удалите строки 

[Source] 

Type=0; Omnidirectional 

И замените их на следующие: 

[Source] 

Type=8; 

K11=…; 

K22=…; 

K33=…; 

K12=…; 

K13=…; 

K23=…; 

Задав тензор момента, сохраните файл runtask.ini (File>Save), затем вернитесь во фрейм с 

картой, в котором находится ранее заданная 3D система наблюдений, и нажмите Run> Run 
3D Modelling>Yes. 
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8.3.2 Использование 2D двойных пар источников в 3D моделировании 

Кроме того, можно моделировать все двойные пары источников только в 2D (т.е. в 

направлении XZ, YZ или XY). Для этого вам необходимо изменить runtask.ini файл 

следующим образом: 

Удалите строки 

[Source] 

Type=0; Omnidirectional 

 

И замените их на следующие: 

[Source] 

Type=8; 

DoubleCoupleAxis=XZ 

Или 

Type=8 

DoubleCoupleAxis=XY  

Или 

Type=8 

DoubleCoupleAxis=YZ 

 

После чего сохраните файл runtask.ini (File>Save), затем вернитесь во фрейм с картой, в 

котором находится ранее заданная 3D система наблюдений, и нажмите Run> Run 3D 
Modelling> Yes. 
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9 Полноволновое 3D моделирование 

Для создания задания полноволнового 3D акустического или эластического моделирования 

вам понадобится: 

1. Построить модель в виде куба скоростей в формате SEG-Y (.sgy) 

2. Задать 3D систему наблюдений 

3. Задать параметры моделирования 
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9.1 Модель в виде куба скоростей 

С помощью команды меню Map > Create Map создаете фрейм Map с поверхностями из 

базы или GRD-файлов 

 

В режиме Map/Section mode проведите на фрейме Map линию сечения (разреза). 

В заголовке должен появиться срез пластов по сечению. 
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Расширьте с помощью мышки заголовок, если сечения в нем не видно Выделенный 

красным цветом пласт – текущий активный (тот, что показывается в поле). 

По правой кнопке на заголовке вызовите команду «Select Layer» - выбрать новый 

активный пласт. Потом по правой кнопке «… 3D model properties (Свойства 3Д 

модели)» 
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Эту команду можно вызвать также путем Map > Active surface processing  

> 3D model properties. 

В диалоговом окне 3D model properties опция Surface type: top – заполняет 

скорости под поверхностью, bottom – над поверхностью. 
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Используя команды по правой кнопке на сечении Select Layer “…” и “…” 3D  

model Properties, заполняете скоростями остальные пласты: 

 

Чтобы показывать на фрейме Map палитру не карты, а скоростей сечения – зайдите в 
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диалог параметров фрейма Map, кнопка «Edit Bottom Title», и в списке «Show Section 

Palette» 

  

Для формирования трехмерного SGY файла используйте команду меню Run> Map Frame> 

Create 3D Seg-Y. Появится диалог, в котором задаются параметры решетки: 
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Если данных по скоростям в модели нет, используется значение по умолчанию. В нашем 

примере это нижняя часть модели. 

 

Результат: 
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Если есть готовая трехмерная модель (куб скоростей) в формате SGY, открываем 

сейсмический файл (.sgy): 
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Далее правой кнопкой мышеи щелкаем на Сейсмический куб и выбираем 

редактирование свойств фрейма ―Edit Frame Properties…” 

 

Правой кнопкой мышеи щелкаем на 
Сейсмический куб и выбираем 
редактирование свойств фрейма 

Открываем сейсмический 
файл (.sgy) 



© Tesseral Technologies -Документация Пользователя- 263 

 

Во вкладке Plane диалога свойств поля сейсмики удобно использовать режим отображения 

«Contour». 
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9.2 3D система наблюдений 

Далее создаем карту с 3D расстановкой 

 

Используйте мастер Acquisition Geometry Wizard для задания системы наблюдений. 

Для подробного описания задания системы наблюдений 3D см. раздел «3D система 

наблюдений» данного руководства. 

Важно: необходимо указать продольную и поперечную длину фрагмента наблюдений. 

После того, как геометрия наблюдений была задана, давайте поместим 3D сейсмический куб 

на карту и объединим их вместе. Нажмите на кнопку Edit Frame Properties 

(Редактировать Свойства фрейма), как показано ниже: 
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Включите опцию Draw Seismic frames plan (Нарисовать план сейсмического 

фрейма) чтобы совместить модель с системой наблюдений на карте: 

Нажмите “Edit Frame Properties” 
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Нажмите на кнопку "Zoom Out" несколько раз, чтобы сейсмический куб стал виден на карте. 

Переключитесь в режим ―Move and Rotate ("Перемещение и вращение") и перетащите 

систему наблюдения в область модели. 



© Tesseral Technologies -Документация Пользователя- 267 

 

 

 

Теперь, нажмите на ―Unzoom ("Уменьшить") и ―Arrange Frames ("Выстраивание 

фреймов", чтобы увидеть модель вместе с системой наблюдений: 

2. Кнопка ―Move and 

Rotate‖( Перемещение и 

вращение) 

3. Потом 

«перетаскиваем» 

расстановку на куб 

1. Выполняем ―Zoom Out‖, 

пока не будет виден контур 

куба 
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Вы можете продолжать изменять расстановку, перемещая и поворачивая продольные и 

поперечные линии на карте. 2D профиль, нарисованный на поверхности модели 

сейсмического куба, будет отображаться и на карте. 

Нажимаем эти кнопки, чтобы 
увидеть все вместе 
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Поворачиваем и 

позиционируем 

расстановку 

2D Профиль на кубе 

отображается и на карте 
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9.3 Выбор процедуры моделирования и границ 

После того, как загружен куб сейсмических скоростей и задана трехмерная система 

наблюдений, воспользуйтесь командами меню Run> Run 3D Modeling для установок и 

запуска полноволнового моделирования или Run> CLUSTER: 3D Modeling… для 

формирования задания для расчета на кластере в системе Linux. 

 

Для поведения акустического или эластического моделирования, в сейсмическом кубе 

должны быть представлены скорости продольных Р-волн. Плотность может быть рассчитана 

автоматически на основе встроенных корреляционных таблиц. Также можно предусмотреть и 

эластическое моделирование куба поперечных S-скоростей, или же он рассчитывается 

автоматически. 

Моделирование специальных границ автоматически настраивается с помощью куба P- 

скоростей. Эти границы могут быть заданы вручную, если это необходимо. 

 

 

 

 

 

 

 

 

 

 
Нажмите 
“Run 3D Modeling…” на персональном 
компьютере или 
Нажмите 
“CLUSTER: 3D Modeling…” для 
запуска на кластере 
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Укажите форму сигнала, частоту и направление в диалоговом окне Wavelet: 

Выбор 

сейсмического 

куба 

Выбор 

источников для 
моделирования 

Граница модели 

устанавливаются по кубу 

скоростей, но можно 

задать и вручную 

(например, уменьшить 

глубину) 

 

Обратите внимание на папку 
для сохранения задания и 
сопутствующих ему файлов 
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© Tesseral Technologies -Документация Пользователя- 273 

 

 

 

  

Автоматический выбор шагов 

по пространству и по времени 

сейчас в экспериментальном 

состоянии. Пожалуйста, 

убедитесь, что указаны 

разумные значения. 

Сразу же можно оценить, 

сколько понадобится 

оперативной памяти (на 1 

узел) для выполнения 

расчетов. 

Частота сигнала влияет на необходимый 

объем памяти 

Границы полей также 

влияют на 

необходимый объем 

памяти 
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9.3.1 Запуск 3D моделирования на Windows PC 

Процесс 3D моделирования отслеживается в диалоговом окне Modeling in 

Progress...: 

 

После завершения расчетов, будут получены сейсмограммы мгновенной скорости частиц и 

давления вдоль осей X, Y, Z. 
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9.3.2 Запуск 3D моделирования на кластере 

Задание состоит из: 

1. Модель куба сейсмических скоростей; 

2. Система наблюдений (survey32.txt) 

3. Параметры задания (runtask.ini) 

Вы можете положить папку с заданием на кластер в Линуксе, чтобы распараллелить 

вычисления, тем самым значительно ускорить расчет. Также, для решения масштабных 

расчетных задач, кластер позволяет использовать большие объемы памяти. 

 

 

 

  

Модель 3D 

куба 

Система 

наблюдений 

Параметры 

задания 
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10 Обработка файлов сейсмограмм 

Команды меню Run предназначенные для обработки и создания сейсмических файлов. 

ВАЖНОЕ ЗАМЕЧАНИЕ 

Вся история обработки и пользовательские настройки сохраняются в файле computation.log. 
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10.1 Процедуры общего предназначения (General Purpose Procedures) 

Во фрейме Model, модель состоит из полигонов (модель в векторном виде). Для 

использования модели в других программах, а также в лучевом трассировании, 

миграционных и некоторых других процедурах Tesseral Pro используется модель в виде 

решетки. Для экспорта фрейм Model в решетку воспользуйтесь командой Run/General 

Purpose Procedures/Export Model to Seismic Format (SEG-Y, TGR). 

 

Выходной файл может быть в формате seg-y. Тогда создается файл продольных скоростей и 2 

дополнительных файла <имя выходного файла>–PQR_Q.sgy и <имя выходного файла >–

PQR_R.sgy с компонентами плотности и поперечной скорости, соответственно. 

Выходной файл tgr-формата (внутренний формат Tesseral) файл решетки содержит все три 

компоненты глубинной модели (продольную и поперечную скорости, плотность). Также этот 

файл может содержать решетку параметров анизотропии, если отмечено Export  Medium 

Anisotropic Properties. 

  

Ограничения на 
значения 
параметров (при 
формировании 
тонкослоистости из 
каротажных кривых) 

Создавать файлы с 
решетками 
параметров 
анизотропии 

Шаг решетки 
выходного файла 

Сформировать 
стандартное имя 
выходного файла 
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10.1.1 Копирование сейсмограммы в формат Seg-Y 

Команда Run/General Purpose Procedures/Copy Seismogram to SEG-Y 

Format используется для преобразования файлов внутренних форматов TGR, SDS-PC в 

стандартный Seg-Y формат. 

 

В TGR-формате не содержаться данные о географических координатах трасс и высоте 

приемника. Отметьте Write coordinate from model для заполнения этой информации 

из фрейма Model в заголовки трасс выходного SEG-Y файла. 
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10.1.2 Разбить сейсмограмму на части по источникам 

Команда Run> General Purpose Procedures> Split Seismogram by  

Shotgathers разбивает полевую или синтетическую сейсмограмму на отдельные файлы 

общего пункта возбуждения (один файл для каждого пункта взрыва). 
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10.1.3 Разбить сейсмограмму на части определенного размера 

Команда Run> General Purpose Procedures> Split SEG-Y File by Limited 

Size Pieces разбивает файл в формате Seg-Y на куски выбранного размера. 

Размер каждого файла не превышает значение, указанное в параметрах выходного файла 

Output file Size (MB). 
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Добавить файл(ы) в группу 

Удалить файл из группу 

10.1.4 Объединить сейсмические файлы 

Команда Run> General Purpose Procedures> Merge Seismograms объединяет 

выбранные файлы в один (в выходном файле будут все трассы всех входных файлов 

записанные в порядке файлов в списке). Если координаты выбранных файлов точно 

совпадают, процедура работает иначе: суммирует значения в трассах (в выходном файле 

трасс столько же, сколько в каждом входном). Второй вариант процедуры используется, 

например, для суммирования кубов после миграции. 
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В выходную сейсмограмму 
попадают только трассы 
ограниченные 
прямоугольником 

 

Условие отбора трасс в 
ограничивающий 
прямоугольник 

 

10.1.5 Вырезать трассы по координатам, ограниченным прямоугольником 
(Вырезать куб/фрагмент) 

Команда Run> General Purpose Procedures> Cut Out Cube/Section 

используется, например, для подготовки полевых сейсмограмм для миграции дуплексных 

волн или вырезания из большого сейсмического файла части, попадающей в указанный 

прямоугольник. Полезно для ускорения обработки очень больших файлов. 

 

  



© Tesseral Technologies -Документация Пользователя- 283 

 

10.1.6 Создать 3D решетку размножением 2D среза (3D Replication) 

Команда Run> General Purpose Procedures> 3D Replication  

используется, например: 

• Для создания трехмерной системы наблюдений (несколько линий источников) из одной 

(с несколькими линиями приемников), полученной с помощью 2.5 моделирования , 

чтобы создать настоящий 3D набор данных из 2D наблюдений. 

• для создания трехмерной скоростной модели (в формате сейсмограммы) из плоской 2D-

сейсмограммы-модели. 

 

 

 

 

ЗАМЕЧАНИЕ: Input File – это скоростная глубинная модель или разрезы 

общего пункта взрыва- решетка в формате Seg-Y или TGR. Чтобы получить 

глубинную скоростную модель в Seg-Y или TGR формате, используется 
Model> Export to Seismic Format. 

Начальные 

координаты и 

азимут профиля 

Линии в 

выходном 3D 

файле. 
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Координаты 

начала профиля 

Входной 2D файл 

Выходной 3D файл. 
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10.1.7 Изменить шаг дискретизации трасс файла 

Используется команда Run> General Purpose Procedures> SEG-Y File 

Resampling. 
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10.1.8 Разница двух сейсмограмм 

Команда Run> General Purpose Procedures> Difference of 2 Seismograms 

используется, чтобы показать отличия 2-х синтетических сейсмограмм, построенных на 

похожих моделях. Например, для исследования как элементы модели влияют на выходную 

сейсмограмму. 

Другой способ использования – получение разницы мигрированных кубов или разрезов 

 

 

 

  

равно минус 
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10.1.9 Загрузка и выгрузка координат трасс (Import/Export Traces Coordinates) 

Сохранить координаты источников и приемников из заголовков трасс в текстовый файл 

Run> General Purpose Procedures> Import Traces Coordinates. 

Загрузить координаты источников и приемников в заголовки трасс из текстового 

файла Run> General Purpose Procedures> Import Traces Coordinates. 
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ЗАМЕЧАНИЕ: В результате перечисленных способов изменения координат трасс 

заголовки самих сейсмических файлов не меняются, а информация о координатах 

трасс записывается в дополнительный файл <имя сейсмограммы>.inf для 

дальнейшего использования в Tesseral Pro. 

10.1.10 Запись координат трасс из фрейма Seismic в заголовки трасс seg-y 
(Write Visible Coordinates to Trace Headers) 

Для записи измененных координат трасс в заголовки трасс сейсмических файлов 

используется команда Run> General Purpose Procedures> Write Visible  

Coordinates to Trace Headers. 

В Tesseral Pro имеются возможности показывать сейсмические файлы, 

преобразовывая координаты с помощью нескольких команд: 

• команда Seismic> Rotate to Align X Axis along Section Profile 

• команда Run> General Purpose Procedures > Import Traces  Coordinates  

(загрузка координат трасс из текстовых файлов); 

• команда View> Raw Trace View Window ((диалог, в котором можно установить загрузку 

координат трасс из нетрадиционных мест заголовков трасс); 

Подробнее об этих возможностях в разделе Фрейм Seismic. Отображение сейсмических файлов. 
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10.1.11 Вырезание профиля из 3D сейсмограммы 

Эта функция используется для извлечения трасс вдоль прямой линии или полилинии из 3D 

сейсмограммы. 

Для доступа к этой функции загрузите 3D сейсмограмму (File>Load Seismic file), а 

затем нажмите Run>General Purpose Procedures>Cut Profile from  3D 

seismogram. 
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Если вы хотите извлечь координаты по линии, тогда укажите X from (X от), X to  (X 

до), Y from (Y от), Y to (Y до) и Step (шаг) или нарисуйте профиль во фрейме 

сейсмики Seismic>Edit Mode>Draw Profile перед обращением к функции Cut  

Profile from 3D seismogram (для получения дополнительной информации о 

профилях см. Профили). 

Трассы можно также извлечь в соответствии с желаемой геометрией системы наблюдений — 

Survey from SPS file (см. Раздел Создание модели из SPS-файла) или из текстового 

файла с координатами трасс - Profile from Seismic File  coordinates( см. 
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Раздел Загрузка и выгрузка координат трасс) 
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10.1.12 Выгрузка (Экспорт) профиля в 2D сейсмический файл 

Для того, чтобы выгрузить 2D профиль из сейсмического куба, прежде всего загрузите 3D 

куб (File>Load Seismic file), начертите профиль во фрейме сейсмики (см. 

Профили,далее нажмите Run> Seismic Frame > Export Map to 2D Seismic  

file. 

 

 



© Tesseral Technologies -Документация Пользователя- 
293 
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10.1.13 Полосовой фильтр (Band-pass) 

 

У пользователя есть возможность умножить спектр сигнала в частотной области 

(эквивалентно свертке во временной области) на спектр фильтра, задав частоты полосового 

фильтра F1, F2, F3, F4 в углах трапеции, а также длину (Length) фильтра по 

времени. 
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10.2 Скоростная модель 

Процедуры обработки, использующие скоростную модель 
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10.2.1 Создать среднескоростную модель из пластовой модели (Average 
Velocities from Model) 

Команда Run> Velocity Model > Average Velocities from Model 

 

Input file – пластовая скоростная модель. Этот файл можно получить из фрейма Model с 

помощью команды Model> Export to Seismic Format (SEG-Y, TGR) 
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ЗАМЕЧАНИЕ: Velocity seismic file – пластовая скоростная модель. 

Этот файл можно получить из фрейма Model с помощью команды Model> 

Export to Seismic Format (SEG-Y, TGR) (подробности в разделе 

Экспорт модели в сейсмический файл) 

10.2.2 Преобразование глубинного файла во временной и временного в 
глубинный 

Команда Run> Velocity Model> Depth to time transformation  

преобразует мигрированный разрез (куб) из глубинной шкалы во временную. 

 

 

Команда Run> Velocity Model > Time to Depth Transformation 

преобразует временной разрез (куб) в глубинный. 

 

  

ЗАМЕЧАНИЕ: Velocity seismic file – это файл решетки пластовой 

модели во временной шкале. Его можно создать из файла глубинной модели, 

выполнив преобразование Depth to Time Transformation. Т. е. если в 

процедуре Depth to time transformation Input file и Grid 

model File – это скоростная глубинная модель, то Output file будет эта 

же скоростная модель, но во временной шкале. 

Скоростная глубинная 
модель 
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10.2.3 3D интерполяция 

С помощью команды Run> Velocity Model> Interpolation, пользователь может 

изменить шаг дискретизации сетки для любого 3D SGY куба путем интерполяции. Для 

реализации этой функции, сначала загрузите 3D SGY: File> Load Seismic File и 

далее Run> Velocity Model> Interpolation. 

 

 

Назначьте новый шаг сетки Step вдоль осей X, Y, Z, а также задайте Min и Max в 

Turn OFF и нажмите OK. 

По умолчанию будут заданы X, Y, Z координаты для всего куба. Файл выходной модели 

Output model file будет иметь новый шаг сетки, в чем можно убедиться, посмотрев в 

заголовки трасс. 
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10.3 Процедуры предобработки 

Эти процедуры предназначены для предварительной обработки. 
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10.3.1 Перекомпоновка сейсмограмм (Gathering) 

Выборка сейсмограмм ОСТ, ОПП, равных удалений. Процедура предназначена для 

пересортировок сейсмограмм по общему пункту возбуждения, общей средней точки, общего 

пункта приема или получение сейсмограмм равных удалений. Процедура предназначена как 

для 2D сейсмограмм, так для 3D сейсмограмм. 

Команда Run> Pre-Processing> Gathering (GATHER). 
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10.4 Процедуры суммирования (Stack (Time domain) 

Это процедуры суммирования во временной области. 
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10.4.1 Ввод кинематических поправок (Normal Moveout) 

Процедура Normal Moveout вводит кинематические поправки в сейсмограммы 

различного типа – общей средней точки или общей точки приема (после работы программы 

Gathering), а также общей точки возбуждения. Результатом работы являются 

сейсмограммы того же типа, что и на входе программы Normal Moveout, но с введенными 

кинематическими поправками. 

Команда Run> Stack (Time domain)> Normal Moveout (NMO) 

 

Среднескоростную модель (параметр Velocity file) можно создать из попластовой 

глубинной скоростной модели командой Run > Velocity Model >  Average 

Velocities from Model. После анализа результатов, для получения временного разреза 

сейсмограммы, являющиеся результатом работы программы Normal Moveout, должны 

быть обработаны с помощью процедуры Stacking. 
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10.4.2 Суммирование по общей координате (Stacking) 

Процедура Stacking предназначена для суммирования трасс, имеющих общую координату, 

после ввода кинематических поправок. Это могут быть выборки по общей глубинной точке, 

полученные после работы программ Gathering и Normal Moveout. 

Результатом работы является временной разрез, полученный по сейсмограммам общей 

средней точки, общей точки возбуждения или общей точки приема. Перед выполнением 

процедуры Staking необходимо с помощью процедуры Normal Moveout ввести 

кинематические поправки в трассы сейсмограмм, сгруппированных по общей средней точке 

или по общей координате другого типа. 

Команда Run> Stack (Time domain)> Stacking (STACK) 

 

 

Accuracy размер бина, используемый для суммирования общих трасс глубинных точек. 
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10.4.3 Получение временного разреза ОГТ (CMP Stack) 

Данная процедура предназначена для непосредственного построения временного разреза по 

ОСТ (суммы по ОСТ), минуя программы Normal Moveout и Stacking. В качестве 

исходной информации используются сейсмограммы любого типа, полученные 

непосредственно при моделировании или прошедшие какую-либо обработку. Процедура CMP 

Stack использует среднескоростную характеристику среды (параметр Velocity file). 

Команда Run> Stack (Time domain)> CMP Stack (SUM) 

 

Среднескоростную модель можно создать из попластовой глубинной скоростной модели 

командой Run> Velocity Model > Average Velocities from Model. 

Gradient – градиент временной задержки. 
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10.4.4 Суммирование с применением поправок за наклон отражающей 
границы (Dip Moveout Stack) 

Пользователь может реализовать суммирование с применением поправок за наклон 

отражающей границы (который сначала выполняет коррекцию данных до центрального луча 

(нулевой вынос (NMO), а затем ввод поправок за наклон отражающей границы (DMO) и 

суммирование, т. е. 3 в 1). 

Как известно, ввод обычных кинематических поправок с нулевым выносом (NMO) для 

наклонных границ приводит к неправильному положению данных и, следовательно, к 

ошибочному суммарному разрезу. Dip Moveout correction (DMO) - метод, который 

преобразует сейсмические данные и приводит все к «истинной» общей глубинной точке, 

независимо от угла падения. Комбинация NMO и DMO с последующей миграцией после 

суммирования эквивалентна, но может быть реализована намного эффективнее, чем полная 

временная миграция до суммирования (JAKUBOWICZ, H. (1990), A SIMPLE EFFICIENT 

METHOD OF DIP-MOVEOUT CORRECTION1. Geophysical Prospecting, 38: 221–245. 

doi:10.1111/j.1365-2478.1990.tb01843.x). 

Процедура суммирования с применением поправок за наклон отражающей границы DMO 

Stack использует файл средних скоростей (нужно указать Velocity file). Параметр 

Step задает шаг дискретизации суммирования по осям X и Y (в случае 3D- сейсмики). 

 

  

http://onlinelibrary.wiley.com/doi/10.1111/j.1365-2478.1990.tb01843.x/full#fn1
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10.5 Миграции 2D/3D 

Процедуры миграции временных двумерных сейсмограмм 
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10.5.1 Пре-стек миграция Кирхгофа (Time Pre-Stack Kirchhoff Migration) 

Процедура предназначена для построения сейсмического изображения среды 

(мигрированного разреза) с учетом сейсмического сноса непосредственно по 

сейсмограммам, минуя построение временного разреза ОСТ и пост-стек миграцию. 

Команда Run> 2D Migration (Time domain) > Time Pre-Stack  Kirchhoff 

Migration (PSM): 

 

Для миграции необходима среднескоростная модель во временной шкале. Ее можно получить 

последовательным выполнением команд Model> Export to Seismic  Format 

(SEG-Y, TGR)) и Run > Velocity Model > Average Velocities  from 

Model. Можно уточнить единицы измерения скорости в файле модели (m/s или ft/s). 

Апертуры миграции вводить не обязательно: программа может использовать значения по 

умолчанию. Для задания пользовательских апертур используются кнопки раздела 

Aperture: Add – добавить, Delete – удалить, Delete All – удалить все, Load – 

загрузить из файла и Save – сохранить в файл. Каждая из кнопок вызывает простой диалог. 

Мигрированный разрез задается разделами Profile Coordinates (с помощью кнопки 

Adjust можно уточнить его направление) и Output Section (размеры и шаг вдоль 

профиля). Можно использовать значения по умолчанию. 

Растяжку сигнала ограничивает Gradient, по умолчанию – 0.5. При слишком низком 

градиенте изображения «размазываются», при слишком высоком градиенте – пропадают 

некоторые участки. 

Результат можно нормализовать (в этом случае усилится шум и слабые сигналы). Как 

правило, нормализация не делается (Just sum). 

Результирующий временной раздел записывается в Output file. Для его преобразования 

из временной шкалы в глубинную можно использовать команду меню Run  

> Velocity Model > Time to Depth Transformation. 
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10.5.2 Глубинная миграция, основанная на уравнении эйконала (Depth Pre-
Stack Kirchhoff Migration) 

Команда Run> 2D Migration (Depth domain)> Depth Pre-Stack Kirchhoff 

Migration (DPSKM) выполняет глубинную пре-стек миграцию Кирхгофа. Результат, как 

и во временной миграции, формируется во временной шкале. Для его преобразования в 

глубинны, можно впоследствии использовать команду меню Run>  Velocity Model > 

Time to Depth Transformation. 

 

Для миграции необходима пластовая модель в глубинной шкале. Ее можно получить 

последовательным команды меню Model> Export to Seismic Format (SEG-Y, 

TGR.  Можно уточнить единицы измерения скорости в файле модели (m/s или ft/s). 

Апертуры миграции вводить не обязательно: программа может использовать значения 

по умолчанию. Для задания пользовательских апертур используются кнопки раздела 

Aperture: Add – добавить, Delete – удалить, Delete All – удалить все, Load – 

загрузить из файла и Save – сохранить в файл. Каждая из кнопок вызывает простой диалог. 

Мигрированный разрез строится та основе 2-D данных. Размеры области построения 

и шаг вдоль профиля (в направлении X) задается в Coordinates along X-axis. Можно 

использовать значения по умолчанию. 

Растяжку сигнала ограничивает Gradient, по умолчанию – 0.5. При слишком низком 

градиенте изображения «размазываются», при слишком высоком градиенте – пропадают 

некоторые участки. 

В процессе работы программа использует алгоритм эйконала для расчета временных полей. 

Дискретность расчетной сетки задает Step X/Y в разделе Time estimation settings. 
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Дополнительная рамка (Margin) позволяет избежать влияния краевых эффектов. Ее 

рекомендуется делать размером в 5-10 шагов сетки. 

Результирующий временной раздел записывается в Output file. 

Min time shift from direct wave (минимальный временной сдвиг от прямой 

волны) используется (если необходимо) на разрезе для подавления шумов миграции на 

определенном интервале после прихода прямой волны. 

Также, задав соотношение продольных и поперечных волн Vp/Vs в среде сразу под 

системой наблюдения, пользователь, по сути, приглушает прямые продольные и поперечные 

волны на разрезах, и, следовательно, устраняет ненужные для миграции шумы, 

сопутствующие этим волнам. 
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10.5.3 Миграция Дуплексных Волн 

Миграция Дуплексных Волн (МДВ) является новой технологией для формирования 

изображений субвертикальных границ с углами наклона от 60 ˚ до 90 ˚. 

Дуплексные волны имеют два отражения: от субгоризонтальной границы, потом от 

субвертикальной или наоборот. 2D МДВ поддерживает только PPP тип отражения. 

Перед запуском 2Д МДВ пользователь должен в первую очередь импортировать 2Д 

синтетическую сейсмограмму в SGY формат, а также 2Д модель, при помощи которой была 

сформирована сейсмограмма. Для этого нужно войти в File>Open в верхнем меню. 

 

Когда модель и сейсмограмма будут загружены пользователь может запускать МДВ при 

помощи инструкции Run>2D Migration (Depth domain)>Duplex Wave  

Migration. 



© Tesseral Technologies -Документация Пользователя- 311 

 

 

 

В диалоге Duplex Wave Migration пользователь должен проверить правильность 

входной синтетической сейсмограммы в SGY формате Input file, и задать имя и адрес 

выходного файла Output File мигрированного сейсмического разреза. 

Алгоритм МДВ предназначен для формирования изображения по энергии ДВ, время прихода 

которой больше, чем то, что относится к базовой границе. 

Подавление этих помех при МДВ осуществляется исключением из области построения 

изображения лучевой трубки заданного радиуса, сформированной вокруг траектории, 

которая соответствует однократно отраженной волне. Для этой цели пользователь должен в 

Model P file загрузить скоростную модель в SGY формате (в глубинном масштабе), 

которая содержит горизонтальные и субгоризонтальные границы, но без целевых 

вертикальных границ, изображение которых будет формироваться при помощи МДВ. 

Глубинная модель формируется по инструкции Model >Export to Seismic  

Format(SGY)из верхнего меню. 

Пользователь также должен выбрать отражающую границу в модели Reflecting  

boundary(polygon) или базовую границу для формирования дуплексного отражения. 

Для этой цели импортируемая 2Д модель должна иметь базовую границу в качестве полигона 

(см. раздел Построение и редактирование полигонов). Базовая граница должна быть, 

разумеется, ниже суб-вертикальных неоднородностей, которые предполагается формировать 

при помощи МДВ. 

Мигрированный разрез имеет параметры Start X и Stop X (Начальный Х и Конечных Х), 

также Start Y и Stop Y (Начальный Y и Конечных Y)в координатах профиля Profile 

Coordinates (для выбора координат, соответствующих полному профилю необходимо 

нажать кнопку Adjust). Задавать параметр шага Step рекомендуется для идентичности 

шага сетки, которая использовалась для решения прямой задачи. 
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Программа использует ейконал для расчета времен прихода волн. Дискретность сетки 

расчета по X и Z определяется при помощи окна Step (шаг) в группе Time estimation  
settings. 

В закладке Aperture определяются апертуры МДВ. Пользователь может определить 

левостороннюю апертуру при помощи расстояния (интервала) левее от пары источник-

приемник to the left of the source receiver group или правее от пары 

источник-приемник to the right of the source receiver group. Для 

симметричной апертуры определяются оба интервала. Левая апертура выбирается левее 

самой левой точки пары источник-приемник, а правая апертура выбирается правее самой 

правой точки пары источник-приемник. 

Растяжка сигнала ограничивается при помощи параметра Gradient, значение по 

умолчанию которого равно 0. Если градиент очень маленький, то изображение будет очень 

растянутым. Если градиент очень большой, то часть информации будет обнулена. 

Имеются два возможных варианта дуплексных волн: HV и VH (т.е. отражение сначала от 

горизонтальной границы, а потом от вертикальной (HV) и наоборот (VH). 

Для ограничения офсетов используются min(Xr-Xs) и max(Xr-Xs), где Xr- координата 

пункта приема, Xs - координата пункта возбуждения. Обрабатываться будут только 

указанные трассы, остальные будут обнулены. Обратите внимание, что задаваемые значения 

могут быть отрицательными для трасс левее источника и положительными для трасс правее 

источника. 

Параметр Threshold используется для обнуления интервала трасс для подавления 

миграционных помех, связанных с отражением от опорной границы. 
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10.5.4 Миграция 2D дуплексных волн на обменных волнах (CDWM) 

Миграция дуплексных волн на обменных волнах может быть использована для PPS, PSS и 

PSP типов дуплексных волн, как Вы можете видеть в CDWM окне. В зависимости от типа 

обменных дуплексных волн Вам может потребоваться X-компонента волнового поля (т.е. 

скорость смещения частиц по горизонтали) синтетической сейсмограммы, а также 

скоростная модель поперечных волн S Model File 

 

Пользователь может определить интервал апертур между источником и приемником (нужно 

поставить птичку в боксе. between source and receiver). Эта опция используется 

для получения изображения на основе проходящих обменных волн. 
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10.5.5 Миграция рассеянных дуплексных волн 

Дуплексная миграция для рассеянных волн больше всего подходит для целевых объектов 

ниже последнего сильного горизонта, таких как разломы соляные купола и другие круто 

наклоненные структуры. 

 

 

В отличие от МДВ для PPP и обменных волн, здесь не нужно задавать опорную границу. 

Вместо нее задается Глубинный Интервал (Depth interval) для рассеянных дуплексных 

волн, относительно непрерывно дискретно задаваемых по глубине опорных границ. 
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8.5.1 Глубинная миграция 2D ВСП 

Для запуска глубинной 2D миграции ВСП нажмите в меню Run> VSP procedures 

(Depth domain)> 2D Depth Kirchhoff VSP Migration (PSDM). На экране 

отобразится диалог с параметрами миграции. 

 

Этот диалог автоматически подхватывает для миграции сейсмограмму из текущего фрейма 

Seismic (если сейсмограмма не выбрана, ее можно выбрать по кнопке ...). 

Выходной файл будет содержать мигрированный разрез. Его имя также формируется 

автоматически, если подхвачено имя входного файла (сейсмограммы) путем добавления 

суффикса « +PSDM». Если файл с таким именем уже существует, дополнительно добавляется 

номер версии – цифра от 0 до 9. 

Min time shift from direct wave используется, чтобы не суммировать фрагмент 

трассы от t-s до t+s, где t – время прихода волны от источника к приемнику, s – значение 

этого параметра в секундах. (Значение t рассчитывается по скоростной модели в процессе 

миграции для каждой трассы.) 

Галочки Waves reflected from horizontal boundary и Waves reflected 

from vertical boundary определяют, какие границы строить в миграции: 

(горизонтальные, или вертикальные); в нашем случае границы только горизонтальные, 

поэтому выбираем верхний флажок. 

Начало, конец, шаг сетки мигрированного разреза по глубине (раздел Output Section) 

автоматически определяются из скоростной модели (фрейм Model). 

Шаг Step (пространственный шаг сетки разреза по длине и по глубине) в разделе Time 

estimation settings, с которым рассчитывается время прихода волны от источников и 
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приемников в каждую точку выходного разреза, может не совпадать с соответствующими 

шагами выходного разреза: Step из раздела Output Section. По умолчанию он 

определяется по модели на основе эвристического правила. Меньший шаг обеспечивает 

большую точность расчета времен за счет замедления квадратичного (т.е. в степени 2 

относительно масштабного коэффициента изменения шага). Стоящий рядом 

Margin нужен, чтобы ослабить влияние краев модели. 

Каждое значение трассы входной сейсмограммы «размазывается» в пределах конуса (в 2D – 

треугольника), заданного апертурами. Для каждой трассы треугольник откладывается от 

средней точки между x-координатой источника (xs) и x-координатой приемника (xr). 

Апертуры миграции могут меняться как вдоль оси времени записи в вертикальном 

направлении Т0, так и в зависимости от положения источника. Значение апертур по 

умолчанию подобрано так, чтобы угол при вершине конуса alpha равнялся 15 градусам. Дуга 

эллипса показывает, в какие точки выходного разреза будет просуммировано значение трассы 

входной сейсмограммы по времени t = ts + tr (= 1.715 на следующих рисунках), где ts – время 

прихода волны от источника в точку выходного разреза, tr – время прихода волны от точки 

выходного разреза до приемника 

 

 

 

Апертуры миграции могут меняться в зависимости от координаты Х источника. Если X-

coordinate апертур – только одна, она используется для всех трасс (т.е. этот параметр 

игнорируется). 

Настроив параметры, по кнопке ОК запускаем расчет миграции и получаем результат. 
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8.5.2 Глубинная миграция 3D ВСП 

Для запуска глубинной 3D миграции ВСП нажмите в меню Run> VSP procedures 

(Depth domain)>3D Depth Kirchhoff VSP Migration (3D PSDM). 

Обратите внимание, что в этом методе реализована только миграция отраженных продольных 

P-волн от горизонтальных границ. 

 

 

Input file – 3D сейсмограмма. Если это TGR файл (в отличие от SGY), то необходимо 

выбрать компоненты файла данных, которые будут обрабатываться. 

Далее вы должны загрузить файл модели Model P file и указать размеры 

мигрированного куба. 

На выходе обрисовывается прямоугольник. Есть два способа задать его размеры. – В 

общем случае прямоугольник на выходе задается вручную с помощью 

координат 3-х последовательных угловых точек: Xx0, Yx0, X00, Y00, X0y и Y0y в 

группе Rotated Axes. Можно использовать приблизительные значения. Программа 

корректирует координаты, чтобы сформировать правильный прямоугольник. 

– Если границы выходного прямоугольника параллельны осям координат, то 

альтернативно прямоугольник можно задать параметрами: StartX, StopX, StartY и 

StopY. Программа поддерживает вывод вертикальных секций, поэтому такие комбинации, 

как StartX=StopX и StartY=StopY включены. 

StartZ, StopZ StopZ это глубинный интервал в выходном массиве. StopZ должна 

быть ниже (больше) глубины залегания границ в модели. 

StepX, StepY, StepZ это шаги сетки для выходного массива. 
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Чтобы точно задать круговую апертуру введите непосредственно T(s) и радиус 

Radius(m)в группе Apertures. Если апертура миграции не указана, программа 

использует значения по умолчанию. 

 

 

Min. time shift from direct wave(s) используется для выключения VSP 

сейсмограммы на конкретном временном интервале, с тем чтобы устранить шумы, 

связанные с приходом прямой волны. 

Остальные параметры в окне Depth VSP Migration точно такие же, как описанные в 

2D Time/Depth Pre-Stack Kirchoff Migration (см. раздел Глубинная миграция, 

основанная на уравнении эйконала (Depth Pre-Stack Kirchhoff  Migration) 
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10.6 Процедуры постобработки (Post-Processing) 

Процедуры постобработки сейсмических файлов 
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10.6.1 Однотрассные процедуры (Trace-wise Procedures) 

 

Выберите галочку, чтобы применить функцию ко всем трассам сейсмограммы. 

• Zero Balancing (Балансировка Нуля) позволяет балансировать трассы к нулю. 

• Linear Gain (Линейное Усиление) позволяет поднять начальную (top) или конечную 

(bottom) часть трасс. 

• Normalization (Нормализация) позволяет нормализовать трассу по одному из 

выбранных критериев. 

• Auto Gain (Автоматическое Усиление) позволяет автоматически уравнивать трассу. 

Параметрами такого выравнивания являются: window (длина окна) – временной (или 

глубинный, метрический) интервал, для которого такое выравнивание производится, 

noise (порог шума) – (в процентах от максимальной амплитуды) ниже этого порога 

выравнивание подавляется. 

• Add White Noise (Добавить Белый Шум) - (в процентах от максимальной амплитуды) 

позволяет добавлять к трассам белый шум. 

• Random shift (Случайный сдвиг) – добавляет к трассам временной случайный сдвиг. 

• Smoothing (Сглаживание) позволяет обрезать высокочастотные шумы, если они 

имеются на изображении. 

• Shift (Сдвинуть) смещает всю трассу вниз (вверх) по временной шкале. 

• Final Scaling (Конечное масштабирование) (в процентах от максимальной 

амплитуды) позволяет менять абсолютные значения амплитуд. 
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10.6.2 Обнуление сейсмического куба над горизонтом 

С помощью этой функции пользователь может отключить любой заданный сейсмический 3D 

куб выше выбранного горизонта. Для этого в первую очередь загрузите SGY куб с помощью 

команды File> Load seismic file… 

 

…далее Run>Post processing>Zero Seismic Cube above a surface. 

 

Убедитесь, что в диалоге сейсмического куба Seismic cube был загружен корректный 

куб, затем загрузите карту поверхности Surface map (т.е. горизонт) и задайте высоту слоя 

Layer height над горизонтом сейсмического куба Seismic cube, которая должна быть 

сохранена. 
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10.6.3 Обнуление сейсмического куба под горизонтом 

С помощью этой функции пользователь может отключить любой заданный сейсмический 3D 

куб ниже выбранного горизонта. Для этого в первую очередь загрузите SGY куб с помощью 

команды File> Load seismic file… 

 

…далее команду Run>Post processing>Zero Seismic Cube under a surface. 

 

 

 

Убедитесь, что в диалоге сейсмического куба Seismic cube был загружен корректный 

куб, затем загрузите карту поверхности Surface map (т. е. горизонт) и задайте высоту слоя 

Layer height над выбранным горизонтом указанного сейсмического куба Seismic 

cube, которая будет обнулена. 
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11 Работа с фреймами 

В этом разделе рассказаны общие принципы размещения и редактирования фреймов (не 

зависимо от типа) в Tesseral Pro. 

Документ Tesseral Pro формируется из фреймов (Frame) четырех типов – модель, 

поверхность, сейсмика, 3D-вид. Параметры изображения фреймов настраиваются в диалогах 

Property и с помощью пунктов соответствующего раздела меню. Фреймы можно удалять, 

перемещать и дублировать. Поддерживаются операции как с одним фреймом, так и с группой 

фреймов. Документ, состоящий из фреймов, может быть напечатан или экспортирован в 

векторную (растровую) картинку без изменения вида (WYSIWYG). Существует два 

основных способа отображения фреймов: Document view и Tablet view. Подробности 

ниже в разделе «Расположение фреймов». 
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11.1 Типы фреймов 

Программа Tesseral Pro поддерживает 4 типа фреймов: 

 

• Frame Model («Модель») – фрейм «Глубинная модель разреза». Скоростная модель 

формируется из полигонов на основании скважинной и/или сейсмической 

информации.  

Полигоны создаются пользователем вручную либо автоматически по картам 

стратиграфических горизонтов (см. раздел «Фрейм Surface. Карты стратиграфических 

поверхностей»). В каждый полигон вводятся данные о скорости, плотности, а также, 

если необходимо – анизотропия и трещиноватость.  

Параметры полигона устанавливаются вручную в диалоге, либо загружаются из 

каротажных кривых выбранных скважин (тонкослоистость). Также в модель вносится 

информация о пунктах взрыва и приема. 

Построенная скоростная модель с размещенными источниками и приемниками 

используется для расчета синтетических сейсмограмм. Подробнее про фреймы Model 

в разделах Создание схемы наблюдения и Фрейм Model. коростная глубинная модель. 

• Frame Surface («Поверхность») – фрейм, в котором отображается карта скважин 

месторождения (месторождений) и поверхности, рассчитанной по скважинным 

данным либо загруженной из внешних текстовых файлов. Необходимая для расчета 

поверхностей информация – координаты пластопересечений скважин – должна быть 

предварительно загружена в базу данных Tesseral Pro. Для расчета поверхностей в 

Tesseral Pro реализовано 8 методов картопостроения, в том числе сплайн-

аппроксимация, кригинг, множественная регрессия. На основании рассчитанных 

(загруженных) поверхностей автоматически строится модель (фрейм Model) по 

любому проведенному на карте сечению. Подробнее про фрейм Surface в разделе и 

Ф р е й м 3 D  - в и д Ф р е й м С е й с м ик а 

Ф р е й м П о в е р х н о с т ь Ф р е й м М о д е л ь 



© Tesseral Technologies -Документация Пользователя- 329 

 

Н и ж н и й з а го л о в о к 

П р а в а я 

гр а н и ц а 

Л е в а я 

гр а н и ц а 

В е р т и к а л ь н а я 

ш к а л а 

П о д о ш в а 

О б л а с т ь д а н н ы х 

К р о в л я 

В е р х н и й з а го л о в о к 

ЗАМЕЧАНИЕ: Двойной щелчок мышкой на заголовок любого фреймам 

«растягивает» этот фрейм на все окно (аналог команда View> Frame Full 

Screen). Повторный двойной щелчок на заголовке размещает все фреймы 

«кирпичиками» внутри окна (аналог команда View> Arrange Frames) 

Фрейм Map. Карты стратиграфических поверхностей. 

• Frame Seismic («Сейсмика»). Отображает сейсмограммы в форматах SEG-Y, SDS- 

PC, TGR. Реализована поддержка отображения 3D-сейсмограмм. Подробнее про 

фрейм Seismic в разделе Фрейм Seismic. Отображение сейсмических файлов. 

• Frame 3D View предназначен для визуализации 3-х мерных объектов. Подробнее 

про фрейм 3D View в разделе Фрейм 3D View. Визуализация 3-х мерных объектов. 

 

Для создания нового фрейма воспользуйтесь командами меню File> New Frame. 

После этого в диалоге параметров фрейма можете поменять значения по умолчанию. 

Все фреймы имеют два собственных заголовка (верхний и нижний). В верхнем заголовке 

выводится любой текст (по умолчанию, верхний заголовок выглядит как заголовок окна в 

Windows), а нижний заголовок содержит специальную, особую для каждого типа фрейма, 

информация. 
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11.2 Выбор фреймов 

Фрейм в поле документа выбирается нажатием левой кнопки мыши. Выделенный фрейм 

отмечается пунктирной рамкой. Отмена выбора – нажатие левой кнопкой мыши за 

пределами фрейма. Выделение/снятие выделения нескольких фреймов реализовано 

стандартным для Windows способом – несколько фреймов выбираются левой кнопкой мыши 

при нажатых клавишах Ctrl или Shift. 

Также в режиме Document view mode группу фреймов можно выбрать, нажав левую 

кнопку мышки за пределами фреймов на пустое поле документа и потянув мышку (при 

нажатой левой кнопке), выделяя в окне документа прямоугольную область. Все фреймы, 

хотя бы частично попавшие в эту область, становятся выбранными. 

Последний выбранный фрейм считается главным, и к нему применяются все не групповые 

команды. Повторное нажатие левой кнопкой мыши с Shift отменяет выбор этого фрейма, 

а повторное нажатие левой кнопкой мыши с Ctrl делает этот фрейм главным выбранным. 

Все фреймы (поля) можно выбрать командой View> Select All Frames, а отменить 

выбор всех полей – View> Deselect All Frames. 
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ЗАМЕЧАНИЕ: Для автоматического упорядочивания фреймов по размеру окна 

пользуйтесь командой View> Arrange Frames, а для удобной работы с 

выбранным фреймом – View> Frame Full Screen. 

11.3 Расположение фреймов 

Для перемещения фрейма в окне Tesseral Pro нажмите левую кнопку мышки на верхнем 

заголовке фрейма и переместите фрейм, не отпуская левую кнопку мышки. 

Существует два режима расположения фреймов 

1. View> Document View Mode. Фреймы свободно размещаются в документе. 

 

В этом режиме фреймы могут перекрываться. Поэтому для выбора правильного порядка 

отображения используйте команды View> Bring Frame Forward и View> Bring 
Frame Backward 

2. View> Tablet View Mode. Фреймы располагаются только в ячейках таблицы. Для изменения 

размеров ячейки потяните мышкой (при нажатой левой кнопке) за любую сторону фрейма, либо 

измените размер колонки (строчки) таблицы на внутренних осях окна фреймов. 

Если Вы перетаскиваете фрейм в ячейку, которая уже занята другим фреймом, то старый 

фрейм сместится в ближайшую свободную ячейку. 
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ЗАМЕЧАНИЕ: Можно изменить мышкой кровлю и подошву любого фрейма со 

шкалой, если потянуть соответственно за кровлю или подошву при нажатой 

клавише Ctrl. 

В с е д е й с т в и я о с у щ е с т в л я ю т с я м ы ш к о й 

п р и н а ж а т о й л е в о й к н о п к е   

В е р х н и й 

з а го л о в о к 

И з м е н и т ь в ы с о т у 

в е р х н е го з а го л о в к а 

Н и ж н и й 

з а го л о в о к 

И з м е н и т ь в ы с о т у + C t r l 

И з м е н и т ь п о д о ш в у 

И з м е н и т ь ш и р и н у 

+ C t r l 

И з м е н и т ь к р о в л ю 

И з м е н и т ь в ы с о т у 

н и ж н е го з а го л о в к а 

С м е с т и т ь 

л е в е е / п р а в е е 

С м е с т и т ь 

в ы ш е / н и ж е 

ЗАМЕЧАНИЕ: Учтите, что при изменении размеров фрейма в Tablet view mode, 

изменяются размеры всех фреймов той же строчки, колонки таблицы. 

11.4 Размеры фреймов 

Ширина и высота фрейма устанавливается в диалоге настройки параметров (команда Edit> 

Edit Frame Properties), а высота верхнего и нижнего заголовков – в диалогах 

настройки верхнего и нижнего заголовка соответственно. У фреймов, выводящихся в 

интервале глубин или времен (Model и Seismic), высота фрейма рассчитывается 

автоматически по кровле, подошве и масштабу. Размеры фреймов можно менять мышкой. 

Для этого надо потянуть при нажатой левой кнопке за нижнюю или правую границу 

выделенного фрейма. Если выделено несколько фреймов, размеры фрейма можно менять 

только у главного (последнего) выделенного фрейма. Размеры у остальных выделенных 

фреймов станут такими же, как у этого фрейма. Высота верхнего и нижнего заголовка 

изменяется, если потянуть за нижний край заголовка. 

 

На следующем рисунке показаны возможности изменения параметров фрейма 
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11.5 Отменить / повторить 

Любую команду (или последовательность команд) при работе с фреймами в документе можно 

отменить Edit> Undo. Для повторения отмененных команд используйте Edit> Redo. 

Команды отмены не поддерживаются при работе с файлами (меню File), базой данных 

(меню Database) и при расчете и редактировании сейсмических поверхностей (Map> Add 

New Horizon from Well Tops, Map> Manage/Delete Horizons, Map > Active 

Surface Processing). 
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11.6 Масштаб отображения 

Для масштабирования (приближение/удаление) документа используются команды 

View> Zoom или кнопки на главной инструментальной линейке.  

 

 

  

Кнопки для зума 
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11.7 Печать и экспорт документа в картинку 

Составные документы формируются по принципу WYSIWYG с использованием фреймов. 

Подробности в разделе «Работа с фреймами». 

Печать документа – команда File> Print. 

Помимо вывода на печать составные документы можно экспортировать в виде картинок в 

указанном масштабе (форматы TIFF, EMF, WMF, BMP). Для этого используется команда 

File> Save as Picture. 
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11.8 Область дерева проекта и базы данных 
 

После сохранения нового проекта (File> Save Project) или загрузке старого в левом 

окне Tesseral Pro появится дерево открытого проекта. Это дерево помогает 

систематизировать все загруженные и созданные файлы.  

 

Дело в том, что каждый раз при моделировании синтетических сейсмограмм создаются 

несколько файлов, и все они помещаются в один каталог (подробности в разделе Процесс 

расчета сейсмограмм). Кроме того, при запуске разных методов моделирования для одной 

модели опять создается еще один набор выходных файлов. Все эти файлы лежат в одном 

каталоге, и бывает сложно найти нужный файл: 
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П р и м е р п а п к и с р е з у л ь т а т а м и А к у с т и ч е с к о г о и Э л а с т и ч е с к о г о м о д е л и р о в а н и я 

 

Для упрощения задачи поиска файлов, в дереве проекта (в левом окне Tesseral Pro) папки с 

сортированными выходными файлами моделирования. Папки в дереве называются также как 

соответствующий метод моделирования (Acoustic, Elastic и др.). Остальные 

сейсмические файлы, например, созданные процедурами обработки сейсмограмм, находятся 

в папке Seismic Files дерева проекта. Двойной щелчок мышки на файле в дереве 

проекта создает в правом окне Tesseral Pro фрейм Seismic с этим файлом. 

Последние вершины дерева проекта – вершины-фреймы (Model, Map, Seismic). 

Дважды щелкните мышкой на такой вершине, чтобы максимизировать соответствующий 

фрейм в правом окне. 
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12 Фрейм Model. Скоростная глубинная модель 

Фрейм Model используется для создания скоростной глубинной модели с помощью 

полигонов, скважинных данных, сейсмических «подложек» (2D или 3D моделей). Далее 

скоростная глубинная модель используется для построения синтетических сейсмограмм. 

Подробности про создание модели в разделе ШАГ 1. Построение глубинной модели разреза. 

Про использование скважинной информации в Построение полигонов по 

пластопересечениям в скважинах и Загрузка данных 

Про заполнение модели полигонами в Построение и редактирование полигонов Про создание 

системы наблюдения в Создание схемы наблюдения 

Про запуск моделирования синтетических сейсмограмм в Моделирование: расчет 

синтетических сейсмограмм 

Про отображение рассчитанных сейсмограмм, сейсмических моделей, полевых сейсмограмм 

в разделе Фрейм Seismic. Отображение сейсмических файлов. 

Ниже дополнительные возможности настройки и использования фрейма Model. 
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Настройка сейсмической подложки 

Выбор профиля 

Установка 

интервала глубин 

Выбор скважин 

Выбор используемых 

скважинных данных 

12.1 Диалог свойств фрейма Model 

Для вызова диалога свойств ранее созданного фрейма Model выберите мышкой фрейм Model 

и вызовите команду Model> Model Frame Properties, либо контекстное меню по 

правой кнопке на фрейме Model, команда Edit frame properties. 

 

Все параметры, вводимые с помощью WIZARD-создания модели, можно изменить 

(установить) вручную в диалоге свойств фрейма Model Properties. 

Выбор скважин в модель. Нажмите кнопку Add>. 
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Выбор сечения (разреза), вдоль которого будет строиться разрез. Установите Draw 

section manually. Теперь Вы можете на поле в левом нижнем углу диалога Model 

Properties мышкой, в режиме нажал-потянул-отпустил, нарисовать линию разреза. Для более 

точной установки линии разреза можно: а) установить координаты начала, азимут и длину (группа 

Section interval) или б) по кнопке Zoom map загрузить большую карту для визуального 

ввода. 

 

Интервал глубин. В группе Depth interval установите кровлю и подошву модели 

Выбор отображаемых на скважине данных. Группа Well data. 
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Left Side – данные, которые выводятся с левой стороны стволов скважины. 

Right Side – данные, которые выводятся с правой стороны стволов скважины. 

Отметьте типы данных по скважине, которые Вы хотите показывать. 

Log – каротажные кривые. В диалоге параметров каротажных кривых выберите кривые, 

которые хотите показывать. Подробности смотрите ниже в разделе 

«Полигоны по каротажным кривым (тонкослоистость)». 

  

Ствол скважины 
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ЗАМЕЧАНИЕ: Если Вы хотите во всем проекте изменить единицы измерения 

длины с ft на m или наоборот, рекомендуется воспользоваться командой File> 

Project  Properties (подробности в разделе Приложение А. Единицы 

измерения) 

12.2 Изменение размеров модели 

Используется команда Model> Scale. 

 

С помощью этой команды Вы можете изменить размер модели и пропорционально растянуть 

(сжать) все полигоны и размещение источников и приемников. Для этого выберите 

коэффициент масштабирования – параметр Re-size model by Scale. 

 

При изменении параметров Length, Top и Bottom полигоны модели не растягиваются и не 

смещаются. 
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12.3 Экспорт модели 

Поддерживается экспорт модели в сейсмические файлы трех форматов (TGR, SDS-PC, SEG-

Y) и в TAM-файл для загрузки модели в программу Tesseral 2D. 
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ЗАМЕЧАНИЕ: Файл TGR многокомпонентный, а если Вы экспортируете модель в 

форматы SDS-PC, SEG-Y, то будет создано три файла (по файлу для каждой 

компоненты). Файла с выбранным именем будет содержать данные Compressional 

velocity. <Имя файла>-PQR.sgy – Density, <Имя файла> PQR_Q.sgy – Shear 

Velocity (<Имя файла >–PQR_R.SGY. 

12.3.1 Экспорт модели в сейсмический файл 

Используется команда Model> Export to Seismic Format (SEG-Y, TGR). 

 

В диалоге установите размеры ячейки и имя выходного файла, а также в окне Components: 

value range можно задать минимальное и максимальное значение компонент для 

ограничения возможных выбросов при интерполяции по каротажным кривым. 

 

После создания файла в окне Tesseral Pro должен появиться фрейм Seismic с созданной по 

модели сейсмограммой. 

Результат: 
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ЗАМЕЧАНИЕ: При экспорте в любой сейсмический формат информация о 

расстановке источников и приемников не экспортируются. 
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12.3.2 Экспорт модели в Tesseral 2D (TAM-файл) 

Используется команда Model> Export to Tesseral 2D Format (TAM). 

 

При экспорте в TAM-файл тонкослоистость не экспортируется, а информация о расстановке 

источников и приемников экспортируются. 
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13 Фрейм Seismic. Отображение сейсмических файлов 

Фрейм, в котором показываются файлы форматов Seg-Y, Sds-PC, TGR. Поддерживается 

специальное отображение для 2D, 3D полевых и синтетических сейсмограмм, моделей и 

мигрированных разрезов и кубов, сейсмограмм ВСП, многокомпонентных файлов, снимков 

распространения волнового поля в модели и т.д. 
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13.1 Загрузка сейсмических файлов 

Открыть сейсмические файлы можно командой Seismic> Load Seismic File (New 

Frame) ( ). Можно выбрать сразу несколько файлов, тогда они будут отображены в общем 

координатном пространстве. 

Если сейсмический файл открывается впервые, предлагается сразу выбрать тип 

сейсмических данных для того, чтобы переключиться на нужный режим отображения: 

 

Ваш выбор определяет режим отображения (см. View Mode), который можно будет изменить 

в любой момент из пункта меню «Seismic» и используя кнопки на панели инструментов. 

После этого ваши сейсмические файлы будут считаны. Первое открытие файла занимает 

много времени, т.к. в этот момент создаются индексные файлы координат трасс, которые 

будут использованы в дальнейшем для оптимизации просмотра. 

Фрейм «Seismic» представляет собой прямоугольный графический объект, состоящий из 

изображения расстановки (сверху) и трасс (снизу). По краям поля и между окнами 

изображены линейки по осям XYZ. Сверху изображена палитра значений на трассах: 

 

Y-scale ruler 
Current shot 

Receivers 

Profile Traces to show 

X-scale ruler 

Trace wiggle 

Z-scale ruler 
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На расстановке отмечены координаты источников (квадратики) и координаты трасс 

(крестики). Текущий источник закрашен красным цветом, а его координаты показываются во 

всплывающем окне. Вид трассы может включать линии кривых трассы и картинки значений, 

соответствующие палитре. Координаты источников и приемников на расстановке могут быть 

отображены по-разному. Изменить эти настройки можно в настройках фрейма, 

вызывающиеся по кнопке  

При движении мыши в области разрезов (вертикального и горизонтального) в строке статуса 

отображаются координаты, соответствующие курсору, и значение в трассе для данной точки, 

если оно известно: 
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Black crosses 
(Best for small 
seismogramms) 

Gray dots 
(best for large 
seismograms) 

Contour 
(best for 3D cubes) 

13.1.1 Отображение плана 

 

Координаты источников всегда показаны квадратами, но способ отображения координат 

приемников варьируется в зависимости от режима отображения. Для сейсмических данных с 

небольшим числом трасс координаты приемников показаны крестиками, для больших 

сейсмограмм – серыми точками, а для еще больших сейсмограмм и для 3D кубов – 

контурами. 
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13.2 Режимы отображения трасс 

В Tesseral Pro реализовано несколько режимов отображения данных, каждый из которых 

удобен для своих задач и типов сейсмических данных. Для просмотра сейсмограмм в 

основном используются три режима, отображенные на рисунке слева направо: Show All 

Receivers «Все приемники», ―Show Current Shotgather «Приемники только 

текущего источника» и ―Show as VSP «Отобразить как ВСП»). 

 

(1) (2) (3) 
(1) Show All Receivers: В этом режиме на виде сверху показана расстановка всех источников и 

приемников. Этот режим используется, если нужно обозреть всѐ исследуемое поле, а также получить 

сечение профиля трасс, проходящего через несколько источников. 

(2) Show Current Shotgather: Этот режим является типичным для сейсмограмм. Показывает трассы 

только текущего источника и позволяет показать трассы (выбранного источника) вдоль любой линии 

профиля. 

(3) VSP:  Этот режим используется для визуализации трасс VSP. Источники расположены вертикально (условно 

в скважине), а трассы рисуются слева направо. 

  

View as VSP 

View all 
receivers 

View receivers of 
only current shot 

Note. In VSP mode 
receivers are drawn 
vertically. 
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13.3 Основные операции с фреймом Seismic 

При работе с полем «Сейсмика» используются четыре режима взаимодействия: выбор 

текущего источника ( ), рисование профиля ( ), масштабирование ( ) и перемещение (

). 

Первый режим позволяет выбрать текущий источник, в результате на поверхности 

наблюдения этот источник отмечается красным цветом, а во всплывающем окне показаны его 

координаты. Режим рисования профиля позволяет выбрать вертикальное сечение на основе 

профиля в виде отрезка. При этом приемник попадает в разрез только в том случае, когда он 

расположен от линии профиля на расстоянии, не превышающем заданное (это расстояние 

рассчитывается автоматически при открытии сейсмических файлов, но его можно изменить в 

настройках). Подробнее о профилях и разрезах описано ниже. В режиме масштабирования и 

перемещения можно приближать и перемещать как поверхность наблюдения, так и 

вертикальный разрез. 

Рассмотрим подробнее операции, которые можно выполнить над изображением 

сейсмических файлов. 

• Select Source Model ( ) позволяет указать текущий источник, для которого показывать 

трассы. 

• Draw Profile Model( ) позволяет на виде сверху вручную провести профиль. Подробнее про 

профиль см. раздел «Профили». Кроме того, в режиме рисования профиля на изображении трасс 

можно указать линию горизонтального сечения. 

• Zoom Model ( ) позволяет приблизить отображение к указанной области. 

• Zoom In  ( ) приближает изображение. 

• Zoom Out  ( ) отдаляет изображение. 

• Zoom 100% (  ) устанавливает изображение таким образом, чтобы изображение во фрейме 

поместилось целиком. 

• Zoom To -  вызывает диалоговое окно, позволяющие вручную указать параметры профиля, его 

координаты, длину, азимут. 

• Move ( ) позволяет перемещать изображение внутри фрейма. 

• Rescale to Make X Scale = Y Scale ( ) изменяет размер фрейма таким образом, 

чтобы пропорции в географических координатах на виде сверху соответствовали визуальным. 

• Rescale to Make X Scale = Z Scale ( ) изменяет размер фрейма таким образом, чтобы 

пропорции в географических координатах трасс соответствовали визуальным. 

• Normalize Palette by Visible Data  ( ) фиксирует значение минимума и максимума на 

палитре, соответствующее тому, что сейчас изображено во фрейме. 

• Normalize Palette by All Data  ( ) фиксирует значение минимума и максимума на 

палитре, соответствующее минимальному и максимальному значению в файлах фрейма. 

• Show Component позволяет выбрать изображаемых компонент (для формата TGR). 

• “Next/Previous Shotpoint” ( / ) позволяет установить следующий/ 

предыдущий источник в качестве текущего источника. 

• Export Traces Coordinates позволяет экспортировать координаты трасс в 

текстовый файл. 

• Import Traces Coordinates  позволяет импортировать координаты трасс из текстового 

файла. 
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• Refresh ( ) обновляет данные во фрейме (перечитывает все значения из сейсмических фалов 

фрейма). 

• Apply Settings to all Seismic Frames  (  ) Позволяет установить настройки 

текущего фрейма другим фреймам. 

Кроме того, пользователь может отобразить амплитудный спектр для любой области 

сейсмограммы, нажав на Spectrum Mode  и выбора области, для которой 

необходимо рассчитать амплитудный спектр. Чтобы выбрать область, просто 

удерживайте левую кнопку мыши, переместите мышь, чтобы нарисовать область, и 

отпустите левую кнопку мыши. Чтобы получить амплитудный спектр для другой 

области, просто выберите другую область, используя ту же процедуру. 
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13.4 Просмотр 3D сейсмических моделей и результатов 3D 
миграции 

Просматривать трехмерные растровые кубы во фрейме Seismic (Сейсмика) возможно 

используя режим простора Show as Model ( ) и формируя горизонтальные и 

вертикальные разрезы по произвольному профилю. Поскольку такие кубы представлены в 

формате сейсмических данных, содержание куба представлено в виде трасс. При этом для 

описания координат X и Y используются координаты приемника трассы, а координата Z 

определяется исходя из отсчетов самой трассы. Координаты источника в общем случае 

игнорируются, но для обеспечения совместимости с визуализаторами сейсмических данных 

удобно либо полагать координаты источников равными координатам приемников, либо (как 

сделано в Tesseral Pro) для приемников с Y=const создавать один источник, у которого 

координата X будет равна минимальной координате X приемников. 

 

 

  

Y-axis 
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13.5 Профили 

Наиболее простой способ создать профиль – это переключиться в режим редактирования ― 

Draw Profile Mode ( ) и вручную провести линию на виде сверху. В результате в 

области отображения трасс будет показан вертикальный разрез. В этот разрез попадут только 

те трассы, координаты которых находятся на определенном в свойствах объекта расстоянии 

от линии профиля. Слишком большое расстояние может привести к тому, что будут 

отображены трассы вне линии профиля. Слишком маленький размер профиля может 

привести к тому, что некоторые нужные трассы не попадут в разрез. 

Section Properties 

Детальные свойства профиля можно получить, вызвав пункт меню Seismic> 

Section Properties. 

 

В окне можно указать координаты профиля, его длину и азимут, а также максимальное 

расстояние от профиля к трассе. 

Вертикальный разрез можно экспортировать как отдельный сейсмический файл, который в 

последующем можно использовать как подложку для модели. Для этого нужно вызвать 

пункт меню Run> General Purpose Procedures > Export Section to 2D 

Seismic File. 

Загруженную во фрейм сейсмику можно вращать вдоль профиля, используя пункт 

меню Seismic> Rotate to Align X Axis along Section Profile. При этом 

содержимое самих сейсмических файлов не изменится – изменения коснуться только файлов 

с расширением «.cr0». 



© Tesseral Technologies -Документация Пользователя- 356 

 

 

 
 

 

 

 
 

 

 

 
 

 

 

 
 

 

 

 
 

 

 
Rotate coordinates along the 
profile. 

Note. Actual seismic files do not 
change! 
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13.6 Использование поверхностей на сейсмических кубах 

Вы можете загрузить поверхность и получить линию пересечения этой поверхности с 3D 

кубом. Для этого зайдите в свойства фрейма Seismic «Сейсмика» и укажите имя файла с 

поверхностью: 

Tesseral Pro поддерживает такие форматы поверхностей: XYV, CSV, DAT, Surfer, 

Schlumberger, Triple TXT, ZMap, Paradigm, GeoQuest, Landmark, Charisma-YX, Charisma-XY. 
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Линия пересечения поверхности и куба показана на вертикальном сечении темно-зеленым 

цветом. 

Если в режиме рисования профиля Profile Drawing нажать в произвольной точке 

вертикального сечения, то автоматически будет построено горизонтальное сечение, 

проходящее через выбранную точку и параллельное загруженной поверхности. Этот рисунок 

появляется на виде сверху. 

  

Picture of 
horizontal section 
created by the grid 

intersection line of 
Grid and Cube 
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13.7 Горизонтальные сечения 

В Tesseral Pro реализован необычный для программ просмотра сейсмограмм режим 

отображения горизонтальных разрезов. Этот режим полезен при визуализации 2D разрезов 

растровых 3D кубов 

 

На рисунках показан горизонтальный (сверху) и вертикальный (снизу) разрезы растровой 

трехмерной скоростной модели. На этих разрезах показаны профили, по которым они 

построены. Профиль на горизонтальном разрезе создает вертикальный разрез и наоборот. 

Для того чтобы построить горизонтальный разрез, нужно в режиме рисования профиля 

нажать в произвольной точке вертикального разреза. При этом горизонтальное сечение, 

проходящее через заданную точку, будет построено автоматически и изображено на виде 

сверху (см. первый рисунок). Если на вертикальном разрезе нарисовать вертикальную 

линию, то будет построено горизонтальное сечение, состоящее из средних значений между 

концами проведенной линии (см. второй рисунок). Область, по которой строится 

горизонтальное сечение, будет заштрихована. 

Горизонтальное сечение можно убрать, нажав в режиме рисования профиля в произвольной 

точке на вертикальном разрезе, удерживая клавишу «Ctrl». 

  

A profile 

Map of a 
horizontal 
section 

Map of a 
horizontal 
section of 
average values 

Click here to get a 
horizontal section for 
exact values 

Draw a small vertical line 
here to get horizontal 
section for average values 
in the interval 
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13.8 Подробности настройки фрейма Seismic 

Управление большинством функций визуализации осуществляется с помощью свойств 

фрейма «Сейсмика». Параметры отображения сейсмограммы устанавливаются в диалоге 

Seismic Property и командами меню Seismic. 

Свойства разделены по вкладкам. Во вкладке «Common» устанавливаются общие свойства 

визуализации объекта, в и на вкладке “Layout”, где определяются параметры визуализации 

поверхности наблюдений.  

Вкладка Units «Единицы» в окне Seismic Properties «Сейсмические свойства» 

предназначена для изменения (масштабирования) координат и значений данных трассы в 

случае некорректного отображения сейсмограммы в Фрейме. В этом случае исходный файл 

не изменяется, а изменения сохраняются в дополнительный файл 

<seismogram_file_name>.CR0. Эти новые изменения значений будут загружены при 

открытии файла в дальнейшем. 

 

Если Вам необходимо восстановить параметры трасс и координат, удалите файл 

<seismogram_file_name>.CR0 или выберите Update в закладке Common в диалоговом окне 

Seismic Property. 

Пакет Tesseral Pro использует двумерное изображение, основанное на цветовой палитре, как 

один из возможных способов представления сейсмических данных. В состав пакета входит 

10 стандартных палитр (сине-бело-красная, радужная, черно-белая и т.п.). Также 

пользователь может создать произвольную палитру. 

Загрузить сейсмограммы в объект «Сейсмика» можно, нажав на кнопку «Add» во вкладке 

Common свойств фрейма. Допускается загрузка нескольких файлов. При этом 

подразумевается, что все источники и приемники находятся в одной системе координат. Если 

это не так, то возможно скорректировать (временно) координаты отдельных сейсмических 

файлов линейным преобразованием, устанавливаемым с помощью настроек в кнопке 

«Properties» » во вкладке Common. Кнопка «Calculate» позволяет восстановить 

основные параметры выбранных файлов, пересчитав их из диска. Эта же кнопка отменяет 

все сделанные до этого линейные преобразования над координатами источников и 

приемников. 
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На вкладке Layout можно задать параметры визуализации системы сбора данных. В 

раскрывающемся списке Seismic viewer на вкладке Common можно выбрать режим 

отображения системы сбора данных. Эти режимы более подробно описаны ниже. 

Для разных сейсмических файлов количество приемников может варьироваться от сотен до 

миллионов, поэтому реализовано несколько способов отображения этих приемников, 

например, маленькие черные крестики, серые точки и контуры. 

  

Вкладка Common «Общие» также позволяет настраивать трассы, отображаемые в 

вертикальном сечении. В группе Show «Показать» пользователи могут выбрать, будут ли 

трассы отображаться в виде волн или изображения на основе пользовательской палитры. Для 

многокомпонентных сейсмических данных пользователи могут выбрать компонент для 

отображения в группе Seismic File Properties «Свойства сейсмического файла» на 

вкладке Units «Единицы». 

На вкладке Rulers «Линейки» указываются параметры отображения вертикальной и 

горизонтальной линеек. По умолчанию обе линейки отображаются слева и справа от 

объекта, но пользователи могут либо отображать вертикальную шкалу слева, либо только 

справа. 

Параметры профиля (вертикальное или горизонтальное сечение) можно определить на 

вкладке Profile «Профиль». 

  

  

Axis direction 

Seismic File(s) 
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Модельные полигоны 

Текущий мгновенный снимок (время) 

Текущий взрыв 

13.9 2D Визуализатор мгновенных снимков 

Для того чтобы показать снимки мгновенного состояния волнового поля – снепшоты  

(snapshots) совместно с сейсмограммой, используется окно, которое вызывается нажатием на 

пункт Snapshot Viewer в меню View. Это окно также появляется автоматически при 

завершении моделирования. 

 

Нажимая на кнопку Select Snap, выберете файл со снепшотом. Нажав на кнопку Select 

Shotgather, выберите файл с соответствующей сейсмограммой. Если в Tesseral Pro открыт 

фрейм Model «Модель», контуры полигонов этой модели будут показаны на снепшоте. 

Навигация по снепшотам и сейсмограммам осуществляется путем использования 

соответствующих слайдеров. 

Вы можете сохранить снимки как видео, нажав на кнопку Capture, после чего 

появится окно свойств анимации. Animation Properties. 
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Видео будет сохранено в формате AVI, а пользователь должен также указать количество 

кадров в секунду Frames per Second при формировании изображения из визуализатора 

Snapshot Viewer. 

 

Пользователь может указать качество сжатия видеоизображения Compression  Quality, 

нажав на Compression (сжатие). 

 

 

Кроме того, качество компрессии можно в последствии изменить, используя регулировку 

Temporal Quality Ratio , выбрав команду Configure. 

 

После того, как все настройки указаны, нажмите кнопку ОК, и программа начнет запись в 

интерфейс Tesseral Pro. Обратите внимание, что закрытие окна просмотра снимков 

Snapshot Viewer с этого момента прервет запись, и все данные, записанные до сих пор 

будут сохранены как видео! Если пользователь хочет записать только окно просмотра 

снимков Snapshot Viewer, то рекомендуется развернуть его на весь экран и выбрать 

опцию Program Window в окне свойств анимации Animation Properties. 
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Для остановки записи нажмите Capture (захват) и видео будет сохранено в указанном месте 

с указанным именем в диалоге файла фильма. Movie file. 
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13.10 3D Визуализатор мгновенных снимков 

Для того, чтобы генерировать 3D-снимки, пожалуйста, выберите чек Generate 3D 

snapshots (Генерирование 3D снимков) и выберите Setup 3D Snapshots (Настройка 

3D снимков) в окне 3D modelling Calculations Properties (Свойства 3D 

моделирования). 

 



© Tesseral Technologies -Документация Пользователя- 366 

 

 

Затем пользователь должен указать пункты взрыва Shot Points и компоненты 

Component, для которого должны быть получены мгновенные снимки, а также в какие 

моменты времени. Кроме того, пользователь может настроить значения по умолчанию для 

сетки шага Mesh Step для поля распространения волн вдоль осей X, Y и Z. 

 

В результате будет создан SGY файл для каждого указанного пункта взрыва и его 

соответствующего компонента, который будет содержать снимки распространения волнового 

поля в указанном промежутке времени. Для того, чтобы просмотреть снимок, 

сформированный SGY файл нужно открыть во фрейме 3D View (3D View>Add SEG-Y  

cube). Для того, чтобы наилучшим образом отобразить снимка, пользователю нужно 

настроить параметры визуализации в окне 3D View> Selected object properties. 
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Как правило, для оптимальной визуализации волнового поля величина прозрачности 

Opacity 85% -95% получается лучше всего. Кроме того, уменьшив значение Magnitude 

within the Palette внутри палитры также усилит отображение всего волнового поля. 
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13.11 Подготовка сейсмических файлов для загрузки 

Для нестандартных сейсмограмм иногда возникает необходимость предварительной 

подготовки к загрузке. Чаще всего проблемы с загрузкой SEG-Y файлов связаны с 

неправильным чтением данных о времени записи сигнала или неправильным чтением 

данных о координатах и высоте расположения источников и приемников. Частично эти 

проблемы можно решить в диалоге Seismic Properties (команда Seismic>  

Seismic Frame Properties).  

 

В диалоге Seismic file Properties введите константы масштабирования координат 

трасс и интервала трассы. При этом содержимое самих файлов сейсмограмм не меняется. 

Все изменения сохраняются во вспомогательный файл <ИМЯ ФАЙЛА 

СЕЙСМОГРАММЫ>.CR0. При нажатии кнопки Apply в диалоге Seismic file 

Properties файл с расширением .cr0 удаляется, и введенные константы масштабирования 

исчезнут. 

Возможно, что координаты трасс в заголовках SEG-Y располагаются не в традиционных 

местах 
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«Стандартное» расположение 
информации о координатах и 
положении над уровнем моря 
источника и приемника трассы в 
заголовке трассы SEG-Y файла 

 

Для подготовки сейсмограммы к загрузке выполните команду Seismic > Raw  Trace 

View Window. После выбора сейсмического файла откроется два окна. В одном реализуется 

просмотр трасс в порядке их расположения в файле, в другом – таблица заголовков 

отдельной трассы. 
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Суть подготовки сейсмического файла для загрузки заключается в выборе полей заголовка, 

которые соответствуют координатам источника и приемника трасс. Соотнести поля 

заголовка с соответствующими координатами можно нажатием правой кнопкой мыши на 

любом поле заголовка. Информация о назначении полей заголовка координатам хранится в 

файле <ИМЯ ФАЙЛА СЕЙСМОГРАММЫ>.INF и будет в дальнейшем использоваться 

программой. 

Просмотр заголовков трасс целиком позволяет просмотреть заголовок трассы как набор 

безымянных значений. Вы можете установить смещение начала видимости заголовка. 

 

 

Min/Max/Avg value 

Set the meaning 

of a header 

Current trace wiggle 

Trace headers 

Current trace number 

View mode 
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Select meaning 

Select type 

Word number 

in header 

Offset 

 

Заголовок можно просматривать в двух режимах: описательном (Descriptive) и целиком 

(Dump). В первом случае просматриваются известные значения полей заголовка, а во втором 

– все значения полей заголовка. 

При просмотре заголовка целиком в первой колонке указан диапазон слов, во второй – тип 

данных, в третьей – значение. Значение зависит от типа данных и меняется в зависимости от 

типа данных. Поскольку типы данных имеют разную длину слов, нижняя часть заголовка 

автоматически сдвигается. Ни одно поле заголовка не может иметь общие номера слов. 

Tesseral Pro поддерживает такие типы данных: CHAR (1 байт, -127-128), SHORT (2 байта, -

32767-32768), LONG (4 байта, - 2147483647~2147483648) 
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14 Фрейм Map. Карты стратиграфических поверхностей 

В Tesseral Pro реализована возможность построения модели по картам стратиграфических 

поверхностей. Модель строится автоматически как вертикальный срез вдоль выбранной 

линии сечения по всем рассчитанным (загруженным) поверхностям. 

Подробнее о построении моделей по стратиграфическим поверхностям рассказывается ниже. 

Сначала рассмотрим краткое описание возможностей Tesseral Pro по загрузке, расчету, 

отображению и обработке поверхностей. 
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14.1 Загрузка поверхности из текстового файла 

Для загрузки готовых поверхностей в Tesseral Pro база данных не нужна. В Tesseral Pro 

поддерживается загрузка готовых поверхностей из текстовых файлов нескольких форматов 

(команда File> Load Surface). Поддерживается загрузка решеток в формате XYV, 

изолиний, отдельных точек, решеток в форматах Integral+, Surfer, Schlumberger, Triple, ZMap, 

Paradigm, GeoQuest, Landmark, Charisma. 

Пользователь также может генерировать поверхности самостоятельно, введя в текстовый 

файл координаты XYZ поверхности в 3 отдельных столбцах, а затем сохранив файл с 

расширением XYZ. 

 

В стандартном диалоге File Open выберите файл поверхности и обязательно правильно 

укажите его формат в списке Тип файла. 
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Вы можете выбрать сразу несколько файлов одного типа для групповой загрузки. 

Далее, в следующем диалоге Calculate Isolines, установите параметры расчета 

изолиний или нажмите Cancel, если не хотите показывать изолинии на поверхности. 

 

Результат: 
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ЗАМЕЧАНИЕ: Команды Undo и Redo не распространяются на функции 

работы с поверхностями (загрузка, расчет, обработка, удаление), но 

распространяются на изменения, касающиеся фрейма Map (выбор поверхности 

для отображения, настройка палитры, масштабов, размеров фрейма и т.д.). 

 

Повторите операцию для загрузки других поверхностей. 

Все загруженные поверхности хранятся в общем массиве в документе Tesseral Pro. Для 

отображения поверхностей используется фрейм Map. Если Вы удаляете фрейм Map, с 

поверхностью, которую этот фрейм Map показывал перед удалением, ничего не происходит, 

она останется в массиве посчитанных (загруженных) поверхностей в документе Tesseral Pro. 

Вы можете показать эту поверхность в другом фрейме Map, выбрав ее из списка. Для 

управления поверхностями, загруженными в документ Tesseral Pro, используется Map> 

Manage/Delete Maps. Подробнее в разделе Управление поверхностями. 
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14.2 Расчет поверхностей по скважинным данным 

Для построения поверхностей по пластопересечениям в скважинах необходимо иметь в 

Tesseral Pro базу данных MS Access или MS SQL Server c координатами скважин, 

альтитудами и/или инклинометрией скважин и глубинами стратиграфических горизонтов в 

скважинах. Подробности по загрузке этой информации в геофизическую базу данных ниже, в 

приложении 2 «Геофизическая база данных». 
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Направление осей для всех 
фреймов Surface проекта 

Выбранные месторождения 
выделяются жирным 
шрифтом 

14.2.1 Выбор месторождений в проект 

Поскольку в базе данных может быть одновременно несколько независимых месторождений, 

перед построением поверхностей необходимо выбрать «рабочие» месторождения с помощью 

команды File> Project Properties. Там же выберите направление осей для карт 

поверхностей, которые Вы будете создавать. 

 

 

  

ЗАМЕЧАНИЕ: После загрузки программы Tesseral Pro, она не подключена к 

базе. Нажмите кнопку Load Database в левой части окна, для подключения к 

СУБД MS SQL Server или MS Access и для загрузки базы Tesseral Pro. 

Подробности по подключению в разделе Операции подключения, создания, 

копирования БД. 
ЗАМЕЧАНИЕ: Еще месторождение можно выбрать командой Select a 

field  for the project контекстного меню по правой кнопке на имени 

месторождения в дереве базы. 
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14.2.2 Создание фрейма Map 

Команда Map> Create Map (New Frame). 

В результате должна появиться карта со скважинами выбранного месторождения. 

 

Все команды, связанные с редактированием карты, расположены в меню Map. 
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ЗАМЕЧАНИЕ: Если область выбрана неправильно: (1) отмена последнего 

действия – Edit> Undo; (2) Увеличение области команда Map> Zoom Mode 

и повторный выбор. 

14.2.3 Рабочая область 

Рабочая область (область построения поверхности) задается интервалом (в метрах или футах) 

по осям X и Y. Рабочая область устанавливается в диалоге Map Properties фрейма Map. 

 

Также рабочую область построения карт можно выбрать визуально мышкой в режиме Map > 

Zoom Mode или Map > Move Mode. В обоих режимах выбор (смещение) области 

производится левой кнопкой мышки на фрейме Surface (нажать-потянуть-отпустить). 

 

Результат: 
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Воспользуйтесь списком 

для автоматического 

выбора пластов 

Отметьте пласты в списке 

ЗАМЕЧАНИЕ: В соответствии с исходными данными в списке методов будет 

автоматически выбран наиболее подходящий метод 

14.2.4 Построение карт поверхностей 

Карты поверхностей пластов строятся на основании данных пластопересечений в скважинах. 

Для картопостроения в Tesseral Pro реализовано 8 методов, в том числе сплайн- 

аппроксимация и кригинг. 

Для создания новых карт поверхностей используется команда Map> Add New Horizon 

from Well Tops. В диалоге Add new surface отметьте пласты, для которых хотите 

построить карты поверхностей 

 

Далее выберите из списка метод картопостроения. 

 

 

Далее, после расчета первой поверхности, Вам будет предложен диалог настройки 

параметров построения изолиний 

 

Расчет поверхностей всех остальных выбранных пластов пройдет автоматически по 

выбранному методу картопостроения. 
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Результат: 

 

 

 

 

  

ЗАМЕЧАНИЕ: Если Вы хотите перестроить поверхности, используя другой метод 

картопостроения, или построить поверхности других пластов, вызовите команду Map 

> Add New Horizon from Well Tops снова. Программа предложит Вам удалить 

уже существующую поверхность, если Вы хотите повторно ее рассчитать. 
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ЗАМЕЧАНИЕ: На операции с поверхностями (создание, загрузка, удаление) не 

распространяется действие команд Undo/Redo. 

14.2.5 Управление поверхностями 

Для выбора поверхности, отображаемой в фрейме Surface, для удаления и изменения 

свойств поверхности (имя, кровля-подошва), используйте команду Map >  

Manage/Delete Horizons. 
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14.2.6 Параметры отображения поверхностей 

Диалог Map Properties (команда Edit> Edit Frame Properties или Map> Map 

Frame Properties) позволяет настроить параметры отображения фрейма Map. 

 

 

Для изменения палитры поверхности выберите мышкой фрейм Surface и вызовите команду 

Edit > Palette либо воспользуйтесь кнопкой Palette диалога Map Properties. 

Поверхность из 

общего списка, 

отображаемая на 

фрейме 

палитра 

Показать/скрыть 

информацию 

При изменении параметров 

проекта, все поверхности 

из документа удаляются 

Отображение 

плана 

сейсмических 

файлов на карте 

ЗАМЕЧАНИЕ: Фрейм Surface не содержит загруженные и рассчитанные 

поверхности. Все поверхности хранятся в общем массиве в документе Tesseral 

Pro (Map > Manage/Delete Horizons). Фрейм Surface используется для 

отображения любой из загруженных (рассчитанных) поверхностей. Т.е. в любом 

фрейме Surface Вы можете показывать любую поверхность из общего списка. 

Удаление поверхности из этого списка приводит к «пропаданию» ее из всех 

фреймов Surface, где эта поверхность показывается. Команды меню Map > 

Active  Surface Processing (поворот, смещение, сглаживание) тоже 

меняют саму поверхность, а не только ее отображение в фрейме. 
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Изменить (уменьшить) амплитуду отображения поверхности через диалог Palette нельзя. 

Для этого воспользуйтесь Map > Active Surface Processing > Properties. 

 

Там же можно поменять имя модели и тип поверхности. Еще в меню Map> Active 

Surface Processing имеются команды Scale, Smooth, Rotate. Эти команды меняют 

саму поверхность, а не только ее отображение во фрейме. Команды Undo/Redo к ним не 

применимы. 
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Скважины, 
выбранные в 
профиль 

14.2.7 Построение модели по поверхностям 

Перед построением модели по поверхностям рекомендуется эти поверхности загрузить или 

рассчитать по скважинам в Tesseral Pro. Вообще, необязательно иметь все поверхности перед 

созданием модели. Этот процесс может быть итерационным. Вы можете удалять, добавлять и 

пересчитывать поверхности, и перестраивать уже существующую модель по новым данным. 

Последовательность шагов создания модели по поверхностям следующая: 

ШАГ 1. Выбор скважин в профиль. Для выбора скважин, которые будут выводиться во 

фрейме Model, необходимо нажать правую кнопку мышки на скважине в фрейме Surface 

(которую Вы хотите добавить в профиль). В контекстном меню выберите команду Add Well 

to Profile. После выбора первой скважины картинка не поменяется. Повторите команду 

операцию для других скважин. 

Результат: 

 

 

Для удаления скважины из профиля воспользуйтесь командой Delete Well from  

Profile контекстного меню или меню Map> Profile, а для очистки всего профиля 

командой Map> Profile > Empty Profile. 

ШАГ 2. Линия разреза. Выберите режим mode Map> Section Mode. Далее левой 

кнопкой мышки на карте проведите линию разреза (нажал-потянул-отпустил). 

Результат: 
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ШАГ 3. Создание модели. Команда command Map> Transmit Horizons to Model. 

Вы попадаете в WIZARD по созданию модели. Подробности в разделе «Создание модели по 

картам поверхностей». 

ШАГ 4. Поддержка тонкослоистости. Если Вы хотите заполнять характеристики 

полигонов по данным каротажа, необходимо подгрузить эти каротажные кривые в скважины 

модели. Для этого вызовите диалог Polygon Properties (команда Model> Edit 

Polygon) после того, как выделите полигон. 

В появившемся диалоге Polygon Properties выберите кривую акустики на скважины 

для автоматической установки параметра From Log у создаваемых по поверхностям 

полигонов. Остальные параметры фрейма Model можно установить сразу или при 

следующих вызовах диалога Model> Model Frame Properties. Подробности 

смотрите в разделе «Диалог свойств фрейма Model». 

Линия разреза 
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Результат: 

 

Выберите кривые для 
отображения на скважинах 
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ЗАМЕЧАНИЕ: При настройке параметров полигонов, созданных 

автоматически из фрейма Surface, пользуйтесь кнопкой By default в 

диалоге Polygon Properties для автоматического заполнения компонентов 

при повторном создании полигона по тем же самым пластам. 

 

ШАГ 5. Настройка модели. Подробности в разделе Построение и 

редактирование полигонов. 

 

  

ЗАМЕЧАНИЕ: При повторном вызове команды Map > Transmit 

Horizons to model, если фрейм Model уже существует, то модель будет 

автоматически перестроена по: (1) выбранным в карте разрезу и профилю и (2) 

существующим в документе картам поверхностей пластов. 



© Tesseral Technologies -Документация Пользователя- 390 

 

Шкала 
Данные 

15 Фрейм 3D View. Визуализация 3-мерных объектов 

Для просмотра пространственного расположения данных из БД, проекта или 

пользовательского файла в Tesseral Pro предусмотрен фрейм 3D View. Настройка 

содержимого фрейма происходит в диалоге, который вызывается командой меню File/New 

Frame/3D View. Отображаемые данные располагаются в кубе, на ребрах которого можно 

настроить шкалу. Для того чтобы повернуть куб, потяните соответствующий ползунок. 

Приблизить изображение можно с помощью линейного регулятора Zoom. Кроме того, можно 

настроить разный масштаб по осям (Horizontal/Depth Scale). Доступ к свойствам 

объектов осуществляется через двойной щелчок мыши или команду 3D View> Object 

Properties (в последнем случае объект должен быть предварительно выбран мышью). 

Данные можно загрузить в куб с помощью меню 3D View. Все данные, загруженные в куб, 

отображаются совместно в единой системе координат. Остановимся на каждой команде 

подробнее. 
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15.1 Визуализация сейсмических данных 

Фрейм 3D View позволяет просматривать данные сейсмических исследований в форматах 

SEG-Y, SDS-PC и TGR. Для того чтобы загрузить куб, воспользуйтесь командой меню 3D 

View > Add Cube. На экране отобразится диалог Add Cube. Затем загрузите нужный 

файл. Приемники на схеме обозначены синими крестиками. Изначально выбрана вся область, 

которую покрывают приемники. Для выбора прямоугольной части области проведите на 

схеме диагональ выбираемого прямоугольника, зажав левую кнопку мыши. 

Указав интервал глубин, можно ограничить куб по глубине. Интервал глубин по умолчанию – 

от минимума до максимума по файлу. После нажатия на кнопку OK в диалоге Cube  

Properties следует задать свойства куба. *-step – расстояние между соседними узлами 

загружаемой решетки вдоль каждой оси. Этот параметр может быть увеличен для ускорения 

отрисовки картинки. Остальные параметры диалога предназначены для настройки палитры. 

По умолчанию интервал палитры – от минимума до максимума по файлу. Для того, чтобы 

установить интервал по отображаемым данным, выберите пункт Auto fitting by cube 

values. 

 

 

 

Процедура загрузки профилей во фрейм практически идентична описанной выше. 

  

Интервал глубин 

Открыть файл 

Вертикальные границы куба 

Схема 

ЗАМЕЧАНИЕ: Чрезмерное увеличение параметра *.-step ухудшает качество 

картинки. 
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15.2 Визуализация поверхностей 

Поверхности из файла загружаются аналогичным образом. Команда 3D View > Add Map 

> From Project позволяет загрузить поверхности из проекта Tesseral Pro. 

После нажатия на кнопку OK диалога Add Map From Project на экране отобразится 

диалог Surface Properties для каждой добавленной поверхности. Палитра может быть 

задана как на основе рассматриваемой поверхности, так и на основе другой поверхности 

(флажок Filling by another surface). Интервал палитры может быть установлен 

пользователем (Set own interval), задан от минимума до максимума поверхности 

(Auto fitting by surface values) или от минимума до максимума по всем 

поверхностям во фрейме (Set general depth interval). Чтобы распространить 

установки палитры на все поверхности, установите флажок Apply to all. 

 
 

  

Поверхность на схеме 

Схема 
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Схема расположения 

скважин во фрейме 

Список отображаемых 

скважин 

15.3 Визуализация инклинометрии, каротажных кривых и пластов 

Для загрузки скважин из БД воспользуйтесь командой меню 3D View> Add/Remove 

Wells, указав в диалоге Wells список скважин, которые вы хотели бы видеть во фрейме. 

Для задания свойств скважин вызовите команду 3D View> Well Properties. 
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15.3.1 Вкладка “General” – общие свойства скважин 

Скважину можно показывать в виде ломаной линии или объемной ―трубы‖ заданного 

радиуса (параметр Fictive Radius). Для этого воспользуйтесь флажком Pipeline 

View. Увеличение значения параметра Number of slices to form a pipe улучшит 

качество изображения, однако может привести к замедлению работы программы. Параметр 

Length of a straight pipe section позволяет отображать не все значения 

инклинометрии, хранящиеся в БД, а выбирать значения из базы так, чтобы расстояние вдоль 

скважины между двумя последовательно выбираемыми значениями было не меньше 

значения, заданного этим параметром. Как и параметр Number of slices to form a 

pipe, параметр Length of a straight pipe section существенно влияет на 

скорость работы программы. С помощью параметров Min и Max скважины можно 

ограничить по глубине. Для этого сначала нужно установить флажок Depth range. 

Параметры Width of well-log display region и Stratum marker: fictive 

radius служат для настройки отображения каротажных кривых и пластов соответственно и 

будут рассмотрены ниже. 
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Добавить кривые 

в список Настройки 

текущей кривой 

Удалить текущую 

кривую из списка 

Удалить все 

кривые из списка 

Текущая кривая Текущая скважина 

 
Список скважин 

фрейма 

 

Список кривых 

текущей скважины 

15.3.2 Визуализация каротажных кривых 

Для добавления данных каротажа во фрейм вызовите диалог Wells properties и 

перейдите на вкладку Logging. Список Well-log содержит имена кривых, которые будут 

отображены во фрейме. Все элементы управления, расположенные справа от списка, 

отображают настройки текущей кривой. Кривые добавляются в список с помощью диалога 

Select Curves. Изначально список диалога содержит все доступные кривые по 

скважинам фрейма (если фрейм не содержит ни одной скважины, диалог будет содержать 

список всех кривых из БД). Для того чтобы получить список кривых по одной скважине, 

выберите соответствующую скважину из выпадающего списка. Во фрейме кривая 

отображается вдоль скважины, слева или справа от нее. Диалог Wells Properties 

позволяет настроить толщину линии каждой кривой. Значение 0 означает, что кривая не 

будет сглажена и будет иметь наименьшую достижимую на данном устройстве толщину. 

Кривые с большим значением толщины будут сглажены. Остальные настройки кривых 

аналогичны рассмотренным в разделе «Полигоны по каротажным кривым 

(тонкослоистость)». Ширину области вывода кривых можно настроить во вкладке General, 

установив значение параметра Width of well-log display region. 
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15.3.3 Визуализация пластов 

На скважинах можно обозначить пересечения скважин и кровли пластов. Для этого откройте 

вкладку Strata диалога Wells Properties. Левый список диалога содержит список 

доступных пластов. Пласты, находящиеся в правом списке, будут отображены во фрейме в 

виде кружочков на скважинах. Задать ширину кружка можно во вкладке General, указав 

значение параметра Stratum marker: fictive radius. 
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Единицы измерения 
проекта 

16 Приложение А. Единицы измерения 

Выбор единиц измерения проекта команда File> Project Properties. 

 

Разные типы данных и типы фреймов по-разному связаны с единицами измерения, 

выбранными в свойствах проекта. Например, база данных не зависит от проекта и каждое 

месторождение (и даже скважина) может иметь свои единицы измерения глубин и значений 

каротажных кривых в зависимости от исходных данных загрузки. Каждая сейсмограмма 

создавались в метрической или имперской системе, но должна корректно загружаться в 

Tesseral Pro. Любые данные можно «привести» к выбранной системе с помощью настроек и 

команд Tesseral Pro. 

Ниже рассказано, как обеспечить вывод данных разных типов в нужных Вам единицах 

измерения. 
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16.1 Фрейм Model 

Параметры Velocity и Density определяют вывод скоростей и плотности в свойствах 

полигонов в модели. Distance – единицы измерения длины, привязки координат, интервала 

глубин модели, геометрию системы наблюдения. При изменении в проекте единиц измерения 

Distance модель пересчитывается, а при изменении Velocity и Density меняется 

отображение данных полигонов. 

 

При загрузке модели из других форматов (File> Load Model) из некоторых форматов, 

где единицы измерения не определены, в диалоге загрузки необходимо самостоятельно 

выбрать в каких единицах измерения содержаться данные в загружаемом файле (Metric, 

Imperial) 

 

Далее загружаемая модель будет преобразована к единицам измерения проекта (если в 

проекте и файле они разные). Кроме того, Distance уже загруженной модели можно 

преобразовать вручную с помощью команды Model> Scale. Там можно выбрать 

коэффициент масштабирования модели, метры в футы или футы в метры. 

Параметры полигонов Параметры полигонов 

Расстояние 
Расстояние 

Имперская система Метрическая система 
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Отдельно, специальным образом, настраиваются единицы измерения для скважин базы 

данных, использующихся при построения модели. Подробности ниже в разделе База данных, 

перобразование единиц измерения. 
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16.2 Фрейм Seismic 

При изменении в проекте единиц измерения меняется только способ отображения 

расстояний, скоростей и плотностей сейсмограммы во фрейме Seismic в текущем проекте, 

при этом сами файлы сейсмограмм не изменяются. 

Например, при выборе в проекте футов, отображение координат трасс соответственно 

поменяется. Например, отображение Seg-Y файла, когда в проекте выбрано Distance – 

метры: 

 

Отображение того же Seg-Y файла, когда в проекте выбрано Distance – футы: 

Координаты в метрах 
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Координаты в футах 

Характеристики данных 

сейсмограммы 

В каких единицах записаны 

данные в файле 

 

При выводе решеток в файлах сейсмических форматов TGR или SEG-Y, если в параметрах 

сейсмограммы указано, что данные файла – это скорость или плотность, то отображение 

значений решетки (трасс файла) масштабируется соответственно выбранным единицам 

измерения. 

Настройка типа данных сейсмического файла (Component) в диалоге Seismic File 

Properties, который можно вызвать из Seismic> Seismic Frame  Properties. 
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16.3 Фрейм Map 

При изменении единиц измерения проекта, загруженные и рассчитанные поверхности 

удаляются. Для преобразования размеров загруженной поверхности из метров в футы или 

наоборот используется команда Map> Active Surface Processing> Scale. 

 

В диалоге нажмите кнопку Convert from ft to m или Convert from m to  ft 

для преобразования выбранной поверхности. 

Для преобразования поверхностей, построенных по пластопересечениям в скважинах базы 

данных, можно изменить единицы измерения расстояний в самой базе (месторождении, 

скважине) и построить поверхности повторно. 



© Tesseral Technologies -Документация Пользователя- 

403 

 

ЗАМЕЧАНИЕ: Перед использованием скважинных данных в построении 

модели, данные (которые хотите использовать) надо пересчитать к единицам 

измерения проекта (команда Database> Convert Units). 

16.4 База данных, преобразование единиц измерения 

Подробнее про содержание и заполнение данных в базу в разделе Приложение Б. 

Геофизическая база данных. 

Данные скорости, плотности и расстояний в базе данных не зависят от выбора единиц 

измерения в проекте. Более того, в базе данных часть информации (например, одно 

месторождение) может содержать данные в имперской системе, а другое в метрической. Для 

преобразования данных месторождения из одной системы в другую, выберите 

месторождение мышкой в дереве базы данных и вызовите команду Database> Convert 

Units. 

 

Выберите в диалоге данные, которые хотите преобразовать и направление преобразования 

(метры в футы или футы в метры). 

 

Значения кривых, загруженных в базу данных тоже можно преобразовать, но по одной. Для 

этого выберите нужную кривую в дереве базы данных и вызовите команду Database> 

Data Properties. 
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В диалоге Log Properties отметьте Edit Log и нажмите кнопку Transform.  

В диалоге Transforming data введите коэффициент масштабирования. 

 

Такое преобразование данных рекомендуется делать, чтобы единицы измерения кривых, 

например, акустического каротажа во всех скважинах одного месторождения были в единой 

системе единиц. 

После того, как единицы измерения значений каротажа нормализированы, можно выбирать 

единицы измерения всех кривых модели непосредственно при создании (редактировании 

параметров) модели по данным скважин. Для этого используется параметр Measurement 

unit в диалоге Log. 
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При заполнении полигонов интерполированными данными из скважин, значения каротажа 

преобразуются к выбранным единицам измерения проекта (m/s, ft/s; kg/m3, g/cm3), и для того, 

чтобы преобразование было корректным надо сделать правильный выбор единиц значений 

каротажа в параметре Measurement unit. 
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17 Приложение Б. Геофизическая база данных 

Для подключения к базе данных разверните вершину дерева Database в левой части 

окна 
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17.1 СУБД (DBMS) 

В Tesseral Pro для хранения данных по скважинам используется СУБД MS SQL Server или MS 

Access. 
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Представление данных по 

скважинам в Tesseral Pro 

17.2 Диаграмма классов 
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17.3 Описание таблиц и основных полей 

Структура скважинных данных в Tesseral Pro следующая: Верхний уровень – месторождения 

(таблица Fields). В базе данных может быть несколько месторождений. Месторождения 

содержат скважины (таблица Wells). Любая скважина может принадлежать только одному 

месторождению.  

Скважина может содержать 

• стратиграфию (таблица Strata) со 

стратиграфическими отбивками по скважине;  

• инклинометрию скважины (таблица 

Inclinometry); и 

• каротаж по скважине (таблица Logs). 

 

 

 

 

 

 

 

 

 

 

 

Fields (Месторождения). Основной атрибут Name – 

имя месторождения, строка. 

 

 

 

 

Wells (Скважины). «Принадлежит» месторождению. 

Основные атрибуты 

• Number – номер (название) скважины, строка 

• x, y – координаты скважины. 

• EBK – альтитуда скважины (в диалоге «Well Properties» 

ему соответствует Elevation Kelly Bush). 

• Borehole – забой скважины (в диалоге «Well 

Properties» ему соответствует Bottom). 

 

 

Inclinometry (Инклинометрия). 

 

Месторождение1 

Месторождение2 

Скважина  

 
Скважина  

 
Скважина  

Инклинометрия 

 

 

 
 

Скважина  
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«Принадлежит» скважине. Содержит таблицу координат отметок вдоль ствола скважины. 

• Depth – глубина отметки от устья скважины; 

• x, y – отклонения ствола скважины на текущей глубине отметки Depth от устья скважины; 

• z – абсолютная глубина текущей отметки скважины от уровня мирового океана. Вниз со знаком «+», 

вверх со знаком «-». 

 

 

 

 

 

 

 

 

Strata (Стратиграфия, пласты). «Принадлежит» скважине. Содержит таблицу 

пластопересечений скважины. Основные атрибуты: 

• Well strata – название пласта; 

• Strata type – определяет, к какому стратиграфическому типу (пласта/толщи/свиты/яруса или 

др.) относится текущий пласт. Таблица разрешенных стратиграфических типов базы данных 
strata_type; 

• Strata code – код пласта в таблице кодов базы данных strata_code. Используется для 

автоматического построения поверхностей по пластопересечениям; 

• Depth – глубина пластопересечения; 

• x, y, z – абсолютные координаты пластопересечения; 

• Is Bottom – подошва (1), кровля (0) пласта. 

 

Strata Code (коды пластов). «Принадлежит» пластам (стратиграфии). Содержит таблицу 

кодов пластов месторождения. Основные атрибуты: 

• Number – код пласта в таблице кодов пластов базы данных strata_code ; 

• Name – название кода пласта; 

• n.of wells – указывает количество скважин, в которых используется пласт с конкретным кодом 
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Strata type (типы пластов). «Принадлежит» пластам (стратиграфии). Содержит таблицу 

типов пластов. Основные атрибуты: 

• stratum_type – код пласта в таблице кодов 

пластов базы данных strata_code; 

• name – название типа пласта 

• Logs (каротаж). «Принадлежит» скважине. 

Содержит таблицу каротажных кривых 

скважины.  

Основные атрибуты: 

• Method – название пласта; 

• Start, Stop – кровля, подошва кривой; 

• Step – шаг кривой; 

• Vmin, Vmax – интервал по амплитуде. 
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17.4 Операции подключения, создания, копирования БД 

Подключение. Выполняется автоматически при загрузке Tesseral Pro либо по команде 

Database > Connect. 

 

Выберите СУБД, к которой хотите подключиться, и настройте периметры подключения. В 

инсталляцию входит тестовая база данных MS Access с несколькими скважинами 

TesseralPro.mdb. 

Создание резервной копии базы. Команда Database > Backup. 

MS Access. Создается копия файла *.mdb с помощью стандартного диалога Save as. 

Для MS SQL Server. 

 

Укажите путь и имя файла резервной копии. Резервные копии базы данных рекомендуется 

делать перед операциями, которые могут привести к потере данных, например, загрузка или 

удаление. В случае неправильных действий можно будет восстановить базу из резервной 

копии. 

Создание новой базы, восстановление базы. Команда Database> Create/Restore. 

 

MS Access. Для создание новой базы создается новый файл *.mdb с помощью стандартного 

диалога Save as. Восстановление базы не поддерживается, используйте команду 

Database> Connect для подключения к другой базе mdb. 
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ЗАМЕЧАНИЕ: При восстановлении базы данных из резервной копии вся 

текущая информации в базе будет потеряна безвозвратно. 

MS SQL Server. Для создания новой базы введите Database Name и выберите  

Create Empty Tesseral Pro Database. Для восстановления базы из резервной копии выберите 

Restore Backup и введите путь и имя файла ранее созданной резервной копи. 
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17.5 Загрузка данных 

Данные в базу Tesseral Pro грузятся либо из LAS-файлов (в таблицу Log), либо из текстовых 

файлов в таблицы Wells, inclinometry, strata, strata_code. 

Поддерживается как загрузка в выбранную скважину, так и загрузка в месторождение с 

«раскладыванием» данных из файла по существующим скважинам или автоматическим 

созданием новых скважин. 

Данные в текстовом файле для загрузки (TXT, CSV, TAB) должны быть представлены в виде 

колонок (колонки разделяются пробелами, табуляциями или точкой с запятой). 

Желательно, чтобы у каждой колонки был заголовок. 

Например, 

Well Number x y ekb borehole 

1 490454.8 7172923.5 85.6 3502 

2 482493.0 7160560.5 96.4 3812 

5 484796.1 7155446.5 89.7 3555 

6 475956.6 7158533.5 100.0 3456 

7 472471.0 7156297.5 100.4 2544 

8 476867.3 7163649.5 91 3514 

9 477733.9 7156292.5 98.2 3098 

10 459056.6 7146075.5 92 3113 

11 496123.6 717966674.9 11 3221 

12 498422.6 718709668.9 12 2801 

13 480333.9 7165486.5 87.7 4121 

14 470601.8 7153447.5 105.6 3434 

Первая колонка – обязательно номер скважины, в которую загружаются данные. Для 

подготовки данных для загрузки используется команда Database> Prepare Text 

Tables. Для загрузки подготовленных текстовых файлов или LAS-ов используется команда 

Database> Import Data. 

ШАГ 1. Создание месторождения. Команда Database > Add Field. В появившемся 

диалоге введите имя нового месторождения 

ШАГ 2. Загрузка координат, альтитуд, забоев скважин. Выберите мышкой 

месторождение, в которое хотите загрузить данные, и вызовите команду Database> 
Prepare Text Tables 

 

В списке Data to import выберите wells. 
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Колонка с данными Колонка с номерами 

скважин. Обязательно 

должна быть заполнена 

Строка с заголовком из файла. 

В ней может быть написан 

любой текст 

Строка с названиями 

атрибутов базы. 

Месторождение для 

загрузки 

Таблица, в которую 

загружаются данные 

ЗАМЕЧАНИЕ: В диалоге Text Table Loader нет команд Undo/Redo. 

Поэтому рекомендуется чаще сохранять промежуточный результат командой 

File > Save. 

Если у Вас есть текстовая таблица с нужной информацией, воспользуйтесь командой File> 

Open в диалоге Text Table Loader. Если у Вас данные в форматах Excel или Word, 

можно воспользоваться командами Copy/Paste для переноса данных из документа MS 

Office в Text Table Loader через буфер обмена. 

Первая колонка загружаемой таблицы – обязательно номера скважин, в которые будут 

загружаться соответствующие данные. Содержание светло-зеленой (второй) строки для 

загрузки не имеет значения – это просто заголовок колонок из «входного» текстового файла. 

В желтой (первой) строке должны быть введены все имена атрибутов для колонок, которые 

Вы хотите загрузить. Щелкните мышкой на каждой ячейке, чтобы выбрать атрибут, в который 

будут грузиться данные из колонки. 

Не обязательно иметь одну таблицу для загрузки и координат, и забоя, и альтитуды. 

Поддерживается последовательная загрузка (догрузка) данных в скважины из нескольких 

файлов. 

Порядок скважин (строк) не имеет значения, порядок колонок (кроме первой) не имеет 

значения. 

Для сохранения подготовленной таблицы в текстовый файл воспользуйтесь командой 

File > Save As text в диалоге Text Table Loader. 

 

Когда таблица подготовлена, нажмите Import для загрузки данных в выбранное 

месторождение. 

В случае успеха появится сообщение «Text table imported successful». 

Результат загрузки рекомендуется проверить. Для этого выберите мышкой любую из 

загруженных скважин и вызовите команду Database> Properties. 
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В диалоге Well Properties можно изменить любые данные и сохранить их в базу, нажав 

кнопку OK. 

ШАГ 3. Загрузка инклинометрии. В целом загрузка аналогична загрузке координат 

скважин. Выберите мышкой месторождение, в которое хотите загрузить данные 

инклинометрии, и вызовите команду Database> Prepare Text Table. В списке Data 

to import выберите inclinometry. 

 

Для использования данных инклинометрии в Tesseral Pro необходимо заполнение колонок 

depth, x, y, z. Остальные колонки несут только информативную функцию и на форму 

ствола скважины не влияют. 

Порядок колонок не имеет значения, кроме первой (номер скважины). Порядок строк одной 

скважины не имеет значения, но не рекомендуется, чтобы в файле данные одной скважины 

шли несколькими «блоками», т.е. лучше, если данные предварительно отсортированы по 

номеру скважины. 

Когда таблица подготовлена, нажмите Import для загрузки данных в выбранное 

месторождение. 

 

Результат загрузки рекомендуется проверить. Для этого выберите мышкой папку 

Inclinometry любой из загруженных скважин и вызовите команду Database> Data 

Properties. 
 

Для корректной работы картопостроения таблица inclinometry должна быть заполнена 



© Tesseral Technologies -Документация Пользователя- 
417 

 

ЗАМЕЧАНИЕ: Если в выбранной скважине уже есть инклинометрия, то она 

будет уничтожена. 

ЗАМЕЧАНИЕ: Если Вас не удовлетворяет результат загрузки инклинометрии, 

выберите мышкой месторождение и воспользуйтесь командой Database> 

Delete from Field> Inclinometry и повторите загрузку снова. 

обязательно (в тех скважинах, которые Вы хотите использовать в картопостроении). Если у 

Вас нет данных инклинометрии, но скважины можно условно считать вертикальными, 

инклинометрию можно создать автоматически. Для этого воспользуйтесь командой 
Database> Create Inclinometry. 

 

В диалоге выберите из списка скважины для создания инклинометрии и нажмите Create 

inclinometry. Для автоматического создания инклинометрии используется информация 

об альтитуде и забое по скважине из таблицы wells. При создании инклинометрии, если 

этих данных у скважины нет, для нее будет предложен диалог ввода альтитуды/забоя. 

Воспользуйтесь кнопками Select wells without inclinometry или Select 

wells with altitude and bottom для автоматического выбора скважин в списке. 

Результат выполнения команды Create inclinometry для скважины 

 

 

ШАГ 4. Загрузка стратиграфии. В целом загрузка аналогична загрузке координат и 

инклинометрии скважин. Выберите мышкой месторождение, в которое хотите загрузить 

стратиграфические разбивки по скважинам, и вызовите команду Database> Prepare 

Text Tables. В списке Data to import выберите strata. 
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Основные атрибуты name (имя пласта), depth (глубина пластопересечения вдоль ствола 

скважины), isBottom (1-подошва, 0-кровля). Если есть данные об абсолютных 

координатах пластопересечения, их тоже целесообразно внести в базу, иначе координаты 

каждый раз будут рассчитываться автоматически перед каждым построением поверхности 

пласта. 

Порядок столбцов кроме первого не имеет значения, строки перед загрузкой рекомендуется 

сортировать по номеру скважины. 

Когда таблица подготовлена, нажмите Import для загрузки данных в выбранное 

месторождение. 

Если в процессе загрузки будет обнаружен пласт с именем, которого нет в таблице 

strata_code, Вам будет предложен диалог выбора, что делать с этим пластом 

 

Create new – добавляется новая строка в таблицу кодов пластов базы данных и код пласта 

в скважине устанавливается по этой строке. 

Assign – код пласта в скважине устанавливается выбранный из списка. 

Assign empty – в скважине код пласта устанавливается «0». 

Cancel – никакого действия. 
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ЗАМЕЧАНИЕ: Если Вас не удовлетворяет результат загрузки стратиграфии, 

выберите мышкой месторождение и воспользуйтесь командой Database> 

Delete from Field > Strata и повторите загрузку снова. 

 

Результат загрузки рекомендуется проверить. Для этого выберите мышкой папку Strata 

любой из загруженных скважин и вызовите команду Database> Data Properties. 

 

 

 

ШАГ 5. Загрузка каротажа. Каротажные кривые загружаются из LAS-файлов с помощью 

команды Database> Import data на скважине или месторождении. 

Поддерживается множественный выбор LAS-файлов в диалоге выбора файлов. После выбора 

файла (файлов) в случае успешного чтения данных из LAS-файла появится диалог выбора 

кривых для загрузки в скважину: 

 

Нажмите Import для загрузки выбранных кривых в базу. 

Для проверки качества загрузки выберите кривую из паки Log скважины и выполните 

команду Database> Properties 

ЗАМЕЧАНИЕ: Код пласта имеет большое значение при построении 

поверхностей пластов по данным пластопересечений и при автоматическом 

создании полигонов в модели. Значение атрибута name в обоих случаях 

игнорируется, а используется только strata_code. Таким образом, 

рекомендуется всегда отождествлять новое имя пласта с уже существующим 

кодом в диалоге Assign a value, если такая возможность имеется. 
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ЗАМЕЧАНИЕ: Для изменения имени кода (типа) пласта щелкните дважды 

левой кнопкой мышки на этом имени и измените имя в строке редактирования. 

17.6 Редактирование данных 

Частично данные, загруженные из LAS-файлов и из текстовых таблиц, могут быть изменены 

в диалогах свойств (Database> Data Properties) для месторождений и скважин. 

 

В диалоге свойств пластов Well Strata List, нажав кнопку Field Strata, можно 

добавить, удалить или изменить коды пластов в базе данных. 

 

 

 

Редактирование кривых. Команда Database> Data Properties при 

выделенном имени кривой в дереве базы данных 
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В диалоге Log Properties отметьте Edit Log для входа в режим редактирования 

значений кривой. В режиме редактирования выделите участок кривой мышкой нажал- 

потянул-отпустил либо кнопкой Select All (выделение всей кривой). Выделенный 

участок можно сгладить (кнопка Smoothing), масштабировать (кнопка Transform) или 

удалить (кнопка Delete). Также любой участок кривой можно «нарисовать» вручную 

мышкой (нажал-потянул-отпустил) при отмеченном Manual Draw.

Сглаженный 
участок 

Удаленные 
выбросы 
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Исходная 
кривая 

Масштабированная 
кривая 
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18 Приложение В. Правила лицензирования 

Tesseral Technologies Inc. поддерживает несколько видов лицензий на использование Tesseral 

Pro. Для определения варианта лицензирования, пожалуйста, контактируйте 

tesseral@shaw.ca 

  

mailto:tesseral@shaw.ca
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18.1 Одиночная лицензия (Single-user License) 

Локальный буквенно-цифровой ключ (local alpha-digital key) есть уникальный для 

определенного компьютера. Лицензирование с буквенно-цифровым ключом не предполагает 

передачу этого ключа между компьютерами. Это может быть самым подходящим выбором 

для лицензии для тестирования пакета, общего автономного компьютера или постоянных 

независимых от пользователя рабочих мест, например, как компьютерный класс в учебном 

заведении. 

Локальный аппаратный ключ (local hardware key (HASP)) обеспечивает лицензирование 

включением в порт USB компьютера. Пользователь может установить один и тот же самый 

продукт Tesseral в других автоматизированных рабочих местах и использовать один и тот же 

самый ключ. Таким образом, этот тип лицензирования является самым подходящим для 

случайного использования пакета Tesseral одним пользователем на разных рабочих местах, 

например, и дома, и в офисе. 
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18.2 Сетевая лицензия 

Сетевая лицензия уникальна для клиентской сети. Ключ лицензии устанавливается на одном 

из компьютеров в сети, обычно называемого сервером. Это можно рассматривать как 

лучший выбор для больших или распределенных компаний. Правда, из-за все большего и 

большего ужесточения политики в администрировании системы Windows это может 

потребовать некоторых дополнительных действий системных администраторов (настройка 

параметров безопасности сети и локальных сетевых параметров Брандмауэра). Но как 

результат, многие пользователи смогут использовать общую лицензию непосредственно на 

многих компьютерах в сети. Программа должна быть первоначально установлена на каждом 

из компьютеров, работающих с Tesseral. 

• Цифровой ключ уникален для сети. Ключ лицензии устанавливается на один из компьютеров в сети 

– сервер. Это может быть и виртуальная машина потому, что этот тип лицензирования не 

предполагает наличия специфического аппаратного обеспечения. 

• Сетевой лицензионный ключ (HASP) включается в USB порт любого компьютера в локальной сети 

или в VPN (Virtual Personal Network), к которой компьютер пользователя имеет подключение. 
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18.3 Смешанные варианты лицензий 

Любая комбинация описанных выше типов ключей может использоваться клиентом для 

лицензирования продуктов Tesseral. Для примера, 3 рабочие станции в сети используют 

сетевой HASP, 2 – локальный USB HASP ключ и 2 – буквенно-цифровые ключи. Может быть 

приобретено и использовано в дальнейшем для лицензирования 3+2+2=7 рабочих станций. 

Для каждого из типов ключа может быть определен специфический выпуск продукта Tesseral 

наряду с дополнительными процессорами, используемыми для ускорения массивного 

моделирования и вычисления сейсмических изображений. 

Лицензирование в течение испытательного срока обычно делается с локальным буквенно-

цифровым ключом. 
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18.4 Установка лицензий 

Лицензия с аппаратным ключом (HASP) позволит пользователю продукта Tesseral 

использовать предоставляемое Tesseral Technologies Inc. электронное USB устройство (HASP 

key – ―Hardware Against Software Piracy) как лицензионный ключ, когда устройство 

подключено в USB порт компьютера. 

Ключ HASP первоначально закодирован для использования последней определенной версии 

продукта Tesseral и ее конфигурации и, возможно, не работает на версиях, выпущенных 

позже, поскольку пакет развивается в виде множества разных конфигураций. После запроса 

пользователя и оплаты модернизации, этот ключ может быть закодирован для 

модернизированной версии, и сконфигурирован через электронную почту (в этом случае 

пользователь получит необходимые инструкции). 

HASP может быть закодирован на использование в течение неограниченного периода 

(постоянный) или в течение ограниченного периода (испытание или лизинговый период), 

после этого периода программы Tesseral Technologies Inc. не будут работать, пока 

пользователь не получит новый HASP от Tesseral Technologies Inc. или не перекодирует его 

через электронную почту. 

Ключ HASP не требует специфического инсталляционного компакт-диска Tesseral 

Technologies Inc. 

Если ключ HASP поврежден, пользователь должен сообщить об этом в отдел обслуживания 

клиентов компании по электронной почте, а затем послать ключ почтой по указанному 

адресу, чтобы получить ключ на замену за его рыночную цену (US$ 50) + отправка и 

доставка. 

Драйверы HASP ключа, поставляемые вместе с продуктами Tesseral, удостоверены 

сертификатами Microsoft и поэтому не будет никаких сообщений предупреждения, когда Вы 

вставляете ключ и устанавливаются новые драйвера. 

Зеленый индикатор на устройстве USB должен светиться, если установка драйверов сделана 

успешно 

ВАЖНО! 

Новые (2008) HASP драйверы строго устанавливаются в зависимости от разрядности 

Windows (не компьютера!). Установочная программа распознает тип Windows и 

устанавливает соответствующие драйверы. Вставляйте USB ключ только тогда, когда 

установка драйверов завершена. Вы не должны смешать 32-и 64-битовые драйверы, если Вы 

будете вынуждены устанавливать их вручную. 

При первом запуске Tesseral Pro высвечивается окно регистрационного диалога для запроса 

специфической относящейся к лицензии информации. 

 

В зависимости от типа лицензии есть несколько 

вариантов: 

(1) Ввести буквенно-цифровой код и нажать ― Register; 

(2) Вставить USB ключ и нажать ―Insert Key; 

(3) Ввести адрес сервера сетевого ключа и нажать ― Connect. 

 

 

 

 

(3) (2) 

(1) 
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18.5 Установка сетевого сервиса Guardant 

Для использования USB ключа необходимо установить Guardant Network Services на Вашем 

компьютере, который будет сервером. Если Вы не используете сетевой ключ лицензии, то 

пропустите этот раздел. 

Guardant Network Services доступен для загрузки по адресу: 

http://www.geopoisk.com/tesseral/download/GuardnetNetServices.zip 

Детальное руководство по установке Guardant Network Services можно скачать по следующей 

ссылке: 

http://www.tesseral-geo.com/documentation/en/license/  

TesseralNetworkLicenseInstallation.pdf Более подробно технические подробности описаны в 

руководстве поставщика ключей: http:/www.tesseral-

geo.com/documentation/en/license/Guardant_LAN_Guide.pdf 

Разархивируйте и запустите на выполнение установочную программу: 

 

 

ШАГ 1. Нажмите Next > 

 

ШАГ 2. Выберите каталог установки программы и нажмите Next > 

 

http://www.geopoisk.com/tesseral/download/GuardnetNetServices.zip
http://www.tesseral-geo.com/documentation/en/license/%20TesseralNetworkLicenseInstallation.pdf
http://www.tesseral-geo.com/documentation/en/license/%20TesseralNetworkLicenseInstallation.pdf
http://tesseral-geo.com/documentation/en/license/USBKeyRemoteUpdate.pdf
http://tesseral-geo.com/documentation/en/license/USBKeyRemoteUpdate.pdf
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ШАГ 3. Вставьте Ваш USB ключ и нажмите Next > 

 

 

a) Вы можете запустить ―Network key monitor для проверки рабочих параметров Вашего ключа: 

 

b) ... и проверить: имя сервера ―Host Name‖: 

Вставьте ключ, затем 

нажмите кнопку Next 
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ШАГ 4. Для использования удаленного USB ключа введите имя сервера ―Host Name‖ в 

регистрационном диалоговом окне Tesseral и нажмите ―Connect: 

 

  

Информация о вашем ключе 

Пожалуйста, 
запомните Host Name! 

введите имя сервера 

―Host Name‖ 
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18.6 Поиск неисправностей 

✓ Читайте, если у Вас возникли непредвиденные проблемы: 

1. Техническая информация для системного администратора 

• Guardant Network Service использует следующие TCP/IP порты (и на вход и на выход): 

– 3182/TCP; 

– 3183/UDP; 

– 3184/UDP. 

• Конфигурационные файлы для дополнительных настроек 

– Для сервера: NNKSRV32.INI 

(в Guardant Net Services каталоге); 

– Для клиента: GNCLIENT.INI (в Tesseral каталоге). 

 

2. Настройка Брандмауэра 

для системного администратора 

a. Открыть Start-> Settings-> Control Panel затем Windows Firewall: 

 

b. Установка Брандмауэра (FireWall): нажмите на закладке―Advanced кнопку― Settings: 
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Установки из раздела 

―Technical information‖ 
IP адрес удаленного 

компьютера 

 
 

c. Нажмите ―Add, затем введите данные соединения: порт ―3182, затем нажмите ―OK: 

 

d. Повторите для портов ―3183‖ и ―3184‖: 
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Вопросы и ответы: 

 

a. В: Network key monitor показывает ―чистое окно 

 

О: пожалуйста, попробуйте следующее: 

– Проверьте, светится ли зеленый индикатор на USB ключе. Если нет – загрузите и 

установите последние драйверы. 

Замечание: 

3182 - это TCP, 

3183, 3184 -это UDP 
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– Попробуйте перезагрузить Ваш сервер. 

Проверьте Ваш Брандмауэр (смотрите раздел Настройки Брандмауэр (Firewall) сервера) (см. 

Поиск неисправностей п.2) 

 

b. В: Tesseral 2D/Pro не ―видит сетевого ключа 

 

 

О: пожалуйста, попробуйте следующее: 

– Проверьте Ваш Брандмауэр (смотрите раздел Настройки Брандмауэр (Firewall) сервера). 

– Проверьте конфигурацию в файле gnlient.ini в папке программы Tesseral. 


